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Safety Precautions 

WARNING    

THIS DEVICE MUST BE GROUNDED  

  IMPORTANT 

Power requirements for electrical equipment vary from area to area. Please ensure that the IMS2000 
meets the power requirements in the surrounding area. If in doubt, consult a qualified electrician or a 
Dolby Laboratories Inc. dealer. 

IMS2000 Power Ratings 

The IMS2000 Maximum Power Consumption is up to 53W in playback 400Mbps with three 
external USB devices attached that can draw 5V/0.5A from the IMS2000 USB ports. 

WARNING: Multiple sources of supply; disconnect all sources before servicing. 

IMS2000 Rack Mount and Thermal Information 

• Maximum operating ambient temperature is 40°C. 
• Never restrict the air flow through the devices’ fan or vents. 

Protecting Yourself and the IMS2000 

Never touch the AC plug with wet hands. Always disconnect the projector from the power supply by 
pulling on the plug, not the cord. Allow only a Dolby Laboratories Inc. dealer or qualified professional 
engineer to repair or reassemble the IMS2000. Apart from voiding the warranty, unauthorized engineers 
may touch live internal parts and receive a serious electric shock. Do not put or allow anyone to put any 
object, especially metal objects, into the IMS2000. Use only a listed AC power supply. Never use a DC 
power supply.  

If water or any other liquid is spilled into or onto the IMS2000, disconnect the power and call a Dolby 
Laboratories Inc. dealer. The unit must be well ventilated and away from direct sunlight. To avoid 
damage to internal circuitry, as well as the external finish, keep the IMS2000 away from direct sources of 
heat (heater vents, stoves, radiators). Avoid using flammable aerosols near the IMS2000. They can 
damage the surface area and may ignite. Do not use denatured alcohol, paint thinner or similar chemicals 
to clean the IMS2000. This can damage the unit.  
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Modification of this equipment is dangerous and can result in the impairment of the functions of the 
IMS2000. Never attempt to modify the equipment in any way. In order to ensure optimum performance 
of the IMS2000, select the setup location carefully and make sure the equipment is used properly. Avoid 
setting up the IMS2000 in the following locations: 

• In a humid or dusty environment. 
• In a room with poor ventilation. 
• On a surface which is not level. 
• Inside a moving vehicle where it will be subject to vibration. 
• In an extremely hot or cold environment. 

REMOVABLE DRIVES WARNING 

Removal of the hot swappable hard drives allows access to pins and traces supplying power to the hard 
drive backplane. This is considered an energy hazard. Removal of the hard drives must be performed by 
a trained service specialist or by trained personnel. The equipment may only be used in a restricted 
access area which is not accessible to the general public.  

CAUTION 

• The non-removable battery is located on the IMS2000 fusion board. 

• Danger of explosion if battery is removed. 

WARNING!! 
• To prevent fire or shock hazard, do not expose this appliance to rain or moisture. 
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Chapter  1 Introduction 

1.1 Purpose 

This manual shows you how to install and operate the Dolby® IMS2000 playback system. 

1.2 Software Version 

• Software version 2.7.10 and later  
• Web graphical user interface (GUI) version 1.3.7 
• Security Manager (SM) version 6.1.119 and higher for Series 2 projectors  

1.3 Contact Technical Support 

If you are in need of assistance, please contact Dolby product specialists: 

USA 
24/7 Technical Services line: +1-866-484-4004 
Technical Services email: doremisupport@dolby.com 

Europe 
24/7 Technical Services line: +44-1793-842-130 
Technical Services link: http://support.doremitechno.org/ticketing 

Technical Services email: doremisupportemea@dolby.com 

Asia/Pacific 
Technical Services line: +86-10-5910-3066 
Technical Services email: doremisupportasia@dolby.com 

Japan 
Technical Services email: doremisupportjapan@dolby.com 
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Chapter  2 Electrostatic Discharge Rules 

2.1 Electronic Discharge Safety Rules 

Be sure to follow electrostatic discharge safety rules while installing, repairing, or 
upgrading hardware on Dolby Laboratories playback systems. 

Following are the basic rules and elements for electrostatic discharge control:  

• Grounded personnel:  
o All technicians must wear electrostatic discharge–safe smocks, wrist straps, and 

heel straps that are properly attached. 
o Never touch a sensitive component or assembly unless properly grounded. 

• Always assume that all electronic (solid-state) components and assemblies are 
sensitive to electrostatic discharge damage. 

• Always do the work on static-safe work surfaces, workstations, or desks. Make sure 
your desk and wrist strap ground outlets are connected to the building ground. 

• Be aware of the static-generating materials that you work with. 
• Always use grounded cards during loading and unloading of electrostatic discharge 

devices.  
• Never transport, store, or handle sensitive components or assemblies except in a 

static-safe environment (using electrostatic discharge static bags). 
• Always store electrostatic discharge devices using safe tote boxes.  
• Personnel training:  

• Training courses should be required for all employees who handle or otherwise 
come into contact with electrostatic discharge items.  

• The training program and the level of electrostatic discharge protection should 
be tailored to the needs and sensitivity of the product or production area.  

• Recurrent training for personnel should be an integral part of the program. 
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Chapter  3 IMS2000 Overview 

The IMS2000 is a Digital Cinema Initiatives (DCI) compliant playback system that plays 
movies and trailer packages in Material eXchange Format (MXF) at up to 500 megabits 
per second (Mbps) when installed in a Digital Light Processing (DLP) Series 2 projector.  

The IMS2000 supports the highest JPEG 2000 decoding formats including 4K, 12-bit 4:4:4, 
and 10-bit 4:2:2 for 2D and 3D high frame rate (HFR) applications. In addition, it utilizes 
High-Definition Multimedia Interface™ (HDMI™) to play alternative content and live 
streams. Content is stored on an onboard RAID5 array. 

You control the IMS2000 through an Ethernet interface using a web-based version of 
CineLister, TMS2000, or a third-party theatre management system that supports Dolby® 
playback systems. The system ingests content through USB, eSATA, or Ethernet. 

3.1 IMS2000 Key Features and Functions 

Following are the IMS2000 key features and functions: 

• Single-board solution (Screen Management System [SMS] and Integrated Media 
Block [IMB] on a single board) 

• High-quality storage 
• Support for local storage 
• HDMI input  
• Dolby Atmos® 
• Web-based interface 
• Support for access products (Fidelio and CaptiView) 
• Ingest through eSATA, USB 2.0 and 3.0, or Ethernet 
• Live support (Ethernet stream, MPEG-2, H.264, and SMPTE 421M [VC-1] up to 50 

Mbps) 
• Scaler and deinterlacer included 
• General purpose input and output ports (GPIO): Four inputs and six outputs 
• Linear timecode (LTC) output port (See Section 19.1) 
• Serial Digital Interface (SDI) input ports support the following 3D mappings: 

• Dual stream 
• Side by side 
• Top/bottom 

Chapter 3 
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3.1.1 JPEG 2000 DCI Digital Cinema Package Playback 

• 2K playback up to 120 fps 
• 4K playback up to 30 fps 
• Bit rates up to 500 Mbps 
• DCI compliant 
• 12-bit 4:4:4 X’Y’Z’ in all formats 

3.1.2 MPEG-2/H.264/VC-1 MXF Interop 

• 720p 60 fps, 1080i, 1080p up to 30 fps 
• Bit rates up 50 Mbps 
• 4:2:0, 8 bits 

3.1.3 Video Processing Features 

• Color conversion support: YCbCr601, YCbCr709, RGB rec709, X’Y’Z’, and YCxCz 
• Deinterlacing 
• Scaler (upscale up to 4K)  

3.1.4 Security 

• Dolby forensic watermarking for audio and video. 
• The Security Manager module (media block) of the NEC NP-90MS02 Integrated 

Media Server is FIPS 140-2 certified and is compliant with FIPS 140-2 Security Level 3 
requirements, with the exception of the EMI/EMC tested FIPS 140-2 Security Level 2. 
This results in an overall FIPS 140-2 Level 2 compliance. 

3.1.5 Audio 

• 16 channels, AES/EBU, 24 bits up to 96 kHz 

3.1.6 Alternative Content 

• HDMI input. (See Chapter 23 for the list of supported formats.) 
• HD-SDI (1.5 gigabit) support.  
• Dual 3G-SDI. 
• Live content (network input). 
• Alternative audio routing (using HDMI audio, SDI embedded audio, and live input). 

3.1.7 Preloaded Test Content 

• Used for testing playback when hard drives are not installed. See Section 3.1.7 for 
more information.  



 Input and Output Ports 
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3.2 Input and Output Ports 

• Three Gigabit Ethernet (RJ-45)  
• One eSATA 3 Gbps 
• One USB 2.0 port 
• Two USB 3.0 ports 
• One HDMI input 
• Two 3G-SDI bidirectional (input and output) 
• Eight AES pair (using two RJ-45) 
• Four GPI ports (one RJ-45) 
• Six GPO ports (one RJ-45) 

3.3 Environmental Specifications 

Temperature range (ambient): 

• Operating: 10° C to 40° C (50 °F to 104° F) 
• Nonoperating: –20° C to 60° C (–4° F to 140° F) 

3.4 Performance, Storage, and Power 

• The IMS2000 uses three 1 TB hard-disk drives (2.5 inch), providing 2 TB of media 
storage. 

• Software RAID5 storage. 
• The IMS2000 supports up to 4K 30 fps and 2K HFR up to 120 fps. 
• The IMS2000 supports 500 Mbps playback. 
• Battery: IMS2000 battery is a Panasonic™ vanadium rechargeable lithium battery 

(VL3032). 
• Power <70 W (power input 12 V @ 6.25 A from projector main low-voltage 

differential signaling [LVDS] connector). 
• External network-attached storage (NAS) support for additional content storage. (See 

Section 12.22.1) 
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3.5 IMS2000 Top and Front Views 

Following are the IMS2000 top and front views. 

 

Figure 3-1 IMS2000: Top View 

 

 

Figure 3-2 IMS2000: Front View 

3.6 Ethernet 

The IMS2000 has three built-in Gigabit Ethernet connectors.  

From the left, the ports are identified as ETH0, ETH1, and ETH2. 

 

3.7 eSATA 

The eSATA port is used for ingesting content. 



 USB 
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3.8 USB 

There are three USB ports on the front panel that can accommodate an external USB 
device, such as the CaptiView transmitter or USB external drive for content ingestion. 
One is a USB 2.0 port, and two are USB 3.0 ports.  

The IMS2000 supports USB 3.0 for ingesting content at much higher speeds than devices 
using USB 2.0. In some situations, a USB 3.0 drive may be detected as USB 2.0. This will 
prevent you from ingesting content at the highest speed possible. Make sure that you are 
using a good quality cable. 

 
Note: You can identify a USB 3.0 capable cable by looking at the connector ends. 

USB 3.0 cables have blue connectors, as shown here. 
 

 
 
If the cable is plugged into the IMS2000 slowly, the USB 2.0 pins are 
detected first and the drive is mounted using the slower 2.0 settings. If a 
prompt appears that says This device could perform faster in the carousel, 
this indicates that the USB 3.0 drive was detected as USB 2.0. In such a 
case, try to reset the connection. 

3.9 HDMI 

HDMI is used for inputting alternative content (that is, from a Blu-ray Disc™ player, 
game console, digital cameras, or laptop). 

High-bandwidth Digital Content Protection (HDCP) is supported. 

3.10 SDI-A/SDI-B 

• 3G-SDI  
• For dual-projector setups 
• Chase mode 
• Alternative content inputs 
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3.11 GPI 

• General purpose input for automation interface 
• RJ-45 connector 

Table 3-1 GPI Pin Number and Description      

 
 

Pin Number Description 

1 GPI 0+ 

2 GPI 0– 

3 GPI 1+ 

4 GPI 2+ 

5 GPI 2– 

6 GPI 1– 

7 GPI 3+ 

8 GPI 3– 



 GPO 
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3.12 GPO 

• General purpose output for automation interface 
• RJ-45 connector 

Table 3-2 GPO Pin Number and Description      

 
 
 
 
 
 
 
 

 
Note: GPO 5 can be configured for LTC output via an internal jumper. 

3.13 AES Out 1–8 

• Digital audio channels 1–8 output 
• RJ-45 connector 

Table 3-3 AES-Out 1–8 Pin Number and Description      
 
 
 
 
 
 
 
 

 

•   

 
 

 

 

 

 

Pin Number Description 

1 GPO 0 

2 GPO 1 

3 GPO 2  

4 GPO 4 

5 GPO 5 

6 GPO 3 

7 +5 VDC 

8 Ground 

Pin Number Description 

1 Channel 1 and 2 plus 

2 Channel 1 and 2 minus 

3 Channel 3 and 4 plus 

4 Channel 5 and 6 plus 

5 Channel 5 and 6 minus 

6 Channel 3 and 4 minus 

7 Channel 7 and 8 plus 

8 Channel 7 and 8 minus 
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3.14 AES Out 9–16 
 
 
 

• Digital audio channels 1–8 output 

• RJ-45 connector 
 

Table 3-4 AES Out 9–16 Pin Number and Description      

 
 
 
 

 

 

 

 
 

 

3.15 LEDs 

See the following figure for LED placement. 

 
 

 
 
 
 

Figure 3-3 IMS2000: Front View 
 

For more information, see Chapter 22.  
 

Pin Number Description 

1 Channel 9 and 10 plus 

2 Channel 9 and 10 minus 

3 Channel 11 and 12 plus 

4 Channel 13 and 14 plus 

5 Channel 13 and 14 minus 

6 Channel 11 and 12 minus 

7 Channel 15 and 16 plus 

8 Channel 15 and 16 minus 

          
CPU 1 and 2 LEDs 

 HDMI LED 
 

SDI A and B LEDs 
 

SM LEDs 
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Chapter  4 Installing and Marrying an IMS2000 
with an NEC Series 2 Projector 

Before you begin to install the IMS2000 into your NEC Series 2 projector, be sure that: 

• The projector is powered down and in the off position.  
• The power cord is disconnected from the wall. 
• You always follow electrostatic discharge  procedures. For more information see 

Chapter 2. 

4.1 Preparing for the Installation 

You must prepare the projector prior to installing the IMS2000 unit, as described in this 
chapter. 

 

Figure 4-1 NEC Projector 

Chapter 4 
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To prepare the projector for the IMS200 installation: 

1. Remove the filter cover.  
 

  

Figure 4-2 Removing Filter     

2. Remove the four screws holding the projector cover in place.  

 

Figure 4-3 Removing Filter Screws  

Screw 

Key hole 

Filter cover 

Screw 

Screw Screw 



 LEDs 
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3. Use the key to unlock the projector.  

 

Figure 4-4 Projector Unlock     

4. Remove the cover from the projector. 

 

Figure 4-5 Projector Cover Removed     

5. Remove the blank cover from the media block slot by unscrewing its two handles at 
the side. 

 

 

Figure 4-6 Removing the Slot Cover     

Blank cover 

Two handles 
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Figure 4-7 Empty Slot     

6. Remove the IMS2000 from its carton and antistatic bag.  
7. Slide the IMS2000 board into the projector media block slot.  

 

Figure 4-8 IMS2000 Inserted Without Hard-Disk Drives     

8. Screw in the handles on the side of the IMS2000 to secure it in the projector. 

  

Figure 4-9 Securing the Board     

Guide rail 

Two 
handles 
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4.2 Installing Hard-Disk Drives  

Each hard-disk drive is shipped out of its chassis. Upon initial installation, insert each 
drive into the IMS2000 hard-disk drive chassis carrier prior to powering up the projector. 
Do not insert or remove a hard-disk drive if the unit is powered on. Each hard-disk drive 
must be of the same make and model with identical storage capacity. We prohibit 
intermixing SATA I drives with SATA II drives within the same RAID. 

To install the hard-disk drives: 

1. Release the lever of the hard-disk drive carrier by pressing the release tab. 
Insert each hard-disk drive into the hard-disk drive slot with the handle open. 

2. Push the handle in until it locks in to place. 

 

Figure 4-10 Hard-Disk Drive Latch    

 

Figure 4-11 Hard-Disk Drive Latch    

Silver release 
lever 

Hard-disk drive 
carrier handle 



Installing and Marrying an IMS2000 with an NEC Series 2 Projector  
 

 

 
18 Dolby® IMS2000 Installation and User’s Manual 
 IMS.OM.004730.DRM: Issue:1 
 

 

Repeat steps 1–3 for the remaining hard-disk drives. 

 

Figure 4-12 Hard-Disk Drives Inserted    

4.3 Reattaching the Projector Covers 

To protect and secure the IMS2000 and any other devices that may be installed, you must 
reattach the projector cover. 

To reattach the projector cover: 

1. Position the projector cover by lining it up with the screw holes. 
2. Secure the cover by tightening the four screws. 

 

Figure 4-13 Reattaching the Projector Cover  

   

3. Use the key to lock the projector in place. 
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Figure 4-14 Locking the Projector    

4. Reattach the filter cover by pushing it into place.  

 

Figure 4-15 Reattaching the Filter Cover    
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Connecting the Audio Cables 

This section shows you how to connect the audio cables to the Dolby® IMS2000.  

 

Figure 4-16 AES Audio Ports   

To connect the audio cables: 

1. Connect one end of a shielded CAT5 or CAT6 cable to the AES-OUT 1-8 port, then 
connect the other end of the cable to the audio processor.  

2. Connect one end of another shielded CAT5 or CAT6 cable to the AES-OUT 9-16 port, 
then connect the other end of the cable to the audio processor. 

 

 
Note: If your audio processor does not have RJ-45 ports but has a single 25-pin 

D-connector, you need to use the RJ-45 to 25-pin D-connector converter 
that is provided with the IMS2000. 

 

 

Figure 4-17 RJ-45 to 25-Pin D-Connector Converter   

AES out 1–8 

AES out 9–16 
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4.4 Connecting the GPI and GPO Cables 

To connect the GPI and GPO cables to the IMS2000:  

1. Connect one end of a shielded CAT5 or CAT6 cable to the GPI port on the IMS2000.   
2. Connect the other end of the shielded CAT5 or CAT6 cable to whichever automation 

controller is available or required. 
3. Connect another shielded CAT5 or CAT6 cable to the GPO port on the IMS2000.  
4. Connect the other end of the shielded CAT5 or CAT6 cable to your automation 

controller. 

  

Figure 4-18 GPI and GPO Ports    

 

GPI 

GPO 
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4.4.1 GPI/GPO Pinout Information 

Figure 4-19 shows the RJ-45 pinouts. 

 

Figure 4-19 RJ-45 Socket Pinout    

4.5 Connecting the Ethernet Cable 

To install the Ethernet cable, connect one end of the cable to an IMS2000 Ethernet port, 
then connect the other end of the cable to a laptop or a network switch.  

 

Figure 4-20 Ethernet Connector 

 

 

Note: Ethernet ports (ETH-1 and ETH-2) are set to DHCP by default. All IMS2000 
boards are shipped from the factory with the following default IP address 
for ETH-0: 

IP: 192.168.100.50 
SM: 255.255.255.0 
GW: Blank 

For more information, refer to Chapter 25. 

Ethernet 
cable 
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4.6 Powering on the Projector 

The projector needs to be powered on.  

To power on the projector: 

1. Connect the power cable to the projector. 

 

Figure 4-21 Connecting the Power Cable    

2. Turn the projector on. 

 

 

Note: Refer to the projector manufacturer manual for the proper power-up 
sequence. 

 

 

Figure 4-22 Power Switch   
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4.7 Accessing the GUI 

To access the IMS2000 graphical user interface (GUI), launch your browser on the 
connected computer and enter the IP address in the address bar. 

The Dolby IMS2000 login screen appears. 

Enter the following information: 

• User name: operator 
• Password: operator 

Then click on the Login button. 

4.8 Configuring the Projector 

For the projector to communicate with the IMS2000:, configure it in the Device Manager.  

To configure the projector: 

1. While the projector is booting up, click Administration > Device Manager. 
2. Click the New button. 

  

Figure 4-23 Device Manager   

New button 
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3. Select Projector from the New Device drop-down menu.  

 

Figure 4-24 Selecting Projector   

4. Populate the projector parameters that appear.  

 

Figure 4-25 Projector Added    

5. Click the Save button.  

Projector 
selection 

Save 
button 
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4.9 Performing the Marriage Operation 

To perform the marriage: 

1. Download and install the latest version of the Digital Cinema Communicator for S2.  
When first opened, the Communication Settings window appears. 

 

 
Note: If you do not have the latest version installed, contact your administrator. 

 
2. Input the IP address of the projector, and click the OK button.  

 

Figure 4-26 Communication Settings    

OK button 
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3. Click on the MODE button.  

 

Figure 4-27 Mode Button   

4. Click the Service button, and input the correct password. 
To obtain the password, contact your administrator.  

5. Click OK.  

  

Figure 4-28 Control Mode Window 

Mode 
button 

Service 
button 
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6. Use the arrow button in the window that appears to scroll until the SETUP button is 
available.  

7. Click on the SETUP button.  

  

Figure 4-29 Setup Button 

When the Setup window appears: 

a. Click the Option Slot button. 
b. Select IMB from the list, then click the Apply button. 

 
Figure 4-30 Setup Window 

Setup 
button 

Arrow button 

Option slot 
button 
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Figure 4-31 Option Slot Window 

8. Click on the Installation button. 
9. Click on the Re-Marriage button.  

 

Figure 4-32 Remarriage Button  

Apply 
button 

Installation 
button 

Remarriage 
button 
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10. Enter the appropriate password and login. Contact your administrator for the 
necessary information. Click the Re-Marriage button. 

  

Figure 4-33 Remarriage Login 

A window appears stating that the operation was successful. 
11. Click the OK button.  

 

Figure 4-34 Operation Successful Message 

12. To arm the service door, press and hold the MENU button on the projector. 
13. Enter the appropriate password, and press the ENTER button on the projector. Contact 

your administrator for the password.  

 

Figure 4-35 Projector Menu 

 

Menu 
button 

Remarriage 
button 

OK button 

Enter 
button 
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14. To ensure that the marriage was completed correctly, on the IMS2000 GUI, select 
Monitoring > Diagnostics > MediaBlock. 
The MediaBlock window appears. 

15. Verify the following in the Security Manager section of the MediaBlock window: 
Status: Green 
Physical Marriage: Active 
Logical Marriage: Engaged 
Active Marriage: Active 

 

Figure 4-36 Security Manager Section 

Marriage has now been completed. 

Security 
manager 
section 
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Chapter  5 Installing and Marrying an IMS2000 
with a Barco Series 2 Projector 

Before you begin to install the IMS2000 into your projector, be sure that: 

• The projector is powered down and in the off position.  
• The AC power cord is disconnected from the wall. 
• You always follow electrostatic discharge procedures. 

5.1 Preparation 

You must prepare the projector prior to installing the IMS2000. 

 

Figure 5-1 Barco Projector      

Chapter 5 
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To prepare the projector for the IMS200 installation: 

1. Remove the blank cover of the media block slot by unscrewing the two screws on the 
sides. 

 

Figure 5-2 Unscrewing Blank Cover 

 

Figure 5-3 Empty Media Block Slot 

2. Remove the IMS2000 from its carton and antistatic bag.  
3. Insert the IMS2000 board into the projector media block slot guide rails.  
4. Tighten the two screws to secure the IMS2000.  

 

Figure 5-4 Tightening the Screws     

Guide rails 

Two 
screws 

Blank 
cover 

Two screws 
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5.2 Installing the Hard-Disk Drives 
 

Hard-disk drives are shipped out of their chassis. Upon initial installation, insert each 
drive into the IMS2000 hard-disk drives chassis carrier prior to powering up the 
projector. Do not insert or remove hard-disk drives if the unit is powered on. hard-disk 
drives must be of the same make and model and with identical storage capacity. 
Weprohibit intermixing SATA I drives with SATA II drives within the same RAID. 

Each hard-disk drive has a silver latch mechanism that allows for unlatching of the drive 
from the hard-drive cage.  

To install the hard-disk drives: 

1. Release the lever of the hard-disk drive carrier by pressing the release tab. 

 

Figure 5-5 Hard-Disk Drive Release Tab     

2. Insert each hard-disk drive into the hard-disk drive slot with the handle open. 
3. Push the handle in until it locks into place. 

   

Figure 5-6 Inserting Hard-Disk Drive     

4. Repeat steps 1–3 for the remaining hard-disk drives. 
 

Silver release 
tab 

Hard-disk drive 
carrier handle 
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Figure 5-7 Hard-Disk Drives Inserted      

5.3 Connecting Audio Cables 

You must connect the audio cables to the Dolby® IMS2000 unit.  

 

Figure 5-8 Audio Connectors     

To connect the audio cables: 

1. Connect one end of the shielded CAT5 or CAT6 cable to the AES-OUT 1-8 connector 
on the IMS2000 board. 

2. Connect the other end of the shielded CAT5 or CAT6 cable to the audio processor.  
3. Take another shielded CAT5 or CAT6 cable, and connect it to the AES-OUT 9-16 

connector on the IMS2000 board. 
4. Plug the other end of the shielded CAT5 or CAT6 cable to the audio processor. 

AES out 1–8 

AES out 9–16 
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Note: To hear audio from an object track at the Dolby Rendering and Mastering 

Unit (RMU), the object must exist in Pro Tools® (that is, the track Panner 
plug-in must have an object number assigned to it), and the I/O Setup must 
be configured for Dolby Atmos®. 
 
When the object exists, auxiliary input tracks and other tracks that route to 
the same object output path will also output at the RMU. 

      

Figure 5-9 RJ-45 to 25-Pin D-Connector Converter     

5.4 Connecting the GPI/GPO 

To connect the GPI/GPO to the Dolby IMS2000: 

1. Connect one end of a shielded CAT5 or CAT6 cable to the GPI connector on the 
IMS2000 board.   

2. Connect the other end of the shielded CAT5 or CAT6 cable to an available or required 
automation controller . 

3. Connect another shielded CAT5 or CAT6 cable to the GPO connector on the IMS2000.  
4. Connect the other end of the shielded CAT5 or CAT6 cable into an available or 

required automation controller. 

  

Figure 5-10 GPI/GPO Connectors    

GPO 

GPI 
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5.4.1 GPI/GPO Pinout Information 

The following figure shows the RJ-45 socket pinout. 

 

Figure 5-11 RJ-45 Socket Pinout     

5.5 Connecting Ethernet Cables 

You must connect the Ethernet cables to an available laptop or network switch. 

To connect the Ethernet cables: 

1. Connect one end of an Ethernet cable to the LAN connector on the Barco® projectors 
cinema controller slot, then connect the other end of the cable to either a laptop or 
network switch.  

 

Figure 5-12 Ethernet Connections     

LAN 
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Note: Ethernet ports (ETH-1 and ETH-2) are set to DHCP by default. All IMS2000 

boards are shipped from the factory with the following default IP address 
for ETH-0: 

• IP: 192.168.100.50 
• SM: 255.255.255.0 
• GW: Blank 

 
2. Connect one end of an Ethernet cable to the IMS2000 Ethernet connector, and then 

connect the other end of the cable to the LAN connector on the Barco projectors cinema 
controller slot. 

 

Figure 5-13 Ethernet Connections     

5.6 Powering on Projector 

The projector needs to be powered on.  

To power on the projector: 

1. Connect the power cable to the projector. 

 

Figure 5-14 Connecting Power     

2. Turn the projector on.  
The expected boot-up time is approximately two minutes, 30 seconds.  

Ethernet 
connector 

LAN 
connector 
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For more information, refer to the projector manufacturer manual for proper power-
up sequence.  

 

Figure 5-15 Power Switch     

5.7 Accessing the GUI 

To access the IMS2000 GUI, launch your browser on the connected computer and enter 
the IP address into the browser window. 

The Dolby IMS2000 Login screen appears: 

1. Enter the user name: operator. 
2. Enter the password: operator. 
3. Click the Login button. 

5.8 Marriage 

Marriage on the Barco projector occurs directly on the projector. After marriage is 
complete, the Barco projector is automatically detected in the Device Manager. 

Once the projector has finished booting up, the taillights at the back of the projector 
illuminate in red, indicating that the board and the projector are not married. If there is a 
touch screen attached to the projector, two tamper errors appears, indicating that the 
marriage has not occurred. 



 Marriage 
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Figure 5-16 Tamper Errors     

To perform the marriage: 

1. Push the button with the key symbol. It should illuminate in red to indicate that the 
marriage is not complete.  

 

Figure 5-17 Button with Key Symbol      

After you push the button with the key symbol, the numbered buttons should flash 
in orange. 

2. Enter the correct password. 
If you do not have a valid password, contact your projector manufacturer 

The numbered buttons flash green when you have entered the password correctly. 

3. Allow approximately a minute for the tamper errors to clear.  
Once the marriage is completed, the button with the key symbol turns green and the 
taillight also turns green.  

 

Figure 5-18 Green Key Button      

Key 
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4. To ensure that the marriage was completed correctly, on the IMS2000 GUI, select 
Monitoring >Diagnostics> MediaBlock. 
The MediaBlock window appears. 

5. Verify the following in the Security Manager section of the MediaBlock window: 
• Status: Green 
• Physical Marriage: Active 
• Logical Marriage: Engaged 
• Active Marriage: Active 

 

Figure 5-19 Security Manager Section 
 

Marriage has now been completed. 

 

Security 
Manager 
section 
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Chapter  6 Installing and Marrying an IMS2000 
with a Christie Series 2 Projector 

Before you begin to install the IMS2000 into your projector, be sure that: 

• The projector is powered down and in the off position.  
• Disconnect the AC power cord from the wall. 
• Remember to always follow electrostatic discharge procedures. 

6.1 Preparation 

You must prepare the projector prior to installing the IMS2000 unit, as described in this 
chapter. 

 

Figure 6-1 Christie Projector      

Chapter 6 
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To prepare the projector for the installation of the IMS2000 unit: 

1. Remove the blank cover of the media block slot, if it is present, by unlatching the two 
latches on the sides. 

 

Figure 6-2 Faceplate Latches      

1. The media block slot should now be empty. 

 

Figure 6-3 Empty Media Block Slot      
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2. Remove the IMS2000 from its carton and antistatic bag. 
3. Insert the IMS2000 board into the projector media block slot guide rails on the inside 

of the slot. 
The latches must be out and open for the IMS2000 to fit properly.  

4. To open the latches, press the red button.  

 

Figure 6-4 Red Button on Latch      

5. Close the two latches to secure the board.  

 

Figure 6-5 IMS2000 Installation      
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6.2 Installing Hard-Disk Drives  

Hard-disk drives are shipped out of their chassis. Upon initial installation, insert each 
drive into the IMS2000 hard-disk drives chassis carrier prior to powering up the 
projector. Do not insert or remove hard-disk drives if the unit is powered on. hard-disk 
drives must be of the same make and model with the storage capacity. Dolby prohibits 
mixing SATA I drives with SATA II drives within the same RAID. 

Each hard-disk drive has a silver latch mechanism that enables you to unlatch the drive 
from the hard drive cage.  

1. Release the lever of the hard-disk drive carrier by pressing the release tab. 

 

Figure 6-6 Silver Latch on Hard-Disk Drive      

2. Insert each hard-disk drive into the hard-disk drive slot with the handle open. 
3. Push the handle in until it locks into place. 

Silver release 
tab 
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Figure 6-7 Inserting the Hard-Disk Drive     

4. Repeat steps 1–3 for the remaining hard-disk drives. 

 

Figure 6-8 Hard-Disk Drives Inserted        

Spring-loaded 
hard-disk drive 
carrier handle 
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6.3 Connecting Audio Cables 

 

Figure 6-9 Audio Connectors     

1. Connect one end of the shielded CAT5 or CAT6 cable to the AES-OUT 1-8 connector 
on the IMS2000 board. 

2. Connect the other end of the shielded CAT5 or CAT6 cable to the audio processor.  
3. Take another shielded CAT5 or CAT6 cable, and connect it to the AES-OUT 9-16 

connector on the IMS2000 board. 
4. Plug the other end of the shielded CAT5 or CAT6 cable to the audio processor. 

 

 
Note: If the audio processor does not have RJ-45 connectors but has a single 25-

pin D-connector, then you will need to use the RJ-45 to 25-pin D-connector 
converter that is provided with the IMS2000.  

      

Figure 6-10 RJ-45 to 25-Pin D-Connector Converter     

AES out 1–8 
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6.4 Connecting GPI/GPO Cables 

 

Figure 6-11 Audio Connectors     

1. Connect one end of the shielded CAT5 or CAT6 cable to the connector labeled GPI on 
the IMS2000 board.  
Connect the other end of the shielded CAT5 or CAT6 cable into whichever 
automation controller is available or required. 

2. Take another shielded CAT5 or CAT6 cable, and connect it into the connector labeled 
GPO.  
Connect the other end of the shielded CAT5 or CAT6 cable into an automation 
controller that is available or required. 

GPI 

GPO 
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6.4.1 GPI/GPO Pinout Information 

Figure 5-11 presents an image of the RJ-45 socket pinout. 

 

Figure 6-12 RJ-45 Socket Pinout    

6.5 Connecting Ethernet Cables 

You must connect the Ethernet cables to an available laptop or network switch. 

To connect the Ethernet cables, connect an Ethernet cable to the Ethernet connector on the 
IMS2000, and then connect the other end of the cable to either a laptop or network 
switch.  

 

Figure 6-13 Ethernet Connection     
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Note: Ethernet ports (ETH-1 and ETH-2) are set to DHCP by default. All IMS2000 

boards are shipped from the factory with the following default IP address 
for ETH-0: 
 

• IP: 192.168.100.50 
• SM: 255.255.255.0 
• GW: Blank 

6.6 Power On the Projector 
 

 
 

1. Connect the power cable to the projector.  

 

Figure 6-14 Connecting the Power Cable     

After approximately two minutes, the main screen appears on the touch-panel controller.  
2. Go to Login. 
3. Log in as Marriage. 

Contact your administrator for the correct password.  

  

Figure 6-15 Selecting Login     

Login 
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4. Select Content Devices Configuration.  
5. Verify that Doremi is selected in the Devices Installed drop-down menu. 

  

Figure 6-16 Content Device Configuration 

 

Figure 6-17 Devices Installed Drop-Down Menu     
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6. Turn the projector on by pressing the green power button on the touch-panel 
controller.  
After approximately two minutes, the projector will be fully powered on. 

 

Figure 6-18 Power Button     

An error message appears.  

7. Press the Acknowledge button. 

 

Figure 6-19 Error Message     
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6.7 Accessing the GUI 

After approximately 40 more seconds, the board will be fully powered on and you will 
be able to access the web GUI. To access the IMS2000 GUI, launch your browser on the 
connected computer and enter the IP address in the browser window. 

The Dolby® IMS2000 login screen appears: 

• Enter the user name: operator. 
• Enter the password: operator. 
• Click the Login button. 

6.8 Configuring the Device 

For the projector to communicate with the IMS2000, you must configure it in the IMS2000 
Device Manager while the projector is booting up.  

To access the IMS2000 Device Manager: 

1. Click on Administration> Device Manager. 
2. Click on the New button. 

 

Figure 6-20 IMS2000 Device Manager   

New button 
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3. Select Projector from the New device drop-down menu.  

 

Figure 6-21 Selecting Projector   

4. Populate the projector parameters that appear.  

 

Figure 6-22 Projector Added   

5. Click the Save button. 

Projector 
selection 

Save 
button 
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6.9 Marriage 

Once the projector and board have finished booting up, the lights on the side of the 
projector illuminate in red and green, indicating that the board and the projector are not 
married. The touch-panel controller attached to the projector will show a second error 
window, indicating that the marriage has not occurred.  

To perform the marriage: 

1. Press the Acknowledge button.  

 

Figure 6-23 Projector Added     

2. Select Menu > Service Setup > IMB Marriage. 
The marriage wizard, on the touch-panel controller, guides you through the required 
steps to complete the marriage.  

  

Figure 6-24 IMB Marriage     
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3. Click the Next button to begin.  

 

Figure 6-25 Marriage Wizard      

4. Click on the Next button in the Marriage Checklist window. 

 

Figure 6-26 Marriage Checklist      

Next 
button 

Next 
button 



Installing and Marrying an IMS2000 with a Christie Series 2 Projector  
 

 

 
58 Dolby® IMS2000 Installation and User’s Manual 
 IMS.OM.004730.DRM: Issue:1 
 

 

5. Click on the Arm Marriage button. Once this button is pressed, you have 30 seconds to 
press the Marriage button on the projector, which should now illuminate in green.  

 

Figure 6-27 Arm Marriage Window      
 

  

Figure 6-28 Marriage Button on Projector      
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6. The taillight on the projector will turn green when the marriage process is complete.  

 

Figure 6-29 Green Projection Light  

     

7. To ensure that the marriage was completed correctly, on the IMS2000 GUI, select 
Monitoring > Diagnostics > MediaBlock. 
The MediaBlock window appears. 

8. Verify the following in the Security Manager section of the MediaBlock window: 
• Status: Green 
• Physical Marriage: Active 
• Logical Marriage: Engaged 
• Active Marriage: Active 

 

Figure 6-30 Security Manager Section 

Marriage has now been completed. 
 

Security 
Manager 
section 
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Chapter  7 Shutting Down the IMS2000 

To properly shut down the IMS2000: 

1. Select the System tab. 
2. Click on the Shutdown button, and wait two minutes.  

The LEDs on the IMS2000 will stop flashing, and the hard-disk drive LEDs will have 
a steady light once it has finished shutting down. 

 

Figure 7-1 Security Manager Section      

3. After two minutes, refer to the projector manufacturer manual for proper power 
down sequence to shut down the projector. 

4. The IMS2000 board and the projector have now been properly shut down. 
 

 
Note: The IMS2000 must be shut down according to the designated method. 

Failure to follow this method may result in file corruption. 

 

Chapter 7 
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7.1  Reset Button  

The IMS2000 has a single push-button switch that provides the following functionality, 
when pushed for the appropriate time length: 
• Reset the IMS2000. 
• Place the IMS2000 in standby mode. 
 
 

 

Figure 7-2 Security Manager Section      

The following chart lists the expected behavior for the reset button. 

Table 7-1 Reset Button Behavior 

Pushing the 
Button   

Result 

<3 second No change. 

>3 second CPU reset. 

>10 second Standby mode. 

>10 second If in standby mode, the unit will wake up. 

      
 

Reset button 
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Chapter  8 Configuring the Operating System 

When you log out of the operating system and then log back in, a login authentication 
window appears. The default login name is operator, and the password is operator. 
However, the administrator may have changed and/or added other login user names and 
passwords. Please contact your administrator for the appropriate information. 

 

Figure 8-1 Security Manager Section      
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The Overview tab appears every time the unit is turned on or rebooted. You can access 
various applications from the tabs located across the top of the GUI. 

  

Figure 8-2 Overview Tab      

8.1 Users 

You will be prompted to enter a password for various tasks when using different 
applications. The administrator determines the level of security. 

Contact your system administrator for passwords, not Dolby Laboratories. 

The following are types of passwords/privileges you may be asked for. Select the user 
name and password: 

• admin (administrator): Super User 
• manager: ShowManager 
• root: Administrator 
• ingest: Projection 
• doremi: Projection 

 

Figure 8-3 Selecting Privileges      

Overview tab 
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Note: The IMS2000 will need authentication to complete certain tasks. For 

example, the authentication required in the password confirmation 
window needs Show Manager privileges; therefore, the IMS2000 will 
automatically prompt you to the manager user name. However, it is 
possible to select a different user name from the drop-down list, 
depending on the level of security that has been provided. 
 

8.2 Language Setup 

You are able to change the language of the operating system.  

To change the language:  

1. Click on the Site Language button on the login window (see Figure 8-4).  

 

Figure 8-4 Login Window       

2. Select the language in the window that appears (see Figure 8-5). 
Once selected, the language will change throughout each application. 

 

Figure 8-5 Language Selection Window      
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Figure 8-6 Chinese Language Selected      
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Chapter  9 Configuring the Network 

9.1 Default Network Configuration 

This chapter explains how to configure the network settings. Ethernet ports (ETH-1 and 
ETH-2) are set to DHCP by default.  

All IMS2000 boards are shipped from the factory with the following default IP address 
for ETH-0: 

• IP: 192.168.100.50 
• SM: 255.255.255.0 
• GW: Blank 

9.2 Changing the IP Address 

To change the IP address. 

1. Select Administration > Control Panel > Networking Configuration. 

 

Figure 9-1 Network Configuration      
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2. You will need to populate the following field: 
• Hostname 

 

 
Note: We recommend entering the circuit location/screen number in the host 

name field (for example, Screen-1, as it will be easier to identify in the 
logs). 

 

• Properties of ETH-0, ETH-1, and ETH-2: 
o IP address 

 

 
Note: Do not put leading zeros (0) in front of any numbers. For example, do not 

input 192.168.100.050. 
 

• Netmask 
• Gateway 

 

 
Note: You can use the tick box for all three of these settings to obtain an IP 

address automatically with DHCP. 
 
Click on the 

You will be prompted to key in a password to keep these settings. See your system 
administrator for this password.  

Superuser privileges are necessary to be able to confirm the changes. If you are 
already logged in with superuser privileges, a password window will not appear.  

2. To verify the setup, select Monitoring > Diagnostics > System > Networking and verify 
the IP address listed in the area labeled Networking (see Figure 9-1).  

  

Figure 9-2 System Monitoring Tab      
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9.3 Network Reset 

To can reset the network settings (if these settings require changes). 

1. Select Administration > Control Panel > Networking Configuration.  
2. Click on the Revert button (see Figure 9-3).  

 

 

 

Figure 9-3 Network Configuration Window 
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Chapter  10 Configuring the Time Zone  

This chapter explains how to check and/or change the time zone. By default, all units are 
set to the Pacific time zone (PST or PDT). 

10.1 Checking the Time Zone 
 

 

To check the time and time zone, select Administration > Control Panel > Time Settings and 
the Date and Time tab appears. 
 

 

Figure 10-1 Current Date and Time Window 
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10.2 Changing the Time Zone 

To change the time zone: 

1. Select Administration > Control Panel > Time Settings, and the Date and Time tab 
appears. 

2. Click on the Timezone drop-down menu. 
A list of time zones appears. 

 

Figure 10-2 Selecting a Time Zone 

3. Select the time zone that best represents the geographical area in which the IMS2000 is 
installed. 

4. When you select the appropriate time zone and it appears in theTimezone field, click 
the Update button to save this setting. 
Superuser privileges are necessary to save the change.  

5. Reboot the system for the changes to take effect.  

Update 
button 
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10.3 Changing the System Time 

You can also modify the IMS2000 system clock. 
 

 
Note: The DCI specification allows you to modify the time ± only up to six 

minutes per calendar year. 
 

To modify the system clock: 
1. Select Administration > Control Panel > Time Settings, and the Date and Time tab 

appears. 
2. Click on one of the appropriate drop-down menus to modify minutes or seconds. 

A list of time settings appears in each field. 

  

Figure 10-3 Setting the Time 

3. Once the appropriate time change has been selected and appears within the box 
labeled Change Time, click the Update button to save this setting. 

4. Superuser privileges are necessary to save the change.  
5. If you exceed the allotted ± six-minute limit, contact your first-tier support 

representative.  

Update button 

NTP servers tab 



Configuring the Time Zone  
 

 

 
74 Dolby® IMS2000 Installation and User’s Manual 
 IMS.OM.004730.DRM: Issue:1 
 

 

 

10.4 NTP Servers 

Network Time Protocol (NTP) servers sync the time and date on your unit to coordinated 
universal time (UTC).  

To access the NTP Servers tab: 

1. Click on the green arrow button on the right side of the Date and Time tab. 

2. Select Administration > Control Panel > Time Settings.  
3. Click the Add button to add your NTP server. 

The Extra delay field allows you to add a delay in syncing the server with the NTP 
server. The delay allows you to space out the time in which all servers connect to the 
NTP server.   

 

Figure 10-4 NTP Servers Window 
 

Add 
button 

Extra 
delay 



 Chapter 11 
 

 

 
Dolby® IMS2000 Installation and User’s Manual 
IMS.OM.004730.DRM: Issue:1 75 

 

Chapter  11 Using the Overview Tab 

The Overview tab will always display first upon logging in to the IMS2000 GUI. This tab 
provides you with a snapshot of the current system status. The top section of the screen, 
labeled Playback Status, will display the current playback status along with any 
upcoming show playlist schedules. 

The lower part of this screen displays the current system status and is divided into two 
sections for storage and IMS2000 information. Hot links on this tab provide quick access 
to the respective functions. 

From the top tabs bar, you can navigate to the ADMINISTRATION tab, CONTROL tab, or the 
MONITORING tab.  

 

Figure 11-1 Overview Tab 
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11.1 Notification Bar 

The bottom notification bar allows you to quickly access important features of the 
IMS2000. These buttons are available and can be accessed at the bottom of every tab. 

11.1.1 Quick Controls  

The Quick Controls button allows quick access to macros that have been added in the 
Quick Controls tab. You will be able to execute a macro from any tab on the GUI: 

1. To execute a macro select:, Administration > Macro Editor > Quick Controls. 
For information on how to add macros to the Quick Controls tab, refer to See Section 
12.7. 

2. Click on the Quick Controls button when the macros have been added, and the macros 
appear. 

 

Figure 11-2 Quick Controls  

3. Click on the macro to execute it. 
4. Clicking on the Quick Controls button again will cause the window to close. 

Quick 
controls 
button 

Macros 
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11.1.2 Playback  

The Playback button alerts you to any playback that is in progress.  

If playback is in progress, you can click on the Playback button, which will open up the 
CineLister Playback tab. If playback is not in progress, clicking on the button will open up 
the CineLister Editor tab. For more information on the CineLister tab and playback, see 
Chapter 13.  

 

 

Figure 11-3 Playback Button 
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11.1.3 Ingest 

The Ingest button alerts you to any ingest that is in progress.  

Clicking on the button will open the Ingest Monitor tab that displays the ingest progress. 
For more information on ingesting, refer to See Section 13.9. 

   

 

Figure 11-4 Ingest Monitor Window 

11.1.4 Session Viewer 

The Session Viewer button displays all of the users that are currently logged onto the 
unit.  
Click the Session Viewer button to open the Session Viewer window. Clicking on the 
button again will cause the window to close. 

  

Figure 11-5 Session Viewer Window 
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11.1.5 Notifications 

The Notifications button provides you with notifications for RAID status, NTP status, 
updates, software integrity, disk space quota, and more. A number appears in the corner 
when there is a new notification.  

 

 

Figure 11-6 Notifications Window 
 

2. Click on the Notifications button to view the notifications. Clicking on the 
Notifications button again will cause the window to close. Hovering over the 
More Details button provides more details about the notification. 

3. To delete a notification, highlight it and click on the X that appears on the right-
hand side. 

4. To delete all notifications, click on the X in the upper right corner of the window. 
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Chapter  12 Using the Administration Tab 

The IMS2000 GUI Administration tab provides access to various applications. Follow the 
instructions provided in this section to access the administration applications. 

1. Click on the Administration tab. 
A drop-down list appears when the mouse is hovering over the tab. The default tab 
is the Control Panel tab, which has several more applications available. 

2. Clicking on individual tabs when hovering over an application will take you directly 
to that tab.  

 

Figure 12-1 Control Panel     

• Device Manager: Allows you to add, edit, and delete different projectors, close 
caption devices, subtitle devices, and more.  

• Content Feed Manager: Allows you to connect to other servers. Once connected, the 
specified servers will show in the Ingest Manager and will be able to pull show 
playlists, CPLs, KDMs, and digital license messages. 

• Macro Editor: Allows you to view, edit, and add macros. 
• Terminal: Allows you to perform terminal commands.  
• System: Allows you to shut down, restart, and place the unit on standby. 
• Control Panel: 

• Account Manager: Allows you to add, remove, and edit user accounts. 
• Interface Settings: Allows you to select an interface size. 
• Networking Configuration: Allows you to setup and modify network connections. 

Chapter 12 
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• Quick Access Links: Allows you to create links on the left side of the GUI for 
quick access to certain applications.  

• Theater Properties: Allows you to input the information for the theatre facility, 
contacts, and auditorium. 

• Time Settings: Allows you to check and change the time and time zone. 
Changing the time is limited annually.  

• Audio Settings: Allows you to map and route all audio tracks to operator-
designated outputs (only SMPTE content). Here you can configure the audio 
delay. 

• CineLister Configuration: Allows you to configure certain values for the 
CineLister application. 

• Live Manager: Allows you to add a live event CPL. 
• NAS Manager: Allows you to manage and configure the NAS setup.  
• Backup Manager: Allows you to back up and restore certain files on a server. 
• License Agreement: Allows you to agree to the software license terms and 

conditions. 
• Automatic Log Upload Manager: Allows you to automate log generation and 

specify the frequency and location the logs will be sent to.   
• Log Operator Maintenance: Allows you to log important information (for 

example, hard disk replacement, projector lamp replacement, and so on). This 
application helps the system administrator keep track of any change operated in 
a theatre booth. 

• Threshold Manager: Allows you to view and adjust threshold levels for the 
server.  
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12.1 Audio Settings/Channel Mapping 

The audio settings application allows you to route all audio tracks in a SMPTE Interop 
package to operator-designated outputs. The main purpose of the mapping is to allow 
you to move the hearing impaired or visually impaired channels to a specific output. The 
audio settings application is available from the Administration tab.  

1. To open the audio settings application, select, Administration > Control Panel > Audio 
Settings. 
When first launched, the audio settings application opens in the Audio Delay tab. 

 

Figure 12-2 Audio Mapping Window: Disabled Setting     

2. Click on the Channel Mapping arrow to get to the Channel Mapping tab. The Template 
Mapping feature will be set to Disabled. 

 

 
Note: All of the templates (except Disabled) can be modified directly instead of 

having to select Custom. Once the template is edited, the template 
mapping will read Custom. 

 

Template mapping 

Channel mapping tab 
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Available configurations include: 

• Disabled: This setting is the default and as such cannot be mapped. 
• 4 channels: This is a preset configuration. 
• 6 channels: This is a preset configuration. 
• 7 channels: This is a preset configuration. 
• 8 channels: This is a preset configuration. 
• 9 channels: This is a preset configuration. 
• ISDCF: This is a preset configuration. 
• Passthrough: This is a preset configuration. 
• Custom: This setting allows you to create your own custom audio configuration. 

To make any changes to the audio configuration, superuser privileges are necessary. 

12.2 Channel Mapping Tab 

12.2.1 Disabled Configuration 

This section provides information on the Disabled configuration setting. 

Disabled: This is the default setting and cannot be mapped. The Disabled mapping 
configuration will perform pass-through mapping, meaning channel number X of the 
CPL audio track will be routed to audio output number X (variable) of the server, X being 
a number between 1 and 16. When the configuration is grayed out, you cannot change 
the configuration.  

 

Figure 12-3 Disabled Configuration     



 Channel Mapping Tab 
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12.2.2  Predefined Mapping Configurations 

 Four Channels 

This configuration is defined as follows: 

• Ch.01 is L/Left: Output Ch.01  plays the CPL Left (L) audio channel. 
• Ch.02 is R/Right: Output Ch.02  plays the CPL Right (R) audio channel. 
• Ch.03 is C/Center: Output Ch.03  plays the CPL Center (C) audio channel. 
• Ch.04 is Input: Ch.04 is pass-through, meaning the output channel X plays the CPL 

audio channel X. 
• Ch.05 is S/Surround: Output Ch.05  plays the CPL Surround audio channel. 
• Ch.06–Ch.14: These channels are pass-through, meaning the output channel X plays 

the CPL audio channel X. X will be a value between 6 and 14. 
• Ch.15 is H/Hearing Impaired: Output Ch.15  plays the CPL hearing impaired audio 

channel. 
• Ch.16 is VI-N/Narration: Output Ch.16  plays the CPL narration/visually impaired 

audio channel. 

 

Figure 12-4 Audio Mapping Set to Four Channels     
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Six Channels 

This configuration is defined as follows: 

• Ch.01 is L/Left: Output Ch.01 plays the CPL Left (L) audio channel. 
• Ch.02 is R/Right: Output Ch.02 plays the CPL Right (R) audio channel. 
• Ch.03 is C/Center: Output Ch.03 plays the CPL Center (C) audio channel. 
• Ch. 04 is LFE/Screen: Output Ch.04 plays the CPL LFE (screen) audio channel. 
• Ch.05 is Ls/Left Surround: Output Ch.05 plays the CPL Left Surround (Ls) audio 

channel. 
• Ch.06 is Rs/Right Surround: Output Ch.06 plays the CPL Right Surround (Rs) audio 

channel. 
• Ch.07–Ch.14: These channels are pass-through, meaning the output channel X plays 

the CPL audio channel X. X will be a value between 7 and 14. 
• Ch.15 is H/Hearing Impaired: Output Ch.15  plays the CPL hearing impaired audio 

channel. 
• Ch.16 is VI-N/Narration: Output Ch.16  plays the CPL narration/visually impaired 

audio channel. 

 

Figure 12-5 Audio Mapping Set to Six Channels     
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Seven Channels 

This configuration is defined as follows: 

• Ch.01 is L/Left: Output Ch.01  plays the CPL Left (L) audio channel. 
• Ch.02 is R/Right: Output Ch.02  plays the CPL Right (R) audio channel. 
• Ch.03 is C/Center: Output Ch.03  plays the CPL Center (C) audio channel. 
• Ch.04 is Input: Ch.04 is pass-through, meaning the output channel X play the CPL 

audio channel X. 
• Ch.05 is Ls/Left Surround: Output Ch.05 will be playing the CPL Left Surround (Ls) 

audio channel. 
• Ch.06 is Rs/Right Surround: Output Ch.06 will be playing the CPL Right Surround 

(Rs) audio channel. 
• Ch.07 is Input: Ch.07 is pass-through, meaning the output channel X will be playing 

the CPL audio channel X. 
• Ch.08 is Input: Ch.08 is pass-through, meaning the output channel X will be playing 

the CPL audio channel X. 
• Ch.09 is Cs/Center Surround: Output Ch.09 will be playing the CPL Center Surround 

(Cs) audio channel. 
• Ch.10–Ch.14: These channels are pass-through, meaning the output channel X will be 

playing the CPL audio channel X. X will be a value between 10 and 14. 
• Ch.15 is H/Hearing Impaired: Output Ch.15 plays the CPL hearing impaired audio 

channel. 
• Ch.16 is VI-N/Narration: Output Ch.16 plays the CPL narration/visually impaired 

audio channel. 

 

Figure 12-6 Audio Mapping Set to Seven Channels     
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Eight Channels 

This configuration is defined as follows: 

• Ch.01 is L/Left: Output Ch.01 plays the CPL Left (L) audio channel. 
• Ch.02 is R/Right: Output Ch.02 plays the CPL Right (R) audio channel. 
• Ch.03 is C/Center: Output Ch.03 plays the CPL Center (C) audio channel. 
• Ch. 04 is LFE/Screen: Output Ch.04 plays the CPL LFE (screen) audio channel. 
• Ch.05 is Ls/Left Surround: Output Ch.05 plays the CPL Left Surround (Ls) audio 

channel. 
• Ch.06 is Rs/Right Surround: Output Ch.06 plays the CPL Right Surround (Rs) audio 

channel. 
• Ch.07 is Lc/Left Center: Output Ch.07 plays the CPL Left Center (Lc) audio channel. 
• Ch.08 is Rc/Right Center: Output Ch.08 plays the CPL Right Center (Rc) audio 

channel. 
• Ch.09–Ch.14: These channels are pass-through, meaning the output channel X plays 

the CPL audio channel X. X will be a value between 9 and 14. 
• Ch.15 is H/Hearing Impaired: Output Ch.15  plays the CPL hearing impaired audio 

channel. 
• Ch.16 is VI-N/Narration: Output Ch.16  plays the CPL narration/visually impaired 

audio channel. 

 

Figure 12-7 Audio Mapping Set to Eight Channels     
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Nine Channels 

This configuration is defined as follows: 

• Ch.01 is L/Left: Output Ch.01 plays the CPL Left (L) audio channel. 
• Ch.02 is R/Right: Output Ch.02 plays the CPL Right (R) audio channel. 
• Ch.03 is C/Center: Output Ch.03 plays the CPL Center (C) audio channel. 
• Ch. 04 is LFE/Screen: Output Ch.04 plays the CPL LFE (screen) audio channel. 
• Ch.05 is Ls/Left Surround: Output Ch.05 plays the CPL Left Surround (Ls) audio 

channel. 
• Ch.06 is Rs/Right Surround: Output Ch.06 plays the CPL Right Surround (Rs) audio 

channel. 
• Ch.07 is Lc/Left Center: Output Ch.07 plays the CPL Left Center (Lc) audio channel. 
• Ch.08 is Rc/Right Center: Output Ch.08 plays the CPL Right Center (Rc) audio 

channel. 
• Ch.09 is Cs/Center Surround: Output Ch.09 will be playing the CPL Center Surround 

(Cs) audio channel. 
• Ch.10–Ch.14: These channels are pass-through, meaning the output channel X plays 

the CPL audio channel X. X will be a value between 10 and 14. 
• Ch.15 is H/Hearing Impaired: Output Ch.15  plays the CPL hearing impaired audio 

channel. 
• Ch.16 is VI-N/Narration: Output Ch.16  plays the CPL narration/visually impaired 

audio channel. 

 

Figure 12-8 Audio Mapping Set to Nine Channels     
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ISDCF 

This configuration is defined as follows: 

• Ch.01 is L/Left: Output Ch.01 plays the CPL Left (L) audio channel. 
• Ch.02 is R/Right: Output Ch.02 plays the CPL Right (R) audio channel. 
• Ch.03 is C/Center: Output Ch.03 plays the CPL Center (C) audio channel. 
• Ch. 04 is LFE/Screen: Output Ch.04 plays the CPL LFE (screen) audio channel. 
• Ch.05 is Ls/Left Surround: Output Ch.05 plays the CPL Left Surround (Ls) audio 

channel. 
• Ch.06 is Rs/Right Surround: Output Ch.06 plays the CPL Right Surround (Rs) audio 

channel. 
• Ch.07 is HI/hearing Impaired: Output Ch.07 plays the CPL hearing impaired audio 

channel. 
• Ch.08 is V-N/Narration: Output Ch.08 plays the CPL Narration (VI) audio channel.

  
• Ch.09 is Lc/Left Center: Output Ch.09 plays the CPL Left Center (Lc) audio channel. 
• Ch.10 is Rc/Right Center: Output Ch.10 plays the CPL Right Center (Rc) audio 

channel. 
• Ch.11 is Lrs/Left Rear Surround: Output Ch.11 plays the CPL Left Rear Surround (Lrs) 

audio channel. 
• Ch.12 is Rrs/Right Rear Surround: Output Ch.11 plays the CPL Right Rear Surround 

(Rrs) audio channel. 
• Ch.13: Ch.13 is set to D-BOX Primary. 
• Ch.14: Ch.14 is set to D-BOX Secondary. 
• Ch.15 is input: Ch.15 is mute, meaning there is no audio output on this channel. 
• Ch.16 is input: Ch.16 is mute, meaning there is no audio output on this channel. 

 

Figure 12-9 Audio Mapping Set to ISDCF  
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Pass-Through Configuration 

This configuration enables the CPL audio channel to pass through to the processor. 

 

Figure 12-10 Audio Mapping Set to Pass-Through     

Custom Mapping Configuration 

You can also customize the Channel Mapping settings: 

1. Click on the drop-down menu, and select Custom.  
The following window appears. 

 

Figure 12-11 Audio Mapping Set to Custom     

2. Click on the drop-down arrow to view the available mapping parameter selection for 
each output channel (Ch.01 through Ch.16) to select the CPL audio channel, using its 
label that is to be routed to the processor.  
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Figure 12-12 Channel Mapping Parameters     



 SMPTE Packages 
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12.3 SMPTE Packages 

To change the Template Mapping setting: 

1. Click on the list menu, and select the setting. 
 

 
Note: All the templates, except Disabled, can be modified directly instead of 

having to select Custom. Once the template is edited, the Template Mapping 
will read Custom. 

 

  

Figure 12-13 Template Mapping Drop-Down Window     

2. Click on the Save button to save the configuration. 
Superuser privileges are necessary to save changes. 

The list of possible labels that can be routed (if present in the audio .mxf file) are 
defined by SMPTE as follows: 
• L/Left 
• R/Right 
• C/Center 
• LFE Screen 
• Ls/Left surround 
• Rs/Right surround 
• Lc/Left center 
• Rc/Right center 
• Cs/Center surround 
• Rrs/Right rear surround 
• Lrs/Left rear surround 
• HI/Hearing Impaired  
• VI-N/Visual Impaired-Narration

Audio delay button 
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12.3.1 Audio Delay Configuration 

To configure the Audio Delay Settings: 

1. Select Administration > Control Panel > Audio Settings > Audio Delay. 
You can modify the delay between the audio and video by dragging the cursor to the 
value between –500 and +500 ms.  

2. Click on the Audio Delay tab on the right side of the Channel Mapping tab. All audio 
tracks will be modified for the same delay selected.  

3. Click on the Save button after the delay has been configured. 
The selected audio delay will be displayed as numeric milliseconds (ms) value. At a 
positive value, the audio will be heard behind the video action and a negative value: 
the audio will be heard ahead of the video action. The recommended value that 
matches almost all setups is 80 ms. 

 

 
Note: All the templates (except Disabled), can be modified directly instead of 

having to select Custom. Once the template is edited, the Template Mapping 
will read Custom. 

 

 

Figure 12-14 Audio Delay Window     

Save button 



 SMPTE Packages 
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12.3.2 Interop Packages 

Interop audio .mxf files do not contain any channel label information. As a result, when 
selecting a configuration, the system executes routing as if the audio .mxf file was created 
according to the ISDCF audio mapping recommendations, which currently include the 
information shown in the following figure.  

 

Figure 12-15 ISDCF: Interop Recommendations  
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12.3.3 Device Manager 

The Device Manager is an application that you use to configure the connection between 
an IMS2000 and cinema projectors, 3D systems, subtitles, closed captions, and so on. It 
also provides for the use of Ethernet commands to control theatre automation devices. 

To run the Device Manager, select Administration > Device Manager. The following 
window appears. 

  

Figure 12-16 Device Manager  

New button 



 SMPTE Packages 
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12.3.4 Adding a Projector 

To connect a projector to the IMS2000: 

1. Click on the New button. 
The New Device drop-down menu window appears.  

Any device in red indicates that the unit does not have a valid digital license 
message. 

 

Figure 12-17 Add Device Drop-Down Window  

2. Select Projector.  
The following window appears. The main configuration window updates to reflect 
the addition of the projector device, and you are able to enter the projector 
parameters. 

 

Figure 12-18 Device Selection Window: Projector Item Selected 
 

Projector selected 

Invalid digital 
license message 
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Figure 12-19 Device Manager GUI: Projector Fields Configuration 

To perform the projector configuration:  

3. Specify a projector identifier (for example, projector name, screen number) in the first 
field. 

 

 
Note: For projector types, select Primary. This could apply if you were to use 

dual projector for 3D. (Left projector would be primary, and right projector 
would be secondary.) 

 
4. Choose the correct Series 2 projector model to connect to the unit using the projector 

model fields.  
5. Select the model Series 2 for the projector from the drop-down menu on the right.  
6. Enter the IP address.  
7. The Test button allows you to test the IP connection prior to saving.  
8. Choose to either enable or disable the subtitles. 
9. Check the Enabled check box at the top-right corner of the GUI. 
10. Click the Save button to record the settings. 
11. A password confirmation page appears.  
12. Enter the password to save and record the settings.  

superuser privileges are necessary to confirm the changes. If you are already logged 
in with superuser privileges, the password confirmation window will not appear. 
Clicking the Revert button prior to saving will delete the unsaved information. 

For information on configuring a dual-projector setup, see Chapter 17. 

Delete device 
button 

Save button 

Test button 

Revert button 
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When a projector is added, a certainty device is also automatically added to allow you to 
connect directly to the media block, and to easily change between SDI, HDMI™, or 
internal inputs.  

 

Figure 12-20 Certainty Added 

Removing a Device or Projector 

You can also remove a device or projector. To remove a device or projector: 

1. Click on the device you want to remove in the left part of the Device Manager GUI. 
2. Click on the Delete Device button. 

12.3.5  Automation Libraries Management 

Support for theatre automation control is also provided. The list of currently supported 
devices is the following: 

• eCNA. 
• JNIOR. 
• A prebuilt library of supported automation commands is available for each of these 

two devices. These automation commands can then be added to macro cues. 

Device added  
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12.3.6  Adding an eCNA Device 

To add an eCNA device: 

1. Click on the New Device button in the Device Manager window. 
The New Device drop-down window appears. 

2. Select eCNA. 
The device manager GUI will be updated to reflect the addition of the eCNA device. 

3. Input the eCNA server IP address in the appropriate field. 
4. Verify the Enabled check box is selected in the top-right corner of the GUI. 
5. Click the Save button to save the settings. 

A window asking for the password appears.  

6. Enter the password to save the settings and proceed.  
Clicking the Revert button prior to saving will delete the unsaved information. 

 

Figure 12-21 eCNA Added 

Removing an eCNA Device 

To remove the eCNA device: 

1. Select the device in the Device Manager GUI. 
2. Click on the Delete Device button. 

IP address 

Enabled check box 



 SMPTE Packages 
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12.3.7  Adding a JNIOR Device 

To add the JNIOR device: 

1. Click on the New button in the Device Manager window. 
The New Device drop-down window appears.  

2. Select JNior. 
The Device Manager GUI updates to reflect the addition of the JNIOR device. 

3. Input the JNIOR server IP address in the appropriate field.  
The port number field will already contain the appropriate value (factory default 
value). 

 
Note: The JNIOR device documentation will provide the correct user name and 

password (factory default values). 
 

4. Click the Save button to save the settings.  
A window appears asking for a password.  

5. Enter the password to proceed.  
Clicking the Revert button prior to saving will delete the unsaved information. 

  

Figure 12-22 JNIOR Added 

Removing a JNIOR Device 

To remove the JNior device: 

1. Select the device in the Device Manager GUI. 
2. Click on the Delete Device button. 

IP address 



Using the Administration Tab  
 

 

 
102 Dolby® IMS2000 Installation and User’s Manual 
 IMS.OM.004730.DRM: Issue:1 

 

 

12.3.8  Adding a Raw Device 

A raw device allows for communication with an external device across an Ethernet 
connection using raw data formatted as text or binary strings. 

To add a raw device: 

1. Click on the New button.  
The New Device drop-down menu appears.  

2. Select Raw. 
The Device Manager GUI will be updated to reflect the addition of the raw device. 

3. Input the name of the raw device in the Identifier field. 

 

Figure 12-23 Device Manager GUI: Raw Device Added 

4. Specify a vendor name in the Vendor field. 
5. Specify a product name in the Product Name field. 
6. Enter the IP address of the raw device in the Device IP field. 
7. Choose the protocol to be used (TCP or UDP) and the proper port number. 
8. Click on the Save button to save the settings.  

A window appears asking for a password.  

9. Enter the password to proceed.  
Superuser privileges are necessary to confirm the changes. If you are already logged 
in with superuser privileges, the password confirmation window will not appear. 
Clicking the Revert button prior to saving will delete the unsaved information. 

 

Removing a Raw Device 

To remove the raw device: 

1. Select the device in the Device Manager GUI. 
2. Click on the Delete Device button. 

New button 
Delete button 



 SMPTE Packages 
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12.3.9   Adding 3D Systems 

You will have the option to add 3D systems. When using an IMS2000 configuration for 
3D presentation, the projector needs to be set to the proper color space. Contact the 
projector vendor to configure the projector properly. 

Dolby 3D Support 

To enable the Dolby® 3D support, please contact Dolby product specialists to receive the 
appropriate license (See Section 1.3). 

RealD 3D Support 

To enable the RealD 3D support, please contact RealD at mailto:cinema-support@reald.com 
to receive the appropriate license. 

To add Real 3D support: 

1. Open the Device Manager GUI; select Administration > Device Manager. 
2. Click on the New Device button. 
3. Select the RealD 3D EQ.  

The device will be visible on the main Device Manager GUI. 

4. Click on the Save button.  
Enter the appropriate password, and click Ok. Clicking the Revert button prior to 
saving will delete the unsaved information. 

 

Sensio 3D Support 

To enable the Sensio 3D support, please contact Dolby product specialists to receive the 
appropriate license (See Section 1.3) . 

12.3.10 Closed Caption Support 

To enable CaptiView and Rear Window devices closed caption support, install the 
appropriate license. For information about the closed caption Support, contact Dolby 
product specialists (see 1.3) or visit http://www.doremilabs.com/support/cinema-
support/cinema-manuals/captiview-manuals/.  

12.3.11 Configuring the Subtitle Engine 

This section provides instructions on how to set up the Device Manager for subtitle 
engine support. It will allow you to generate subtitles into the picture before being 
exported to the projector. To configure the subtitle engine: 

1. Open the Device Manager GUI; select Administration > Device Manager. 
2. Click on the New Device button. 

The New Device drop-down window appears. 

mailto:cinema-support@reald.com
http://www.doremilabs.com/support/cinema-support/cinema-manuals/captiview-manuals/
http://www.doremilabs.com/support/cinema-support/cinema-manuals/captiview-manuals/
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Note: If you already have a projector configured through Device Manager to 

display subtitles, meaning that the enable subtitle file was set to yes, 
adding the subtitle engine device causes a warning window to appear 
asking you to disable all projector subtitle display. The subtitle engine will 
generate the subtitle inside the picture before exporting the resulting 
pictures to the projector. If you plan to use the subtitle engine, click the Yes 
button in the warning window to disable all projector subtitles. 

 
3. Select the subtitle engine device. 
4. The device will be visible on the main Device Manager GUI. 

  

Figure 12-24 Subtitle Engine 

3. Click on the Save button. 
You will be asked for a password.  

4. Enter the appropriate password and click on the Ok button.  
Clicking on the Revert button prior to saving will delete the unsaved information. 
The closed caption check box, when checked, uses closed caption data (instead of 
subtitles) when subtitles are not detected.  

12.3.12 Missing License  

If a license is missing, it appears in red in the New Device drop-down menu.  

 

Figure 12-25 Missing License 

Missing license  

Closed-caption 
check box  

Subtitle engine  
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If you try to add a device with a missing license, a message will alert you to the missing 
license.  

 

Figure 12-26 Missing License Message 

12.4 Macro Editor 

12.4.1 Automation Cues 

An automation cue is a command that is sent from the IMS2000 to any external device 
connected to the IMS2000 for the purpose of being inserted into a show playlist. Upon 
installation of the IMS2000, automation cues can be predefined by the operator, 
transferred from an XML file, or added manually. Automation cues can be added to CPLs 
and show playlists using CineLister. 

12.5 Macro Automation Cues 

A macro automation cue consists of two parts, an automation cue and a Trigger Cue. 
Trigger cues are explained fully in Section 12.6 . A trigger cue is an action that is sent to 
the IMS2000, whereas an automation cue is sent from the IMS2000. Also, macro cues are 
a sequence of actions, whereas an automation cue is only one action. 

12.5.1 Creating Macros Using the Macro Editor 

You can create macros using the IMS2000 macro editor.  

To create macros using the macro editor: 

1. Select Administration > Macro Editor. 
2. The macro editor GUI appears.  

Missing license 
message  
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Figure 12-27 Macro Editor GUI 

3. Click on the New macro button to begin the process. 
4. You will be prompted to enter a name for the macro automation cue. 

 

Figure 12-28 New Macro Settings 

5. Click on the Ok button when done, and the macro editor GUI will reappear. 
6. The new macro appears in the macro editor window. 

 

Figure 12-29 New Macro Added 

7. Click on the Save button when done creating the macro automation cue. 
superuser privileges are necessary to save the changes. If you are logged in as a 
superuser, the confirmation window will not appear. 

New macro button 

Settings button 

Save button 

Delete button 

Macro added  
Up and down arrows 

Revert button 



 Macro Automation Cues 
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12.5.2 Editing a Macro Automation Cue 

To edit the name of an existing macro automation cue: 

1. Click on the macro. 
2. Click on the Settings button, or double-click on the macro itself. 
3. Edit the name of the macro. 
4. You can use the up and down arrows to rearrange the automation cues. 
5. Click the Save button when finished. 

Selecting the Revert button will close a document without saving the changes.  

Use this with caution.  

6. To delete a Macro Automation Cue, select the automation cue in the Macro Editor 
window and click on the Delete Macro button. 

12.5.3 Inserting Actions into Macro Cues 

To insert actions into a macro cue: 

1. Select the Macro Editor window, select Administration > Macro Editor. 
2. Highlight the macro to be modified.  
3. Click on the drop-down arrow next to the Select an Action to Insert field. 

 

Figure 12-30 Automation Cue Window 

4. Click on the action. 
5. Click on the Insert button. 

Insert button 
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The actions available include the following: 

• Projector: 
o Dowser: Open or close the selected projector dowser. 
o Lamp: Power on or off the selected projector lamp. 
o Projector Channel Switch: Switch the selected projector channel. 
o Macro: Execute the macro defined in the selected projector. 

• Input/Output: 
o General Purpose Output: Configure a GPO line. 
o Send Message: Send a message to the connected device. 

• Playback: 
o Audio Volume: Control the audio volume output. 
o Audio Mute: Mute the audio  
o Playback Actions: Change the playback state. 
o Video Output Actions: Change the default video output format. 
o Sensio3D: Enable or disable the Sensio3D output format. 
o RealD SBS: Enable or disable the RealD SBS output format. 

• Macro Control: 
o Delay: Insert a delay between actions. 
o Purge Pending Macro: Purge the current macro execution stack. 

• Library: 
o Offers control using Certainty, eCNA, JNior, JNior Expansion Module, and 

more.  
• System: 

o Binary Execution: Execute a binary command 
o System Shutdown: Allows you to shut down the player. 

6. Click on the Save button to save the settings, or click on the Cancel to stop adding an 
action. 
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12.5.4 Adding a GPO Action to the Macro Automation Cue 

To add a GPO action to the macro automation cue: 

1. Highlight the macro cue. 
2. Select the GPO option, which is located in the input/output section in the Select an 

Action to Insert drop-down menu. 
3. Click on the Insert button. 

The following window appears. 

 

Figure 12-31 GPO Setup Window 

4. Set the line number and value according to the usage, and click on the Ok button. 

12.5.5 Adding a Playback Action  

To add a playback action: 

1. Highlight the macro cue. 
2. Select the Playback Actions option, which is located in the playback section in the 

Select an action to insert drop-down menu. 
3. Click on the Insert button. 

The following window appears. 

 

Figure 12-32 Playback Actions Setup Window 

4. Select the proper playback action between Play, Pause, Toggle Play/Pause, Recue 
Show, Rewind, Skip to Next Clip, Skip to ShowPlaylist Segment, or Exit from 
Intermission, and click on the Ok button. 
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12.5.6 Adding a Video Output Action  

To add a video output action: 

1. Highlight the macro cue. 
2. Select the Video Output Actions option, which is located in the playback section in the 

Select an Action to Insert drop-down menu. 
3. Click on the Insert button. 

The following window appears. 

 

Figure 12-33 Video Output Setup Window 

12.5.7 Adding a Dowser Action  

To add a dowser action: 

1. Highlight the macro cue. 
2. Select the Dowser Action option, which is located in the projector section in the Select 

an Action to Insert drop-down menu. 
3. Click on the Insert button. 

The following window appears. 

 

Figure 12-34 Add a New Action Window (Dowser) 
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12.5.8 Projector Channel Switch Insertion 

To add a projector channel switch action: 

1. Highlight the macro cue. 
2. Select the Projector Channel Switch Action option, which is located in the projector 

section in the Select an Action to Insert drop-down menu. 
3. Click on the Insert button. 
4. The following window appears. 

 

 

Figure 12-35 Add a New Action Window: Channel Settings 

5. Choose the name of the projector from the drop-down menu window that appears. 
6. Use the plus/minus buttons to select the channel to send the command to. 
7. Click on the Ok button.  

12.5.9   Automation Library Usage 

Using Automation Library 

Support for theatre automation control is provided. The currently supported devices are: 
• eCNA 
• JNior Expansion Module  
• JNior 

When one of the supported devices (for example, eCNA and JNior) is added, the macro 
editor will allow you to use the corresponding commands for each device:  

1. To use a library command, click on Library in the Select an Action to Insert menu and 
click on the Insert button. 
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The following pop-up window appears. 

 

Figure 12-36 Add a New Action Window: Library Window 

2. Select the driver and action. Click Ok or, click Cancel to cancel this command.  

12.5.10 Copying from an Existing Macro 

You can also copy an existing macro using the Copy from drop-down menu. Name the 
new macro, and select a macro to copy. The macro, with the accompanying action, 
appears in the Macro Editor window.  

 

Figure 12-37 Copy Macro 
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Resulting Macro Setting 

The right part of the Automation Cue tab will display the added actions, as shown in the 
following figure.  

 

Figure 12-38 Action Added  

1. Click the Save button to save the settings. 
2. Enter the password to save settings and proceed. 

12.5.11 Action List Management 

Action Reordering 

The two arrows allow you to change the order of the actions in the macro automation 
cue. Using the arrows allows you to place move each action to the top or to the bottom of 
the Macro Actions window. 

To move an action in the list: 

1. Select it, and click on the arrow pointing to the top or bottom. 
2. Repeat the steps until the required actions order is obtained. 
3. Click on the Save button to save the settings. 

Up and down 
arrows 

Macro delete  

Save  

Trigger cue  

Action delete  

Properties  
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Editing Actions 

You can edit an action of any given macro automation cue by highlighting it in the Macro 
Actions window.  

To edit the action: 

1. Click on the Properties icon that appears on the right. 
2. Edit the properties, and set the action when added to the macro automation cue. 
3. Click on the Save button to save the settings. 

Action and Macro Removal 

You can remove an action or macro highlighting it in the Macro Actions window. 

To remove an action from the list of actions associated with a macro automation cue: 

1. Select the action in the Macro Actions window. 
2. Click the X that appears on the right. 

To delete a macro: 

3. Select the macro on the left side of the GUI. 
4. Click on the Delete button. 

12.5.12 Macro Saving 

You can save a macro by highlighting it in the Macro Actions window. 

1. Repeat the macro creation operations for all the macro automation cues, and click the 
Save button. 

2. You will be asked to enter a password to perform the operation. 
3. Enter the appropriate password, and click on the Ok button.  

superuser privileges are necessary in order to be able to save changes. If you are 
already logged in as a superuser, the Password window will not appear. Selecting the 
Revert button will close a document without saving the changes.  

4. The macro automation cues will be available in CineLister to create a show playlist. 
 

 
Note: The saving operation will not only save the macro automation cues, but 

also the trigger cues that were created. 

 
 

 



 Trigger Cue Tab 
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12.5.13 Add a Macro to a Show Playlist 

For information on how to add a macro to a show playlist, please See Section 13.2.2. 

12.6 Trigger Cue Tab 

A trigger cue allows for the execution of a macro automation cues upon the occurrence of 
an event from an external device using a signal or GPI. When you select an event to occur 
from the external device, the occurrence of that event triggers a macro automation cues. 
The macro automation cues will then be executed. Both the event and the macro 
automation cues are defined during the trigger cue creation. 

You can access the Trigger tab by either selecting it on the left-hand side of the GUI under 
the Macro Editor tab (Administration > Macro Editor) or by clicking on the Trigger Cue 
arrow in the Macro Automation tab and Quick Controls tab.  

 

 
Note: The signal comes from an external device connected over the Ethernet. The 

external device options are: eCNA, JNior, and Raw. 

If a trigger cue is based on the event, (Wait for GPI #1 ON), it is possible to link a specific 
macro automation cue as presented in order to be executed when GPI 1 is on. 

12.6.1 Trigger Cue Tab Overview 
 

 

 

Figure 12-39 Macro Editor: Trigger Cue Tab 

New trigger 
button 
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12.6.2 Trigger Cue 

The Trigger Cue tab is located in the trigger cue options window (Administration > Macro 
Editor > Trigger Cue).  

Alternatively, you can click on the green arrow button on the right side of the Automation 
Cue tab to access the Trigger Cue tab.  

To perform the operation: 

1. Click the New Trigger button.  
A window appears allowing you to enter the trigger cue name. 

 

Figure 12-40 Trigger Cue Setting Window 

2. Enter the appropriate name. 
It will be the name used by the CineLister application to insert the trigger cue in a 
Show Playlist. The newly created trigger cue appears in the Trigger window, and it 
will be ready to connect to an event. 

 

 

Figure 12-41 Trigger Cue Defined 
 

Settings button 

Delete trigger button 
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To edit the name of an existing trigger cue: 

1. Select the trigger cue. 
2. Click on the Settings button. 

To remove a trigger cue: 

1. Select the trigger cue. 
2. Click on the Delete Trigger button. 

12.6.3  Connection to a General Purpose Input Event 

You will be able to connect to a general purpose input event. 

To connect a trigger cue to an event: 

1. Select the trigger cue. 
2. Click the Connect to An Event drop-down menu. 

  

Figure 12-42 Trigger Cue Window 

3. Click on the General Purpose Input option.  
4. Click on the Add button. 

The following window appears. 

 

Figure 12-43 General Purpose Input Setup Window 
 

5. Define the GPI line number and value to connect to the trigger cue. 
6. Click on the Ok button. 

The connected GPI event will then appear in the right part of the GUI. 

Add button 
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Figure 12-44 GPI Event Added 

12.6.4 Connection to a Signal Event 

You can connect the trigger cue to a signal event. 

To perform this operation: 

1. Click on the trigger cue that you want to assign the signal event to. 
2. Click on the Connect to an Event button from macro editor Trigger Cue tab.  

The Connect to an Event drop-down window appears. 

3. Click on the Signal button, and click on the Add button.  
The Signal Setup window appears. 

 

Figure 12-45 Signal Event Setup Window 

4. Choose the device from the drop-down menu. 
5. Choose the driver from the drop-down menu. 
6. Choose the signal from the drop-down menu. 

The signal name will autopopulate. 

7. Click on the Ok button when finished. 

Event added 



 Trigger Cue Tab 
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The connected signal event appears in the right part of the Editor tab. 

 

Figure 12-46 Signal Added 

12.6.5 Editing and Deleting the Event 

You will be able to edit and/or delete a created event. 

To edit the event: 

1. Highlight the event in the Trigger Cue Actions window.  
2. Click on the Properties icon that appears. 
3. Edit the information. 
4. Click on the Save button to save the settings. 

To delete the event: 

1. Highlight the event in the Trigger Cue Actions window.  
2. Click on the X that appears to delete the event. 
3. Click on the Save button to save the settings. 

Save  

Signal added 

Properties  

Revert button 

Delete event  

Quick controls  

Save button 
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12.6.6 Copying From an Existing Trigger Cue 

You will have the ability to copy an existing trigger cue using the Copy From drop-down 
menu.  

To perform the operation: 

1. Select the Copy From drop-down menu. 
2. Name the new trigger cue and select a trigger to copy from. The macro, with the 

accompanying event, appears in the Trigger Cue window.  

 

Figure 12-47 Trigger Settings Window 

12.6.7 Predefined Macro Usage 

If you have a predefined macros.xml file containing automation and trigger cue 
definitions, then copy it into the /doremi/etc/ folder, and the corresponding macros will be 
visible in the macro editor GUI. You will then be able to update the cues, if needed, from 
the macro editor GUI. 

12.6.8 Default Cues 

The default_cues.xml file can be used to load an automation and trigger cue playlist prior 
to any playback. This is to avoid having to add a fire alarm trigger cue to each show. If 
you are provided with a default_cues.xml file, copy it into the /doremi/etc/ folder. 

12.6.9 Startup Scripts 

Copy the script to be executed automatically at boot in the /doremi/etc/rc.d/ folder. 

 

12.6.10 Add a Trigger Cue to a Show Playlist 

For information on how to add a macro to a show playlist, please see Chapter 14. 



 Quick Controls 
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12.7 Quick Controls 

The quick controls feature provides you with the ability to use macros without having to 
browse through various menu items. You will be able to execute any command with the 
click of a mouse. You can add multiple sections to make executing macros simple and 
efficient.  

To access the Quick Controls tab, select Administration > Macro Editor > Quick Controls. 
Alternatively, if you are in the Macro Automation tab or Trigger Cue tab, you can access 
the Quick Controls tab by clicking on the Quick Controls arrow on the right side of the 
GUI. 

12.7.1 Creating Macros  

To create macros, refer to Chapter 12. 

12.7.2 Setting Up Quick Controls  

All of the macros created in the Macro Automation tab will automatically appear in the list 
of available macros on the left side of the GUI in the Quick Controls tab. 

To assign a macro to a quick controls section: 

1. Click on the New section button.  
This will create a tab to the right of the macro list, and you will be able to define the 
section according to the function of the created macro. 

 

Figure 12-48 Quick Controls Window 

2. Drag the selected macro to the New section tab. 
3. Click on the Save button to save the settings.  

If the selection has not been saved it will not appear on the Quick Controls screen. 
Clicking the Revert button before saving will cause all of the changes to be lost.  

4. Hover over the section. 
5. Several options appears on the right. 

New section 
button 

New section 
added 
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6. To move the section, if there are multiple sections, click on the cross arrows. 
7. Rename the section by clicking on the New Section tab. 
8. Click on the Save button to save the changes. 

 

 

Figure 12-49 Configuring Quick Controls 

To delete the section: 

1. Click on the section or hover the cursor over the section.  
Several options appears on the right.  

2. Click on the X to the right of the section. 
3. To delete a macro within the section, click on the X to the right of the macro. 

 

Figure 12-50 Edit Section 

Macros added 
section  

Save  

New section tab 
renamed 

Revert  

Search  

Change name 
button 

Cross arrows 
button 

Delete macro 
button 

Delete section 
button 
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12.7.3 Executing the Quick Controls  

When all of the sections have been set and saved, click on the Quick Controls button on 
the bottom-left corner in the Notification Bar and the recently added macros appear in the 
Quick Controls window.  

1. Click on the previously created macro to execute it from any tab on the GUI. 
2. Clicking on the Quick Controls button in the Notifications Bar again will close the 

window. 

 

Figure 12-51 Quick Controls Window 

12.8 Content Feed Manager 

The main purpose of the Content Feed Manager application is to add an FTP ingest 
source. In addition, multiple units can be interconnected to share content simultaneously. 
The Content Feed Manager makes the ingestion process quicker and simpler.  

12.8.1 Quick Configuration 

To open the Content Feed Manager application, select Administration > Content Feed 
Manager. 

 

Figure 12-52 Content Feed Manager: Advanced Options 

Quick controls 
button 

Macros available 

Advanced options  
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Advanced Options 

The advance options section allows you to configure different features available on the 
IMS2000: 

1. Click on the Advanced Options button. 

A drop-down menu where you can configure the following file types to be used for 
ingesting appears: 
• Authorize "play while ingest" from this server (not supported). 
• Key Delivery Message: Allows the KDM to be ingested from the FTP or another 

server registered in the net map. 
• Composition Playlist (enabled by default): Allows import or FTP of a CPL into the 

server. 
• Installation Package software, security manager, firmware packages for upgrades. 
• Digital License: Digital license messages (for example, Dolby 3D, RealD, 4K 

enabled, and so on). 
• Show Playlist: Click this box to be able to export and then import a show playlist 

from one server to another. 
2. Click on the Save button to save the configuration.  

The server is now added to the Content Feed Manager network. 



 Content Feed Manager 
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12.8.2  Adding a Server Manually 

Networking the Servers 

The Content Feed Manager GUI can be manually set up. 

To perform the operation: 

1. Click on the New button.  
This allows you to add a new server for which the fields will have to be manually 
entered. 

 

 

Figure 12-53 Content Feed Manager 

2. Enter the identifier name in the Identifier field.  
We recommend that a unique identifier be used (for example, screen 1, screen 2, and 
so on). 

3. Ingest Protocol is set to FTP.  
4. Enter the IP address for the server. 

Optional: Click the Test button to test the IP connection. A pop-up window appears 
that will test the connection. Click the Close button to exit this window. 

5. Enter the remote path for the destination of the server. 
You must manually enter the remote path. 

6. Click the Save button to save your changes.  
Clicking the Revert button before saving will cause you to lose all of the changes.  

New button  

Delete button  

Save button  

Revert button  

Test button  

Advanced options  
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Advanced Options 

The advance options section allows you to configure different features available on the 
IMS2000. 

1. Click on the Advanced Options button. 
A drop-down menu where you can configure the following file types to be used for 
ingesting appears: 
• Authorize "play while ingest" from this server (not supported). 
• Key Delivery Message: Allows the KDM to be ingested from the FTP or another 

server registered in the netmap. 
• Composition Playlist (enabled by default): Allows import or FTP of a CPL into the 

server. 
• Installation Package software, security manager, firmware packages for upgrades. 
• Digital License: Digital license messages (for example Dolby 3D, RealD, 4K 

enabled, and so on). 
• Show Playlist: Click this box to be able to export and then import a show playlist 

from one server to another. 
2. Click on the Save button to save the configuration.  

The server is now added to the Content Feed Manager network.  

12.8.3 Deleting a Server 

You are able to delete a server that was previously added to the Content Feed Manager. 

To perform this operation: 

1. Click on the server. 
2. Click on the Delete Repository button.  

This will also remove it from the ingest manager drop-down list of servers to ingest 
from. 



 Content Feed Manager 
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12.8.4  Ingesting from a Server  

You will have the option of the ingesting from a server that was added manually. 

In order to ingest material (restrictions are based on the advanced options settings) on 
the destination unit, you will need to open the Ingest Manager application (Control > 
Ingest Manager).  

1. Select the unit that was previously added in the Content Feed Manager application as a 
source/feed. 

 

Figure 12-54 Ingesting Scan Window 

2. The Ingest Manager application scan tab window will display the content available for 
ingest from the selected source/feed unit. 

3. Select the material to ingest. 
4. Click on the Ingest button to ingest the content. 

New server 
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12.9 Terminal 

The terminal is used mainly for administrative purposes: 

1. To log into the Terminal tab, select Administration > Terminal. 
2. Enter the administrator user login name and password. 

If possible, all changes made to settings should be performed through the Terminal 
GUI. 

 

Figure 12-55 Terminal Login 

12.10   System 

The System tab (Administration > System) allows you to restart, shut down, and place the 
unit in standby mode:  

• To restart the IMS2000, click on the Restart button. You will be disconnected from the 
web interface in five seconds. You have the option to cancel the action. 

• To shut down the system, click on the Shutdown button.  
• To place the unit in standby, click on the Standby button.  

You will be asked to confirm the operation. 

Terminal  



 System 
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Figure 12-56 System GUI 

If content is currently being played, a window appears asking you to confirm the restart 
or shutdown request. 

You can also quickly log out, restart, shut down, or cancel from any tab on the GUI by 
using the quick access buttons:  

• Clicking the Logout button will automatically log you out. 
• Clicking on the red Power button provides you with the options to restart, shut 

down, or cancel. 

 

Figure 12-57 Quick Access Power Options 

Standby button 

Shutdown button 

Logout button 
Power button 

Restart button 
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12.11  Log Operator Maintenance 

The log operator maintenance application lets the operator log important information 
(for example, hard disk replacement, projector lamp replacement, and so on). It will help 
the system administrator keep track of any change operated in a theatre booth. The log 
records created with the log operator maintenance application are stored for one year. 

The log operator maintenance application is available in Administration > Control Panel > 
Log Operator Maintenance.  

The tab will default to the Event Log tab. 

12.11.1 Event Log Tab 

 

Figure 12-58 Event Log Tab 

To create an event log: 

1. Click on the New button. 
You will need to authenticate yourself as an administrator by inputting the correct 
password to be allowed to use this application. 

Scheduled tab 

New button 
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The following window appears. 

 

Figure 12-59 Record Maintenance Window 

2. The author of the log will be shown as admin. 
3. Add a comment in the Comment field.  

No restrictions apply for the Comment field, but we recommend that the 
operator/technician insert comments about the job performed as accurately as 
possible. This will be used for future references about maintenance. The log will be 
recorded based on the date and time when the log was entered into the log operator 
maintenance application. 

4. Click on the Record button or the Cancel button to cancel the operation.  
The logs that were added can be viewed in the Event Log tab. 

5. Click on the concerned log to view its properties/details. 

 

Figure 12-60 Log Added 

Cancel button 

Record button 

Scheduled 
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12.11.2 Scheduled Tasks Tab 

The Scheduled Tasks tab lists the different maintenance operations that exist for the 
IMS2000. 

It lists, per maintenance operation, the last time the operation was performed and the 
next time the operation will have to be performed. For the IMS2000, the only type of 
maintenance operation is annual maintenance activities. The tab is not modifiable. 

To access the Scheduled Tasks tab, click on the green arrow on the right-hand side of the 
GUI while in the Log Operator Maintenance tab.  

 

 

Figure 12-61 Scheduled Task Window 

Scheduled tasks 
window 
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12.12  Account Manager GUI 

The Account Manager GUI allows you to edit, add, and delete user accounts. To access 
the Account Manager GUI, select Administration > Control Panel > Account Manager. 

The following window appears. 

 

Figure 12-62 Account Manager GUI 

12.12.1 Add a New User Account 

In the Account Manager GUI, you will be able to add a new user account. 

To perform the operation: 

1. Click on the New button. 
2. The following window appears. 

 

Figure 12-63 Account Manager GUI: New User Addition 

New button  
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3. Enter the user name (to be used for login) in the upper empty field and the associated 
full name used to describe you. Both names display in the window after the new user 
addition is completed. 

4. Select the proper privileges.  
5. They are listed here from the lowest level to the highest level of privileges: 

• Inactive: This user does not have any privileges. 
• Ingest: This user is allowed to ingest content. 
• Projectionist: Projectionist is a standard user allowed to use the Dolby 

applications present on the unit without changing the configuration. 
• Show Manager: In addition to projectionist's privileges, a Show Manager user is 

allowed to ingest and delete content, and to save show playlists. 
• SuperUser: In addition to Show Manager user privileges, a superuser has the 

privileges to configure the unit and to create, modify, and delete user accounts. 
For example, the superuser can update the firmware and software.  

 

Figure 12-64 Account Manager GUI: Privileges Definition 

Two different login types are available to you: 

• Virtual: Virtual user account only works with Dolby applications. 
• System: Regular Linux® user account that can be used anywhere on the system 

(for example, on Linux terminal windows).   
6. Define the password by typing the password.  

 

 
Note: You will be provided information about the strength of the chosen 

password. Confirm the password in the Confirm field. 

 

Save button  
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7. Click on the Save button to save the new user. 

The new user account will be visible in the main Account Manager GUI. 

 

Figure 12-65 Account Manager GUI: New User Added 

12.12.2 Edit an Existing User Account 

In the Account Manager GUI, you will be able to edit an existing user account. 

To edit an existing user account: 

1. Select the account.   
The following dialog box appears, allowing you to edit your properties but not the 
user name or the login type. 

 

Figure 12-66 Account Manager GUI: User Properties Editing 

2. Click on the Save button when finished editing the settings. 
3. Click on the Close button when finished with the configuration. 

New user 
account  
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12.12.3 Deleting an Existing User Account 

In the Account Manager GUI, you will be able to delete an existing user account. 

To delete an existing user account: 

1. Hover over the account in Account Manager GUI. 
2. Click on the X that appears on the right side of the screen. 

You will be asked for a confirmation.  

3. Click on the OK button to delete the user account. 

 

Figure 12-67 User Account Deletion Confirmation 
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12.13   Theatre Properties 

The Theater Properties tab allows you to specify theatre properties, such as the facility 
name, address, auditorium specifics, and contact information. You may add one facility 
per IMS2000.   

To access the Theater Properties tab, select Administration > Control Panel Theater 
Properties.  

This information is necessary as it contains information needed for the generation of the 
.flm file. The information is used by studios in KDM management.  

12.13.1 Auditorium Tab   

The Theater Properties tab defaults to the Auditorium tab. Here you can input the 
auditorium specifics (such as screen aspect ratio and screen color).  

To complete the operation, click on the Save button to save the changes. 

Clicking the Revert button without saving will cause all of the changes to be lost. 

 

Figure 12-68 Auditorium Tab 

Contacts tab  

Save button  

Revert button  
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12.13.2 Contacts Tab 

The Theater Properties tab defaults to the Auditorium tab. Here you can access the 
contacts tab.  

To access the Contacts tab: 

1. Click on the arrow at the right side of the Theater Properties tab.  
2. Input the information of the appropriate contact for the facility. 

 

Figure 12-69 Contacts Tab 

3. Click on the New button. 
The Add Contact window appears. 

4. Input the appropriate information. 
5. Click on the Save button, or click the Cancel button to cancel the operation. 

The contact appears in the Contacts tab.  

To delete a contact: 

1. Hover over the contact. 
2. Click on the X that appears on the right. 
3. The contact is now deleted. 

  

Figure 12-70 Add Contact Window 

New button 

Save button 

Facility tab 
Delete button 
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12.13.3 Facility Tab 

You can access the Facility tab from the Theater Properties tab.  

To access the Facility tab: 

1. Click on the arrow at the right side of the Theater Properties tab. 
2. Input the facility name and address if required. 
3. Click on the Save button to save the changes. 

Clicking on the Revert button without saving will cause all of the changes to be lost. 

 

Figure 12-71 Facilities Tab 

Revert button 

Save button 
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12.14 Quick Access Links 

The Quick Access Links application allows you to create links on the left-side of the GUI, 
to be quickly accessed by you from anywhere on the GUI. The links are available on 
every tab of the GUI. 

To access the Quick Access Links application, select Administration > Control Panel > Quick 
Access Links or click on the Quick Access Links tab on the left side of the GUI. 

A maximum of 12 links can be created.  

 

Figure 12-72 Quick Access Links 

To create a new access link: 

1. Select the tab from the drop-down list. 
2. Click on the Add button. 
3. Click on the Save button to save the quick access link. 

 

Figure 12-73 Quick Access Drop-Down Menu 

Drop-down menu 

Add button 

Quick access 
links tab 
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The selected link appears in the window.  

 

Figure 12-74 Link Added 

To edit the link: 

1. Select the link. 
2. Click the rectangle to rename the link. 

To revert to the default name, click the curving arrow. 

3. Click the X to delete the link. 
For information on the action performed by the link, click the information button.  

 

Figure 12-75 Editing the Link 

4. Click on the Save button.  
Clicking on the Revert button will delete all unsaved changes. After saving and 
refreshing, the newly added link appears on the left-hand side of the GUI in all tabs. 
Clicking on the link will automatically take you to the designated tab.    

Info button 

Rename button 

Delete button 

Revert 
button 

Save button 

Revert button 
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Figure 12-76 Link Added 

12.15 CineLister Configuration  

The CineLister configuration application allows you to configure certain components of 
the CineLister application. CineLister is discussed in detail in Chapter 12. 

To access the CineLister configuration application, select Administration > Control Panel > 
Cinelister Configuration. 

12.15.1 Editor Configuration  

 

Figure 12-77 CineLister Configuration Editor 

To modify the amount of time that the fast-forward and rewind buttons will jump to in 
playback:  

1. Type the amount of seconds in the space provided.  
2. Click on the Save button to save the settings. 

To modify the amount of time that playback will rewind to in the case of an emergency 
recovery: 

1. Type the amount of seconds in the space provided. 

Added link 

Emergency 
recovery value 

Fast-forward and 
rewind value 
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2. Click on the Save button to save the settings. 

12.15.2 Scheduler Configuration  

To modify the first day of the week in the Cinelister Schedule tab: 

1. Select the day from the drop-down menu.  
2. Click on the Save button to save the changes. 

Clicking on the Revert button will delete all unsaved changes. 

 

Figure 12-78 CineLister Configuration Schedule 

Drop-down menu 

Save button 

Revert button 
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12.16  Live Manager 
 

The Live Manager application allows you to add a virtual device as a source of a live 
event. These live CPLs can be added to the show playlists in CineLister. 

To access the Live Manager GUI, select Administration > Control Panel > Live Manager. 

 

Figure 12-79 Live Manager 



 Live Manager 
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12.16.1   Creating a Live Event 

To create a live CPL: 

1. Select the live source device type from the drop-down menu. 

  

Figure 12-80 Live Source Device Type 

2. Enter the live CPL content title in the Content Title field. 
3. Enter the IP address of the external live event in the Device IP field. 

 

Figure 12-81 CPL Title and IP 

4. Click on the Create button to complete the live CPL creation. 
5. The live CPL is now visible in the Live Manager main window. 

Live source type 

Device IP 

Content title 
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Figure 12-82 CPL Created 

 

 
Note: The MPEG streamer format is dynamically handled. This means that the 

4:2:2 vs 4:2:0 parameter is automatically detected from the MPEG stream 
itself. There is no need to provide this information to the playback engine. 

 
6. Repeat the steps 1–5 as many times as necessary to generate another live CPL. 

To view the properties of the CPL: 

1. Highlight the CPL. 
2. Click on the Properties button on the right-hand side.  

This information is the same information provided in the Content Manager 
Composition Playlist tab. See Section 13.10.2 for more detailed information.  

 

Figure 12-83 CPL Properties 

Live CPL 



 Live Manager 
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12.16.2 Live Event in CineLister 

To use the live CPL, allowing a live event, open CineLister. 

The newly created live CPL will be visible under Live in the left part of the Editor tab, 
allowing you to insert it in a show playlist like any standard CPL. 

For more information on show playlist building, see Chapter 12.  

 

Figure 12-84 Live CPL Inserted in a Show Playlist 

Live CPL 
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12.16.3   Deleting a Live CPL 

In the Composition Playlist window, you will be able to delete an existing live CPL. 

To perform this operation: 

1. Select the CPL from the Composition Playlist tab. 
2. Click on the Delete button. 

  

Figure 12-85 Deleting a Live Event 

3. The live CPL will be deleted from the Live Manager as well. 

Live CPL 



 Backup Manager 
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12.17 Backup Manager 

The Backup Manager allows you to backup, delete, and restore files saved on a unit. This 
application allows you to back up and restore the following files on a server: 

• Doremi: These files include configuration files, devices, SNMP threshold, audio, 
macros, and databases. 

• Identity: These files include Dolby Security Module identity certificates. 
• KDMs: These files include KDMs and digital license messages. 
• Network: Includes IP addresses, DNS configurations, and so on. 
• System: These files include system user accounts, group configurations, and time-

zone information. 
 

12.17.1 Automatic Backup of System 

The backup manager application generates an automatic backup file to the local drive 
(for example, RAID) daily. The most recent backup is restored. It will also allow you to 
back up and restore the configuration files to and from an external drive (for example, 
eSATA or USB). 

 

 
Note: You do not have control over the time at which the automatic backup is 

generated. The backup will generate at 10:08 GMT or at the next boot up. 
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Viewing the Backup File Records 

To view the backup file records: 

1. Open the backup manager application. 
The Restore Backup tab appears, showing the latest backups available.  

 

Figure 12-86 Backup Manager Window 

2. Click on the backup file to display details about the backup. 
To search for specific file locations, use the Location search field. 

 

Figure 12-87 Location Search Field 
 

Restore backup tab 

Last backup 
performed 

Backup information 

Location search field 
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12.17.2 Restoring the System to a Previous Backup 

This section applies to units that have had any storage component changed. Every time a 
storage component has changed, you will receive a message asking to restore the 
configuration files:  

• Yes: You can choose to restore now by clicking on the Yes button. This will restore 
the configuration files on the RAID to the new USB flash drive. 

• No: You can choose not to restore now by clicking on the No button. This will 
generate a backup file based on the current configuration on the flash drive and place 
it on the RAID. 

 

 
Note: If you select No by mistake, you can manually restore the latest 

configuration from the second most recent record. 

 
• Ignore: You can choose to ignore the message for now by clicking on the Ignore 

button. This performs no restore or backup processes. 

12.17.3 Restoring the Configuration Files 

 

Figure 12-88 Restore Confirmation 

To restore the configuration files now: 

1. Click on the Yes button. 
A confirmation window appears, asking to proceed with the restoration process. 

2. Click on the Yes button. 
A login window appears.  

3. Enter the appropriate password.  
4. Click on the Ok button. 

The restore process will now begin. 
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Note: You may cancel at any time by clicking on the Cancel button. 

 

Figure 12-89 Restore Process Window 

5. Click on the Close button to exit out of the restore window.  
6. To view the backup, select the Restore Backup tab. 
7. The restore process is now complete. 



 Backup Manager 
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12.17.4 Manual Backup and Restore 

You have the option to manually back up and restore the configuration files. 
 

 
Note: This section assumes you want to manually back up or restore the 

configuration files at any time. You can back up or restore the 
configuration files to a local drive (RAID) or to an external drive (for 
example, eSATA or USB). 

You cannot back up or restore while unit is in playback. 

Manual Backup to RAID 

To perform the operation: 

1. Click on the Generate Backup tab. 

 

Figure 12-90 Backup Manager Window 

2. Click on the Generate button. 
3. Select the location where you want to save the backup file. 

You can save either to local disk (RAID) or to an external drive. 

4. Click on the Ok button. 
The backup process will now begin.  

  

Figure 12-91  Select Disk Window 

The Backup Generation window appears.  
 

 

Generate 
backup 

Generate 
button 

Location drop-
down menu 
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Figure 12-92 Backup Generation Window 

5. Click on the Close button to exit out of the Backup Generation window.  
To view the backup, select the Restore Backup tab. 

6. The manual backup process is now complete. 

Manual Backup to External Drive 

You can back up the configuration files manually, to an external drive (for example, 
eSATA or USB). 

To perform the operation: 

1. Insert an external storage device into the unit.  
For this example, a USB flash drive will be used. 

2. Click on Generate Backup tab.  
3. Click on the Generate button. 
4. Select the USB from the drop-down menu. 
5. Click on the Ok button.  

The backup process will now begin. 

 

Figure 12-93 Select Location of Backup File (USB) 

6. The Backup Generation window appears.  
This will indicate that the backup process was a success. 



 Backup Manager 
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Figure 12-94 Backup Generation Window 

7. Click on the Close button to exit out of the Backup Generation window.  
To view the backup, select the Restore Backup tab. 

 

  

Figure 12-95 USB Restore 

 

 
Note: The USB backup will appear only if the USB or external device is plugged 

in. 

 
8. The manual backup process is now complete. 

USB backup 
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12.17.5 Deleting Backup Files 

You will have the option of deleting a backup file from the Backup Manager window. 

If you want to delete a backup file that was previously generated: 

1. Select the file from the Restore Backup tab. 
2. Click on the Delete button. 

You can only delete manually generated backups, not automatic backups.  

 

Figure 12-96 Delete Button 

3. Click on the Ok button to continue the deletion process. 
The backup file is now deleted. 

 

Figure 12-97 Confirmation Window 

Delete 
button 
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12.17.6 Restoring Backup Files 

Restoring from RAID 

You can restore from the RAID in the Backup Manager window. 

To perform the operation: 

1. Select the backup file from the left-hand side. 
2. Click on the Restore button. 

A login screen appears. 

 

Figure 12-98 Restore Button 

3. Enter the appropriate password. 
4. Click on the OK button. 

The Restore Category Selection window appears. Here, you will be able to choose 
which types of files to restore, or you can select all files to restore: 

• Doremi: These files include configuration files, devices, SNMP threshold, audio, 
and databases. 

• Identity: These files include Dolby Security Module identity certificates. 
• KDMs: These files include KDMs and digital license messages. 
• Network: Includes IP addresses, DNS configurations, and so on. 
• System: These files include system user accounts, group configurations, and 

time-zone information. 
For example, if you decide to select kdms, highlight the item on the left and click on 
the Restore button. 

 

Restore 
button 
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Figure 12-99 Restore Category Selection Window 

5. Reboot the system to complete the restore process.  
If you decide not to reboot, click on the Close button. The unit will not reboot. This 
will not complete the restore process. 

 

Figure 12-100 Processing Window 

The restore process is now complete. 

 

 
Note: The reboot process takes approximately three minutes to begin. 

 

Select all 
button  
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Restoring from an External Drive 

You can restore from an external device in the Backup Manager window. 

To perform the operation: 

1. Insert the external drive into the unit. 
The backup appears in the Restore Backup tab. 

2. Select the backup file from the left-hand side. 
3. Click on the Restore button. 

A login screen appears. 

  

Figure 12-101 Restore Button 

4. Enter the appropriate password. 
5. Click on the OK button. 

The Restore Category Selection window appears. Here, you will be able to choose 
which types of files to restore, or you can select all files to restore: 

• Doremi: These files include configuration files, devices, SNMP threshold, audio, 
and databases. 

• Identity: These files include Dolby Security Module identity certificates. 
• KDMs: These files include KDMs and digital license messages. 
• Network: Includes IP addresses, DNS configurations, and so on 
• System: These files include system user accounts, group configurations, and 

time-zone information. 
For example, if you decide to select doremi, highlight the item on the left and click on 
the Restore button. 

Restore 
button   
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Figure 12-102 Restore Category Selection Window 

6. The Processing window appears. 

 

Figure 12-103 Processing Window 

7. Reboot the system to complete the restore process.  
If you decide not to reboot, click on the Close button. The unit will not reboot. This 
will not complete the restore process. 

 

 
Note: The reboot process will take approximately three minutes to begin. 

 
The restore process is now complete. 



 License Agreement 
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12.18 License Agreement 

The License Agreement application allows you to agree to the Dolby terms and 
conditions. You will need to perform this action only once. 

If you have not agreed to the terms and conditions yet, a notification appears at the top of 
the screen notifying you of the issue. 

  

Figure 12-104 License Message 

To access the license agreement: 

1. Select Administration > Control Panel > License Agreement. 
2. Click the check box to indicate that you have read and accept the terms of the 

software license agreement.  

 

Figure 12-105 License Agreement  
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12.19  Automatic Log Upload Manager 

The automatic log upload manager allows you to generate a log and upload it to a 
location you select. You will be able to automate log generation at a specified frequency.   

To access the automatic log upload manager, select Administration > Control Panel > 
Automatic Log Upload Manager.  

Check the Active Log Uploading check box to ensure that the logs are being uploaded.  

To perform the operation: 

1. Specify the frequency and time, and select a file name.  
2. Click on the Add button.  

The following window appears. 

 

Figure 12-106 Automatic Log Upload Manager 

 

Figure 12-107 Manager Configuration Window 

3. Click on the Enable box if this particular configuration will be used. 
4. Give the configuration a name. 
5. Input a location in the URL field. 
6. Enter a user name and password. 
7. Select SMPTE and/or system logs. 
8. Click on the Test button to test the configuration, if needed. 

Add button 

Test button 

Check box 
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9. Click on the OK button. 
The new configuration appears in the main window.  

10. Click on the Save button to save the configuration. 

 

Figure 12-108 Configuration Added 

To delete a configuration: 

11. Select the configuration. 
12. Click the Delete button.  
13. Click on the Save button to save the changes. 

Delete 
button 

Revert 
button 

Save 
button 
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12.20 Threshold Manager 

The threshold manager allows you to view and adjust the threshold values for 
temperature, voltage, fans, and certain errors.  

To access the Threshold Manager, select Administration > Control Panel > Threshold 
Manager. The default tab is the Help tab. This tab offers an explanation of the application.  

 

Figure 12-109 Help Tab 

 

 
Note: Although you are able to change the threshold values, we recommend that 

you leave the default values. 

 

Each tab lists the high and low threshold as well as the hysteresis value, which is 
optional. The default hysteresis value is 0, but this can be changed. 

The hysteresis value is the plus or minus tolerance value, meaning that an alert appears 
when the threshold high or low is reached and will not appear again until the hysteresis 
value is reached. This is to prevent multiple alerts from appearing if the value continues 
to remain above the threshold values. Once the hysteresis value is reached, an alert 
appears. 

Help tab 
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12.20.1 Temperatures Tab 

The Temperatures tab lists the high and low threshold values for different components of 
the server, in degrees Celsius. Hovering over the component will give a brief explanation 
of that component.  

Click on the Save button to save any changes or on the Revert button to undo any 
unsaved changes. 

 

Figure 12-110 Temperature Tab 

12.20.2 Voltages Tab 
The Voltages tab lists the high and low threshold values for different components of the 
server, in millivolts. Hovering over the component will give a brief explanation of that 
component.  

Click on the Save button to save any changes or on the Revert button to undo any 
unsaved changes. 

 

Figure 12-111 Voltages Tab 
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12.20.3 Fans Tab 

The Fans tab lists the high and low threshold values for the different fans of the server, in 
RPMs. Hovering over a fan will give a brief explanation of that fan.  

Click on the Save button to save any changes or on the Revert button to undo any 
unsaved changes. 

 

Figure 12-112 Fans Tab 

12.20.4 Counters Tab 

The Counters tab lists the high and low threshold values for different errors, indicating 
how many times that particular error is allowed to happen before an alert is issued. 
Hovering over an error will give a brief explanation of that error.  

Click on the Save button to save any changes or on the Revert button to undo any 
unsaved changes. 

 

Figure 12-113 Counters Tab  
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Save button 
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12.20.5 Reset to Default Tab 

The Reset to Default tab allows you to reset all values to the default values. 

 

Figure 12-114 Reset Values Tab 

Reset button 
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12.21  Interface Settings 

The Interface Settings application allows you to set the interface size. Click on the drop-
down menu to select the size. Click on the Switch button to confirm the change. 

 

Figure 12-115 Interface Settings 

12.22  NAS Manager 

The IMS2000 supports NAS. This provides extra HD space on the network, increasing 
storage capacity. It allows you to ingest to and play from the NAS device.  

 

 
Note: Each IMS2000 unit is limited to four attached NAS devices on one unit. 

Following is a list of approved NAS devices: 

• Netgear: ReadyNAS 2120  
• Seagate: STDE100 
Below is a list of approved hard-disk drives that are supported for both NAS devices: 
• Hard-disk drive M/N: HUS724020ALA640 
• Hard-disk drive M/N: WD2003FYYS 

Switch button 
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To add an NAS source: 

a. Select Administration > Control Panel > NAS Manager. 
b. Click on the New button. 
c. Populate the fields with the appropriate information. 
d. Ensure that the Enabled check box is selected.  
e. Click on the Save button to save the source.  

 

Figure 12-116 NAS Manager 

12.22.1 Verifying NAS Connection 

To verify the status of the NAS connection: 

• Go to Monitoring > Diagnostics > Storage. 
• Click on the removable storage icon button. 
• Verify that the status in the Unit Information section is Normal. 

If the NAS device is showing a warning or error message, refer to Chapter 27 for 
information on how to troubleshoot the problem. 

New 
button 

Save 
button 
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12.22.2 Managing Content on an NAS Device 

Ingesting to an NAS device 

The attached NAS device should ingest from only one unit at a time to ensure the 
performance of the devices are not hindered. 

To perform the operation: 

1. Verify the NAS permission is set to read/write. 
2. Go to Control > Ingest Manager > Ingest Scan. 
3. Select the source that contains the content that will be ingested to the NAS. 
4. Move the cursor over the Ingest button and select the NAS destination. 

The ingested content will be available on the NAS storage when the process is 
completed. You will be able to view the progress of the content being ingested in the 
Ingest Monitor window. 

 

Figure 12-117 NAS Destination 

 

 

Figure 12-118 Ingest Monitor Window 

NAS 
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Ingest from an NAS Device 

The attached NAS device should ingest to only one unit at a time to ensure the 
performance of the devices are not hindered. To perform the operation: 

1. Go to Control > Ingest Manager > Ingest Scan. 
2. Select the NAS source from the drop-down menu. 
3. Select the content to ingest to the local storage. 

 

Figure 12-119 Selecting NAS Source 

4. Move the cursor over the Ingest button, and select the Local (default) destination. 
The ingested content will be available on the local storage when the process is 
completed. You will be able to view the progress of the content being ingested in the 
Ingest Monitor window. 
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12.23 Adding an Audio Processor to the IMS2000 

To add a Dolby audio processor to the IMS2000 as a RAW device (to enable automation 
commands): 

1. Select Administration > Device Manager. 

2. Click the New button. 
3. Select Raw Device. 
4. Enter the name of the Dolby Audio Processor (for example, CP650, CP750, or CP850) 

in the Identifier field. 
5. Enter Dolby in the Vendor field. 
6. Enter the name of the Dolby audio processor (for example, CP650, CP750, or CP850) 

in the Product Name field. 
7. Enter the IP address of the device in the Device IP field. 
8. Enter the protocol type in the Protocol field. 
9. Enter the appropriate port number in the Port field as follows: 

• Dolby CP850 port number:  61408 
• Dolby CP750 port number:  61408 
• Dolby CP650 port number:  61412 

12.24 Transferring the Automation Cue Library to the IMS2000 
 

To transfer the audio processor automation cue library to the IMS2000 (so it appears in 
the Device Manager Library list): 

1. Use FileZilla (or another FTP client program) on your computer. 
2. Connect to the IMS2000 using the following credentials: 

• Username: root 
• Password: veeone 
• Port: 22 

3. Browse to doremi/etc/cuelib. 
4. Transfer the Dolby audio processor cues library file into this directory. 

12.25 Adding the Dolby Audio Processor Macro and Automation 
Cues to the IMS2000 

 

To add macro and automation cues: 

1. Select  Administration > Device Manager. 

2. Click the New button. 
3. Click Select and Action to Insert > Library, then select Insert. 
4. Select the audio processor from the Driver field. 
5. Select the cue you want to trigger in the Action field. 
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Chapter  13 Using the Control Tab 

13.1 Managing Shows Using CineLister 

The Control tab provides access to the CineLister GUI that enables you to create, manage, 
edit, and play back show playlists and other ingested content. With CineLister, you can 
also schedule playbacks. 

13.2 CineLister Editor Tab 

To access CineLister, select Control > CineLister. 

The CineLister Playback tab appears. The Playback tab is the default tab that CineLister 
displays each time the you open the application. 

 

Figure 13-1 Playback Tab 

To access the Editor tab, click on the green arrow button on the right side of the GUI.  

The Editor tab is composed of two different parts: 

• The left pane displays all of the content (for example, features, trailers, 
advertisements) and automation and trigger cues. 

• The right pane is used to display the content of a given show playlist. 

Chapter 13 

Editor tab 
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Figure 13-2 Editor Tab 

13.2.1 Show Playlists 

A show playlist is a succession of Composition Playlists (CPLs), automation cues, and 
trigger cues. Show playlists make up the chain of events that account for the playback of 
a show. Using CineLister, you can create and edit show playlists. Following are the types 
of elements that you can use when creating a show playlist: 

• Audio/visual content (for example, features, test content, trailers, live, and so on) 
• Automation cues (macro automation events) 
• Trigger cues (events upon which a macro automation cue is executed) 

13.2.2 Audio/Visual Content 

When the audio/visual content is encrypted, an icon is displayed with the content: 
  

•   Lock icon with red button: The required KDM is not available. Thus, the content 
cannot be played. 

•   Lock icon with green button: A valid KDM is available for that content and        
that content can be played.

Available 
content 

Show 
playlist 
content 
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13.3 Show Playlist Creation 

The CineLister application allows you to create your own show playlist from the 
elements listed in the left pane of the Editor tab. 

13.3.1 Creating a New Show Playlist 
 

 

  

Figure 13-3 Editor Tab 

To perform the operation: 

1. Click on the New button from the CineLister Editor tab. 
2. Click on the elements to add to the show playlist from the left pane of the GUI.  
3. You can filter the elements or search for a specific element to make it easier to add 

them to a show playlist. 
4. The items appears in the right pane. 

  

Figure 13-4 Elements Added to Show Playlist 

New button 

Element list 
window 

Show playlist 
window with 
elements added 

Delete 
element 

Save 
button 
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To remove an element in a show playlist: 

1. Select it in the show playlist window, and click on the X button that appears on the 
right. 

2. Click on the Save button.  
You will be prompted to a window asking you to input the correct password. 
superuser privileges are necessary to confirm the changes. If you are already logged 
in with superuser privileges, the password confirmation window will not appear. 
After the correct password is entered, you will be prompted to name the newly 
created show playlist. 

 

Figure 13-5 Show Playlist Naming 

13.3.2 Adding a Macro 

You will be able to add macros in the editor tab. 

To perform the operation: 

1. Select the element to attach the macro to in the show playlist window on the right side 
of the application. 

2. Select the macro on the left part of the GUI, and click on it. 
3. The Edit Time Code window appears. 

 

Figure 13-6 Macros Selected 

 

Macros 



 Show Playlist Creation 
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Figure 13-7 Edit Timecode Window 

4. Select the offset value for the macro. 
5. Click on the Ok button when finished.  

The macro appears on the right-hand side of the GUI. 

 

Figure 13-8 Macro Added 

Macro 
added 
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Adding a Trigger Cue 

You will be able to add macros in the Editor tab. 

To perform the operation: 

1. Select the element to attach the trigger cue to in the show playlist on the right side of 
the application. 

2. Select a trigger cue on the left part of the GUI, and click on it. 

 

Figure 13-9 Trigger Cue Selected 
 

 
3. The Edit Trigger Cue window appears. 

 

Figure 13-10 Edit Trigger Cue Window 

4. Select the automation cue to associate to the trigger by clicking on it in the automation 
cues window. 

5. Select the scope of the trigger by checking if the trigger is available for all elements or 
just the selected element. 

Open 
button 

Trigger 
cues 
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6. Click Ok when finished, and the trigger appears on the right-hand side of the GUI. 

 

Figure 13-11 Trigger Cue Added 

13.3.3 Element Reordering 

Using the up and down arrows, each element can be moved to the top or to the bottom of 
the show playlist: 

To move an element in the show playlist, select the element, then click on the up or down 
arrow. 

  

Figure 13-12 Element Reordering 

 
Note: When an element is associated with an automation or trigger cue, the cues 

will also be reordered. 

Up and down 
arrows 

Refresh button 
Open button 

Trigger cue 
added 
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Refresh Button 

Anytime new content and a package are ingested into the server, the elements are not 
displayed automatically in the CineLister GUI if CineLister is already running. Click on 
the Refresh Contents button from the Editor tab to view an updated version of all 
available elements that were ingested. 

Save Button 

It is very important to click on the Save button when done completing any task, 
especially a show playlist. If you do not click on the Save button, the changes will not be 
reflected. 

13.4 Accessing a Show Playlist 

You are able to access an existing show playlist from the CineLister application. 

To perform the operation: 

1. Click on the Open button from the CineLister Editor tab.  
A new window appears, allowing you to select the show playlist. 

 

Figure 13-13 Open Show Playlist 
 

2. Select the show playlist, and click on the Ok button.  
The show playlist displays on the right side of the GUI.  



 Accessing a Show Playlist 
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13.4.1 Editing an Existing Show Playlist 

You will be able to edit an existing show playlist from the CineLister application. 

To perform the operation: 

1. Click on the Open button in the CineLister Editor tab. 
2. You will be prompted to the show playlists available on the server window. 
3. Select the show playlist, and click on the Ok button. 
4. The show playlist content will be displayed on the right side of the GUI. 

   

Figure 13-14 Show Playlist Opened 

5. Reorder the elements within the show playlist by using the up and down arrows. 
6. Remove elements by selecting them and then clicking the X button. 

To view the properties of a show playlist: 

1. Open the show playlist. 
2. Click the SPL Properties button. 

To view the properties of a particular CPL, highlight the CPL and click on the 
Properties icon that appears on the right. 

Element 
properties icon 

Delete show 
playlist button 
Show playlist 

properties button 

Delete element 
button 
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13.4.2 Deleting a Show Playlist 

You are able to delete an existing show playlist from the CineLister application. 

To perform the operation: 

1. Open the show playlist. 
2. Click on the Delete SPL button. 

A password is required to complete this operation. Superuser privileges are 
necessary to confirm the changes. If you are already logged in with superuser 
privileges, the password confirmation window will not appear.  

3. The Delete window appears. 

 

Figure 13-15 Delete Show Playlist Window 

4. Select the show playlist to delete, and click Delete. 



 Accessing a Show Playlist 
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13.4.3 Element Properties 

You have the ability to view the properties of a selected element. 

To perform the operation: 

1. Select the element from the right side of the GUI.  
2. Highlight the selected item. 
3. Click on the Element Properties button. 

The Composition Playlist Properties window appears. 

 

Figure 13-16 CPL Properties 

If the element selected is an unencrypted CPL, the properties window in the 
following figure appears. 

 

 

Figure 13-17 Unencrypted CPL 
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If the element selected is an encrypted CPL, the following properties window appears 
with the KDM information. The window indicates that the KDM is available and 
displays its end date. 

 

 

Figure 13-18 Encrypted KDM 

 

 
Note: All KDMs will automatically be removed from the server upon expiration. 
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13.5  Play 2D Content in 3D Mode 

13.5.1   3D Mode Configuration 

You have the ability to play 2D content within a 3D show playlist. Changing the mode of 
the show playlist to 3D does not automatically make the content 3D. The content must be 
in 3D at 48 fps format to create a 3D show playlist. 

13.5.2   Setting the Show Playlist Mode to 3D 

To perform the operation: 

1. Click on the Show Playlist Properties button. 
2. Select 3D mode from the display mode drop-down window. 

 

Figure 13-19 Display Mode Drop-Down Menu 

3. Select the HFR check box if the show playlist supports HFR.  
4. Click on the Close button. 

The Show Playlist Properties button reflects the name of the show playlist and what 
mode it is set to. 

 

Figure 13-20 Show Playlist Set to 3D 

Name and mode 
Open button 

Playback tab 
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Note: In 3D or 48 fps mode, the IMS2000 video output is in the YCxCz color 

space. The projector itself needs to be properly configured to the YCxCz 
color space in 3D or 48 fps mode for proper display. Contact the projector 
vendor to configure the projector properly, or See Section 12.3.3. 

13.6 Segment, Marker, and Intermission 

You will have the option to add a segment, marker, or intermission to a selected show 
playlist. 

Clicking on the plus button in the CineLister Editor tab opens a drop-down menu that 
allows you to add a segment, marker, and intermission to the show playlist. 

  

Figure 13-21 Plus Button 

Plus button 



 Segment, Marker, and Intermission 
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13.6.1 Segment 

A segment allows you to organize and arrange the visual presentation of a show playlist 
into sections or segments.  

Segments are only used as an aesthetic tool to organize the show playlist and to notify 
you of different sections within the show playlist.  

To create a segment: 

1. Click on the plus icon in CineLister (in an existing or new show playlist). 
2. Select Segment from the drop-down menu.  
3. The new segment appears. 
4. Use the up and down arrows to rearrange the segment.  
5. Several segments can be added into a show playlist. 
6. Attach show playlist elements to the segment by using the up arrow. This allows you 

to move the elements when the segment moves.  
 

 

Figure 13-22 New Segment 

 

 
Note: Within the same show playlist, each segment must have a different name. 

To rename the segment: 

1. Click on the properties icon on the right. 
2. Click on the Save Pack Name button to save the name.  

Substitute any spaces with an underscore. 

 
 

New segment added 

Properties icon 
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Figure 13-23 New Segment Naming 

To delete a segment: 

1. Select it. 
2. Click on the Delete button. 

  

Figure 13-24 Segments Added 

Delete segment 

Up and down 
arrows 

Connected 
elements 
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External Show Playlist 

You also have the option of adding a show playlist into another show playlist. These are 
called external show playlists. The external show playlist allows the content of that show 
playlist to be inserted into the current show playlist. CineLister now lists the available 
show playlists on the left area of the editor among the other CPLs.  

To include an external show playlist into the current show playlist: 

1. Select the show playlist in the left side of the GUI. 
It appears as a segment labeled as the title of the added show playlist. 

 

Figure 13-25 External Show Playlist  

2. Click on the Save button to save any changes. 

Available 
show 

playlists 

External 
show playlist 

added 
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Skip to Show Playlist Segment Macro 

You can also create a macro that will cause playback to jump to a specific segment.  

To create the macro, select Administration > Macro Editor: 

1. Click on the New button. 

 

Figure 13-26 External Show Playlist  

2. Name the macro Skip to Segment X. 
X is the name of the segment that will begin playing upon execution of the macro. 

3. Click the Ok button.  
The macro name appears in the Macro Settings window. 

 

Figure 13-27 Macro Settings  

4. Select the macro. 
5. Click on Select an Action to insert it.  

New button 
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Figure 13-28 Inserting Action 

6. Select Playback > Playback Actions, and click on the Insert button. 
7. Select the Skip to Show Playlist Segment from the drop-down menu. 

 

Figure 13-29 Selecting Action 

8. Enter the exact name of the segment in the field that appears, and click on the Ok 
button. 
The newly added macro appears in the macro editor. 

 

Figure 13-30 Segment Named 

9. Click on the Save button to save the macro. 
10. Click on the Refresh button. 

The macro will also appear in CineLister after it has been clicked.  

Macro added 

Insert button 

Playback actions 
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Figure 13-31 Macro Added 

When executed, this macro causes playback to jump to the specified segment within the 
show playlist. 

13.6.2 Marker 

A marker is a label that is attached to a specific timecode of a CPL inside the show 
playlist. It can be used by y to add a note about when an event is expected to happen in 
the show playlist. The use of these markers is generally for user information purposes 
only.  

The exception is the Exit_Intermission marker. For information on how to use this 
marker, go to Section 13.6.2 

Intermission  

The intermission feature offers a quick and easy solution to create an intermission during 
any CPL being played. 

An exit from intermission macro can be created and added to allow the operator to 
trigger the exit from the intermission show playlist and resume the main show playlist. 

Macro added 

Refresh button 
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Intermission Show Playlist 

To create the intermission show playlist, select the CineLister Editor tab. 

1. Add the CPLs to create an intermission show playlist.  

  

Figure 13-32 Intermission Show Playlist 

2. Click on the Save button, and name the show playlist. 

Save button 
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Main Show Playlist 
 

 
 

1. Create or open the main show playlist that you wish to attach to the intermission 
show playlist. 

   

Figure 13-33 Main Show Playlist 

2. Select the CPL to attach the intermission show playlist to, and click the plus button.  
3. Select Intermission. 

  

Figure 13-34 Intermission Drop-Down Menu 

4. Select the preferred offset position timecode, the intermission playlist from the drop-
down of show playlists, and the amount of time to rewind the show playlist before 
the cut position. 

Plus button 

Main 
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5. Click on the Ok button.  
The intermission show playlist has now been added. 

 

Figure 13-35 Edit Intermission Window 

 

 
Note: The minutes-to-rewind time amount should be smaller than the offset 

position time amount. 
 

6. Click on the Save button, and name the show playlist, if necessary. 
The main show playlist appears. The CPL that has the intermission show playlist 
attached to it appears as two clips with the intermission CPLs in between.  

  

Figure 13-36 Intermission Show Playlist Added 
 

Save 
button 

Intermission 
added 



Using the Control Tab  
 

 

 
196 Dolby® IMS2000 Installation and User’s Manual 
 IMS.OM.004730.DRM: Issue:1 
 

 

 

Figure 13-37 Intermission Playback 

Creating an Exit from Intermission Macro  

An exit from intermission macro can be created in the macro editor application and then 
inserted to allow you to quickly end intermission at any point during intermission 
playback and either return to the main show playlist or, with a marker, jump to a specific 
part of the intermission show playlist.  

To create the macro, select the macro editor: 

1. Click on the New button. 

  

Figure 13-38 Macro Editor 

2. Name the macro Exit from Intermission. 
3. Click the Ok button.  

CPL split in two 

New button 
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Figure 13-39 Exit from Intermission Macro 

4. Click on the Select an Action to Insert button. 
5. Select Playback and then Playback Actions. 
6. Click on the Insert button. 

 

Figure 13-40 Macro Added  

7. Select Exit from Intermission from the drop-down menu. 
8. Click on the Ok button. 

 

Figure 13-41 Exit from Intermission Macro Added 

5. Click on the Save button, and enter the necessary password to save.  
Superuser privileges are necessary to save the macro. 

Insert button 

Playback actions 

Macro added 
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Figure 13-42 Exit from Intermission 

Exit Intermission Marker 

Executing the macro during intermission will automatically begin playback of part two 
of the main show playlist. To cause playback to jump to a specific part of the intermission 
show playlist (instead of returning to the main show playlist), you can create a marker 
that works with the macro.   

To add a marker, in the intermission show playlist: 

1. Select the CPL that you want to play when the exit from intermission macro is 
executed.  

2. Click on the plus button, and select Marker.  

 

Figure 13-43 Marker Creation 

3. Indicate at what timecode you would like the CPL to play. 
4. Click on the Ok button. 

The marker has now been added. 

Save button 

Marker 
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Figure 13-44 Exit Intermission Marker 

   

Figure 13-45 Marker Added 
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13.7 CineLister Playback Tab 

To access the Playback tab, click on the green arrow on the right-hand side of the GUI in 
the Editor and Schedule tabs. 

13.7.1 Playback an Existing Show Playlist 

You can play back an existing show playlist. 

To perform the operation: 

1. Click on the Open button from the CineLister Editor tab. 
The following window appears. 

 

Figure 13-46 Open Show Playlist Window 

2. Select the show playlist to play. 
3. Click on the OK button. 
4. Select the Playback tab from the CineLister GUI. 

  

Eject button 

Play button 

Pause button 
Mode drop-
down menu 
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Figure 13-47 Playback Tab 

5. Click the Play button to load the playlist. 
If no playlist is selected, a message appears stating The show playlist is empty. 

 

Figure 13-48 Empty Playlist 

 

 
Note: If a show playlist contains an element with an expired KDM, the show 

playlist will not load. 
 



Using the Control Tab  
 

 

 
202 Dolby® IMS2000 Installation and User’s Manual 
 IMS.OM.004730.DRM: Issue:1 
 

 

 

 

13.7.2  Playback Progress 

The show playlist progress list box displays the order of the playback.  

  

Figure 13-49 Playback Icons 

The top playback bar displays how much time has elapsed and how much time is 
remaining in the individual element. The bottom playback bar displays how much time 
has elapsed and how much time is remaining in the entire show playlist: 

• Elements already played are flagged using a yellow mark. 
• Elements currently being played are flagged using a green mark. 
• Elements that were not played due to an error are flagged using a red mark. 
• Elements that were skipped by you have an orange mark.  
• Elements that have not yet been played do not have any marks next to them. 

The playback button on the bottom notifications bar will display if playback is in 
progress. If playback is in progress, clicking on the playback button will open up the 
CineLister Playback tab. If playback is not in progress, clicking on the button will open up 
the CineLister Editor tab.  

Playback 
icons 

Next button 

Rewind  

Top playback 
bar 

Playback button 

Bottom playback 
bar 

Fast forward  

Next button 
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13.7.3  Playback Buttons 

To pause playback: 

1. Click on the pause button to pause the playback. 
 

 
Note: Clicking the eject button will eject the show playlist. 

 
2. Click on the next and previous buttons to select the next or previous CPL in the show 

playlist. 
3. Click on the fast forward and rewind buttons to forward or rewind within a CPL.  

The default value is set at three minutes.  

4. Click on the play button to resume from where the CPL was last paused. 
5. Click on the eject button to stop playback. 
6. Select the playback mode from the Mode drop-down list. 

You will be prompted to a password window to confirm the mode. Superuser 
privileges are necessary to confirm the changes. If you are already logged in with 
superuser privileges, the password confirmation window will not appear.  

13.7.4 Playback of a Live Event  

You can create a show playlist for the live event using theatre effects such as closing and 
opening of curtains, previews, trailers, and advertisements before the live event is 
scheduled to start. The live event is not prerecorded and therefore cannot be rewound or 
fast forwarded. See Chapter 11 for more information on creating and playing a live event.   
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13.7.5 Playback Lock Mode 

The Mode button can be used to determine manual or schedule mode.  

 

Figure 13-50 Playback Lock Mode 

In schedule mode, you are unable to change playback. 

 

Figure 13-51 Schedule Mode 
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13.7.6 Playback Alert Messages 

There are two alerts available for playback errors. These errors are displayed at the top of 
every window: 

• Projector communication failure. 
This message is displayed when there is no projector configured or if the server is not 
connected to the primary configured projector.  

 

Figure 13-52 Projector Communication Failure 

• Storage needs assistance. 
This message displays if at least one of the available RAID storage devices is 
degraded or faulty (for example, RAID-md0 or RAID-md1). 

 

Figure 13-53 Storage Needs Assistance Message 
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13.8 CineLister Schedule Tab 

The Schedule tab allows you to schedule the playback of show playlists on a certain day 
and time. The server will automatically begin the playback of the show playlists once 
they have been scheduled. 

To access the Schedule tab, click on the green arrow on the right-hand side of the GUI in 
the Editor and Playback tabs. 

 

Figure 13-54 CineLister Schedule Tab 

13.8.1 How to Schedule Playback 

To schedule playback from the CineLister application: 

1. Select the Schedule tab from the CineLister GUI. 
The Schedule tab automatically displays the current week. To display another week, 
use the green arrow. 

2. Click on the New button. 
3. Enter the appropriate password for the authentication window that might appear 

depending on your user level. 
4. The Edit Schedule window appears. 
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Delete button 
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Outdated 
schedules 



 CineLister Schedule Tab 
 

 

 
Dolby® IMS2000 Installation and User’s Manual 
IMS.OM.004730.DRM: Issue:1 207 

 

 

Figure 13-55 Edit Schedule Window 

5. Select the show playlist to schedule for playback from the drop-down menu. 
6. Use the left and right arrows to adjust the week to schedule the playback. 
7. Select the days to schedule the playback by checking the corresponding boxes. 
8. Select the start time for the scheduled playback by using the up and down arrows. 
9. Click on the Save button when finished or cancel the operation. 
10. The Schedule tab will be updated to reflect the recently added schedule.  
11. To display outdated schedules, check the outdated schedule box.  

13.8.2 Schedule Conflict 

If you are trying to schedule playback and one already exists for the same time and date, 
you will receive a schedule conflict message. The schedule conflict message displays the 
time and date for which there is a conflict. You will also receive the conflict message if 
you are trying to schedule playback that interrupts the scheduled time of another 
playback.  

13.8.3 Scheduled Show Did Not Start Error 

If there is an error message stating The scheduled Show below did not start as expected. 
This can be due to several reasons. Contact Dolby product specialists for assistance (See 
Section 1.3).

Save button 

Cancel button 
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13.8.4  Show Playlist Removal 

You can remove a show playlist from the schedule: 

1. Select the CineLister Schedule tab. 
2. Click on the show playlist to remove it in the Schedule window. 
3. Click on the Delete button. 

The appropriate password will be needed for the password authentication window 
that will pop up. superuser privileges are necessary to confirm the changes. If you 
are already logged in with superuser privileges, the password confirmation window 
will not appear.  

4. Click on the Delete button to delete the playlist. 

13.8.5  Playback Recovery Due to Power Failure 

If a power failure occurs during a scheduled playback, then playback recovery will be 
possible after having powered the unit back on. 

How to Recover Playback 
To recover playback after an unexpected failure occurs, login with the proper 
credentials. 

 
Note: After logging in, CineLister will resume playback at the default amount of 

180 seconds prior to power failure. This amount will be different if the 
settings have been changed by you. 

Shutting Down During Playback 

When there is a playback in progress and you try to shut down the server, you will be 
prompted to a confirmation window. If you select yes, the server will shut down in five 
seconds and playback will stop. 

 

 
Note: Playback will resume when the unit is turned back on. 

 



 Ingest Manager 
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13.9 Ingest Manager   

The ingest manager GUI can be accessed by going to Control > Ingest Manager. It will 
only show items that can be supported by the IMS2000. Text, documents, pictures, 
PowerPoint® presentations, and so on will not appear. 

You are able to ingest while performing playback. 

13.9.1  Ingest Scan 

The Ingest Monitor tab automatically opens the Ingest Scan tab. 

 

Figure 13-56 Ingest Scan Window 
 

 
Note: CPLs, KDMs, digital license messages, and show playlists can all be 

ingested through the ingest manager GUI. 

Selecting an element to ingest and then hovering over the Ingest button reveals the 
amount of space available on the local storage. Clicking on the pop up will take you to 
the Ingest Monitor tab.  

Ingest button 
Refresh button 

Location menu 
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Figure 13-57 Local Storage Availability 

Content Types 

Different types of content can be displayed in the ingest manager GUI window: 

•   Reel icons represent a composition package, which contains audio and video 
content (for example, features, trailers, and so on). 

•  Speaker and film icons represent individual compositions within a composition 
package. 

•  Film icons represent show playlists, which contain the main feature and trailers. 
 

 
Note: When the show playlist is ingested, the ingest manager GUI shows all of 

the components that make up the show playlist. 
  

•   Lock icons represent KDMs, which contain the required decryption keys 
allowing playback of the corresponding CPLs. 

Local storage  



 Ingest Manager 
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Ingesting Content from a USB Drive 

If the content to ingest is on a USB drive, plug the drive into the IMS2000 USB port and 
open the Ingest Manager application: 

1. Select Local Storage. 
2. Click on the Refresh button. 
3. Select an item: 

• To select, or unselect, all items, use the Select all button. 
• To search for an item, use the search field. 

4. Click on the Ingest button.  
The ingest process will begin. If an item was already ingested, it appears in gray. 

 

 
Note: To hide all ingested content, select the Hide ingested content button. 

 

 

Figure 13-58 USB Ingest 

You will be prompted to the Ingest Monitor tab to view the progress of the ingest. 

Ingested items 

Search field 

Select all button 

Hide ingested 
content 
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Ingesting Content from an FTP Site 

Use a File Transfer Protocol (FTP) connection to ingest an item from a central server or a 
cinema server over a network. 

Ingesting Content from a Dolby Remote Playback System/Library Media Server 

To ingest content from a remote playback system/Library Media Server: 

1. Click on the drop-down menu from the location menu. 
2. Select the device from which to ingest. 

Its content will be displayed inside the GUI. 

 

Figure 13-59 Ingest Scan Tab 

3. Select the item to ingest. 
4. Click on the Ingest button. 

You will be prompted to the Ingest Monitor tab to view the progress of the ingest.  

 

 
Note: The server must be added through the Content Feed Manager. 

 

Ingest monitor 
tab 
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Play While Ingest 

When a composition is ingested, it can be played while it is being ingested instead of 
waiting until the ingest is complete. Give the CPL approximately five to seven minutes to 
load. You cannot rewind or fast forward during playback.  

This feature is available only on software version 2.7.12 and later. If the content is 
encrypted, you must first ingest a KDM. 

To perform the operation: 

1. Select a clip and enable the P’ngest check box.  
2. Click on the Ingest button.  

 

Figure 13-60 Play While Ingest Enabled 

A prompt appears, asking you to confirm the action. 

 

Figure 13-61 Play While Ingest Confirmation 

3. Monitor the progress of the play while ingest by clicking on the Monitor tab (See 
Section 13.9.2). 

4. Wait approximately five to seven minutes, then select the CineLister editor. 
5. Click on the Refresh button. 

The CPL appears in the window.  

6. Select the CPL. 
7. Select the Playback tab, and click play. 
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Pause button 
Delete button 

13.9.2  Ingest Monitor  

The IMS2000 allows you to ingest content while the server is ingesting previously 
selected content. Click on the Ingest Monitor tab to see the progress of all the ingested 
items. 

To access the Ingest Monitor tab, click on the green arrow on the right-hand side of the 
GUI in the Ingest Scan and Upload tabs: 

• USB ingests are real time. 
• eSATA ingests are two-thirds of real time. 
To display an updated view of the Ingest Monitor with all the recently ingested items, 
click on the Refresh button. 

 

Figure 13-62 Ingest Progress 

In the Ingest Monitor tab, you can delete, pause, resume, or cancel an ingest using the 
available buttons.  

To select or unselect all items, use the Select All button.  

To see more details for each element, highlight the item and click on the properties icon 
on the right-hand side. The element information displays at the bottom of the window.  

The notifications bar alerts you to any ingest that is in progress.  

Clicking on the button opens the Ingest Monitor tab that displays the ingest progress. 

 

Refresh button 

Ingest button 

Resume button 

Upload tab 
Cancel button 

Element 
information 

Select all button 

Properties icon 
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13.9.3 Ingest Upload 

You can use the Ingest Upload tab to upload packages from your local network.  

 

Figure 13-63 Ingest Upload 
 

To upload a package: 
 
 

1. Select Control > Ingest Manager > Upload.  
Alternatively, clicking on the green arrow on the right-hand side of the GUI in the 
Ingest Scan and Ingest Monitor tab also opens up the Upload tab. 

2. Click on the Browse button to locate the package to ingest.  
3. Click on the Upload button when you have selected the file. 

When the file has been uploaded, you may be prompted to reboot the unit.  

4. Click on the Reboot button.  

 

Figure 13-64 Upload Reboot 

You will be prompted to the System tab to restart the unit. 

Browse button 

Upload button 

Reboot button 
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Figure 13-65 Restart Unit 

5. Log in with proper credentials when the unit reboots. 
6. Select the Ingest Monitor tab.  

The package will be fully ingested.  

 

Figure 13-66 Package Inserted 

Restart button 

Package 
available 
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13.10  Content Manager 

The Content Manager application is a GUI that allows you to browse, manage, and export 
all the content available on the player, including:  

• Show playlist 
• CPL 
• KDM 
• Digital license messages 

The Content Manager application is available in the Control tab. 

Select Control > Content Manager to open the content manager application. The Overview 
tab appears.  

To see an updated view of the Overview tab with all available content, click on the 
Refresh button. 

13.10.1   Overview 

The Overview tab lists all available CPLs, licenses, show playlists, and KDMs on the unit. 
It also displays the used and free space available.  

 

Figure 13-67 Content Manger Main Tab 
 
 
 

• A complete CPL is a CPL that is playable.  
• An incomplete CPL has missing elements and is therefore not playable. 
• Valid KDMs are KDMs that have not expired yet and are for trusted devices. 
• Expired KDMs are KDMs with a validity date that has expired. 
• Not yet valid KDMs reference KDMs made in advance, not valid presently, to be 

used in the future.  

Composition 
Playlist tab 

Used space 

Refresh button 

Free space 
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• A valid license is a license that has not expired. 
• An expired license is a license with validity date that has expired. 
• Not yet valid licenses are available on the unit, not valid presently, but valid only for 

future use. 

13.10.2   Composition Playlists Page 

The Compositions Playlists tab displays all of the CPLs available on the unit as well as 
their properties. To access the Composition Playlists tab, click on the green arrow on the 
right-hand side of the GUI in the Overview and Decryption Keys tabs.  

To see an updated view of the tab will all available CPLs, click on the Refresh button. To 
search for a specific CPL, click on the Search button. To filter the CPLs by the type of 
elements that have been ingested, click on the Filters button. To select or unselect all of 
the elements, click the Select all button.  

 

Figure 13-68 Content Manger Composition Playlist Tab 

Delete button 

Search button 

Refresh button 
Filter button 

Properties icon  

CPL properties 

Select all 
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Delete a CPL 

To delete a CPL from the server: 

1. Select the CPL. 
2. Click on the Delete button.  

A window appears, asking to confirm.  

 

Figure 13-69 Delete CPL Window 

3. Click on the OK button to continue or on the Cancel button to cancel the operation. 
Once the CPL is deleted, it will be permanently deleted from the server and removed 
from any associated show playlists.   

Information  

Clicking anywhere on the line of a highlighted CPL, or on the properties icon that 
appears on the right, will display information about that CPL on the bottom portion of 
the tab. 

Any time you want to exit the CPL information window, click on the Close button. 

Properties Tab 

The Properties tab displays the information about the CPL:  

• Title 

• Sound (channel count, quantization bits, encoding) 
• Picture (encoding and dimension) 
• Package size 
• Duration 

• Edit rate (frame rate) 
• Kind (for example, trailer, feature, and so on) 
• Caption and subtitle info 
• UUID (universally unique identifier) 
• Creation date 
• Creator 
• Company 
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Figure 13-70 CPL Information Window: Properties Tab 

Assets Tab 

The Assets tab displays information on all the reels that compose the CPL and the assets 
in each reel (reel number, subtitle, and sound). 

 

Figure 13-71 CPL Information Window: Assets Tab 

Close button 
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SPL(s) Tab 

The SPL(s) tab displays information related to all of the show playlists that contain the 
selected CPL. 

For more information on a specific show playlist, select the show playlist from the Name 
column and click on it. This will open the show playlist information window Properties 
tab that will show all the names of the CPLs inside that show playlist. 

The second tab of the show playlist information window displays the related schedules. 
Click on the Ok button to return to the CPL properties window.  

 

Figure 13-72 SPL(s) Tab 
 
 

 

Figure 13-73 Show Playlist Information Window 

OK button 
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Figure 13-74 Related Schedules Window 

KDM(s) Tab 

This tab will display the UUID and validity of each KDM for the concerned CPL.  

 

Figure 13-75 KDM(s) Tab 

For more information on a specific KDM, select the KDM and click on it. This will take 
you to the KDM information window Properties tab. 

The Properties tab displays the following information about the selected KDM: 

• Message ID: KDM UUID  
• Message Type: Message type field of the KDM  
• Annotation Text: Annotation text field of the KDM  
• Ingestion Date: Date on which the KDM was ingested into the server 



 Content Manager 
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Figure 13-76 Properties Tab 

The Content tab contains the following information about the related CPL: 

• CPL Title 

• CPL ID (CPL UUID) 

 

Figure 13-77 Content Tab 

The Validation tab contains precise information about the date and time of the validity of 
the KDM, an approximation of the period for which the KDM is valid. 

 

Figure 13-78 Validation Tab 

The trusted device list tab contains the list of the trusted devices (projectors) and their 
certificate thumbprints. 
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Figure 13-79 Trusted Device List Tab 

You can click on the Ok button to return to the CPL properties window.  

Audio Mapping Tab 

The Audio Mapping tab allows you to save audio settings specific to the CPL. The audio 
setting created for the entire unit in the Audio Settings tab does not carry over into this 
tab, allowing you to edit these settings for each CPL, if needed.  

You also have the option to enable the data check box for the individual CPL, indicating 
that you want the channel to get a data signal, not an audio signal. It is important to click 
on the Save button when the configuration is complete. 

 

Figure 13-80 Audio Mapping Tab 

Save button 

Data check 
box 

OK button 
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Settings Tab 

The Settings tab allows you to alter the subtitle placement for the CPL as well as enable 
delete protection, which prevents that CPL from being deleted. If you attempt to delete 
the CPL, you will get an error message. Click on the Save button to save any changes.  

 

Figure 13-81 Settings Tab 

Filter Tool 

The Content Manager allows you to filter CPLs in the Composition Playlist tab using the 
Filter button located on the top portion of the window. The Filter button allows you to 
sort the CPLs based on the type of elements that have been ingested. In this case, you can 
filter by: 

• Incomplete elements, advertisements, feature, live, policy, teaser, test, and trailer 
 

 
Note: The black-highlighted area indicates whether the content is 3D or has 

subtitles. 
 

 

Save button 
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Figure 13-82 Composition Playlist Tab 

13.10.3 Decryption Keys Tab 

The Decryption Keys page displays the list of all encrypted CPLs on the unit and the 
corresponding KDMs with a description of the following information: 

• Expiration date 
• UUID of the KDM 
• Associated CPLs 

Any KDMs with missing CPLs appear in red.  

To access the Decryp. Keys tab, click on the green arrow on the right-hand side of the GUI 
in the Composition Playlist and Show Playlist tabs. 

To see an updated view of the tab with all available KDMs, click on the Refresh button. 
To search for a specific KDM, click on the Search button. To upload a KDM, click on the 
Upload button. The Upload tab of the Ingest Manager tab appears.  

For more information on the Upload tab, refer to Section 13.9.3. 

To select or unselect all of the KDMs, click the Select All button. 

Subtitle 

Decryption 
keys tab 
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Figure 13-83 Description Keys Tab 

KDM Properties  

Clicking anywhere on the line of a highlighted KDM, or on the properties icon that 
appears on the right, will display information about that KDM on the bottom portion of 
the tab. 

Clicking on the name of a KDM will open the KDM Information tab. Any time you want to 
exit the KDM Information window, click on the Ok button.  

Delete a KDM 

To delete a KDM from the server: 

1. Select the KDM. 
2. Click on the Delete button.  

A confirmation message appears.  

 

Figure 13-84 Delete KDM Confirmation Window 

3. Click on the OK button to continue or Cancel to cancel the operation. 
Once the KDM is deleted, it will be permanently deleted from the server.   

KDM properties 

Properties icon 
Upload button 
Refresh button  

Search button 

Delete button 

Show playlist tab 
Select all 

Missing CPL 
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13.10.4 Show Playlists Tab 

This page displays all the show playlists available on the unit together with the following 
information: 

• Show playlist duration  
• Show playlist name 
• UUID 

To access the Show Playlist tab, click on the green arrow on the right-hand side of the 
GUI in the Decryption Keys and Licenses tabs. 

To see an updated view of the tab with all available show playlists, click on the Refresh 
button. To search for a specific KDM, click on the Search button. To select or unselect all 
of the show playlists, click the Select All button. 

 

Figure 13-85 ShowPlaylist Tab 

Delete button 

Refresh button 

Search button 

Licenses tab 

Download icon 

Select all 
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Delete a Show Playlist 

To delete a show playlist from the IMS2000: 

1. Select the show playlist from the list. 
2. Click on the Delete button.  

The appropriate password and confirmation are required to complete the operation. 

3. Click on the Yes button to confirm the deletion, or click No to deny the deletion. 

Download 

To download and save a show playlist from the IMS2000: 

1. Select the show playlist. 
2. Click on the download icon on the right-hand side.  

This allows you to download the show playlist onto a computer and to view the 
CPLs in the show playlist.  

After selecting a show playlist and clicking the Download button, a prompt tells you 
to save or open the file. 

Information 

To retrieve details concerning the show playlist: 

To perform the operation: 

1. Select a show playlist. 
2. Click on it to get details regarding the show playlist. 

The SPL Information window pops up and displays the show playlist Properties tab 
(all CPLs in it) and the Related Schedules tab. 

 

Figure 13-86 Properties Tab 
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Figure 13-87 Related Schedules Tab 

13.10.5 Licenses Tab 

The Licenses tab contains the list of all the licenses available on the unit including the 
expiration date and short description on the usage of the license. On this page, you are 
allowed to delete licenses. 

To access the Licenses tab, click on the green arrow on the right-hand side of the GUI in 
the Show Playlist and Overview tabs. 

To see an updated view of the tab with all available licenses, click on the Refresh button. 
To search for a specific license, click on the Search button. To select or unselect all of the 
licenses, click the Select All button. 



 Content Manager 
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License Properties  

Clicking anywhere on the line of a highlighted license, or on the properties icon that 
appears on the right, will display information about that license on the bottom portion of 
the tab. 

 

Figure 13-88 Licenses Tab 

Delete a License 

To delete licenses that have been installed on the IMS2000: 

1. Select the license from the list. 
2. Click on the Delete button. 

A manager password is required to perform the deletion. If you are already logged in 
with superuser privileges, the password confirmation window will not appear. 

3. Click on the Yes button to confirm the deletion. 

Delete button 

Refresh button 

Search button 

License 
properties 

Properties icon 

Select all 
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13.10.6 Adding a License 

To install licenses on the IMS2000: 
 

1. Upload the license file on a USB flash drive. 
2. Plug the USB drive into a USB port on the IMS2000 unit. 
3. Select Control > Ingest Manager, and select Local Storage from the drop-down menu.  
4. Select the license files to install. 
5. Click on the Ingest button. 

 

Figure 13-89 Licenses Ingest 

6. Enter the appropriate password, and press Ok. 
It is not necessary to reboot the unit. 

7. Verify the license was ingested successfully. Go back to the license manager GUI. The 
ingested licenses will be visible. 
After ingesting a license, the associated device (for example, Subtitle Engine, Dolby 
DFC 100) will be visible in the Device Manager GUI. 

License icon 
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13.10.7 Licenses Available: Managed Through Digital License Control 

The following licenses are available: 

• Sensio® Hi-Fi 3D demultiplex 
• RealD® 3D EQ (deghosting) 
• RealD Side-by-Side license 
• Dolby® 3D 
• Dolby Atmos® 
• Doremi 4K license 
• Doremi StreamIt license 
• Doremi CaptiView (closed captions) 
• Auro-3D 

13.11  Device Controller  

13.11.1 Configuring the Device Controller GUI 

To display and configure the IMS2000 device controller GUI, select Control > Device 
Controller. 

  

Figure 13-90 Device Controller 

Browse 
projectors 

button 



Using the Control Tab  
 

 

 
234 Dolby® IMS2000 Installation and User’s Manual 
 IMS.OM.004730.DRM: Issue:1 
 

 

To view existing projectors, click on the Browse Projector button to display the Projector 
List window. 

 

Figure 13-91 Browse Projector Window 

Registered Tab 

If the device was previously created or registered in the Device Manager GUI, then it will 
automatically appear in the Registered tab of the device controller GUI.  

An IMB or Sony® SRX projector will be automatically detected by the device controller 
application when added to the network. 

The following parameters are shown in the Registered tab for the device: 

• Name 
• Type 
• IP 
• Port 

The port number is automatically populated. Please do not alter this field. 

Select the device to control, and then click on it. The Device Controller window displays 
four tabs that will allow you to configure, control, and manage the device. 

 

Figure 13-92 Registered Tab 
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General Tab 

The General tab is the first tab that is presented at the Device Controller window. You can 
control the input source and scaling.  

 

Figure 13-93 General Tab 

The Input drop-down menu has the following options available: 

• Internal: Signal source is the IMS2000 hard drives. 
• HDMI™: Signal source is an external device (for example, Blu-ray Disc™ player) that 

connects via HDMI cable to the IMS2000.  
• SDI: Signal source is an external device that connects via SDI cables to the IMS2000. 
• Scaling: The following masking/scaling is selectable from the drop-down menu: 

• Side masking 
• Top/bottom masking 
• One to one 

Input drop-
down menu 

Scaling drop-
down menu 
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System Tab 

The second tab displays the networking configuration. 

 

Figure 13-94 Systems Tab 

The following networking configuration information is displayed: 

• IP 
• Mask (subnetwork mask)  
• Gateway 

The factory default settings are: 

• IP: 192.168.254.246 
• Mask: 255.255.255.0 
• Gateway: 192.168.254.1 

You can save these settings as default by pressing the Save button. These configurations 
will be effective even after a reboot. 

To restore the networking configuration to factory default, click on the Restore button.  

Save as default 
button 

Restore button 
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Colors Tab 

The Colors tab allows you to modify the color space for HDMI and HD-SDI inputs. 

 

Figure 13-95 Colors Tab 

HDMI Color Space Settings 

Click on the arrow on the HDMI Input Color Space drop-down menu, and select the color 
space standards from the list: 

• Auto 
• YCbCr709 
• RGB709 
• YCxCz 
• X’Y’Z’ 

Click on the arrow on the HDMI Input Degamma drop-down menu, and select the 
degamma factor from the list: 

• Rec709 
• DCI 
• Custom: Choose the degamma factor value in the numeric field using the arrows. 
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HD-SDI Color Space Settings 

Click on the arrow on the HD-SDI Color Space drop-down menu, and select the color 
space standards from the list: 

• Auto 
• YCbCr709 
• RGB709 
• YCxCz 
• X’Y’Z’ 

Click on the arrow on the HD-SDI Input Degamma drop-down menu, and select the 
degamma factor from the list: 

• Rec709 
• DCI 
• Custom: Choose the degamma factor value in the numeric field using the arrows. 



 Device Controller 
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Click on the arrow on the HD-SDI Input Mode drop-down menu, and select the input 
mode from the list: 

• (2D) 4:4:4 Dual Link 
• (3D) 4:2:2 

Info Tab 

The fourth tab will display the following useful identification information for the 
controlled device:  

• Firmware version 

• MainBoard (main board revision number) 
• Running Mode 
• Serial Number 
• Software Version 

 

Figure 13-96 Info Tab 

13.11.2 Manual Tab 

If the device is created manually in the Manual tab, then it will be temporary and will be 
lost once the unit is rebooted or if you log out. 

 

Figure 13-97 Manual Tab 

Exit button 
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The following information is required to configure the device manually: 

• Device Name: We recommend that you use a relevant name. 
• Device Type: Click on the arrow for the list of supported devices. 
• IP Address: IP address of the device to control.  
• Port: This information is automatically populated after choosing the device type. 
• IMB port number: 43751. 

 

 
Note: Ethernet ports ETH-1 and ETH-2 are set to DHCP by default. All IMS2000 

boards are shipped from the factory with the following default IP address 
for ETH-0: 

• IP: 192.168.100.50 
• SM: 255.255.255.0 
• GW: Blank 
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13.12  Macro Execution 

The macro execution feature allows you to execute a set of macros in one single click. 
This feature is particularly useful in emergency cases. For instance, in case of a crash 
recovery, the player will resume the show but you will have to quickly execute some 
macros (such as projector lamp on). 

Click the Refresh button to ensure all recently added macros are visible. 

 

Figure 13-98 Macro Execution 

 
 

Refresh button 
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Chapter  14 Using the Monitoring Tab 

The Monitoring tab provides information drive information, detailed reports, and other 
product-related information. 

14.1 Diagnostics  

Select Diagnostic > Monitoring > Diagnostics to display the System tab. 

  

Figure 14-1 System Tab 

The application is composed of four different tabs:  

• System: Provides overall information regarding the system 
• Status Overview: Provides hardware-related information 
• Storage: Provides storage-specific information, and enables you to repair, 

reinitialize, and replace a drive 
• MediaBlock: Provides media block-related information 

Chapter 14 

System tab 
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14.2 System Tab 

The System tab provides general information related to the server, such as serial number, 
software/firmware version numbers, IP addresses, product name, security manager 
version, web UI version, operating system information, and hardware information. The 
System tab automatically jumps to the Product Information section.  

  

Figure 14-2 System Tab 

14.2.1 Detailed Report Overview 

You will have the ability to generate a detailed report when needed. 
 

 
Note: If possible, generate the report log when there is no playback. 

To perform this operation: 

1. Select Monitoring > Diagnostics > System. 
2. Click on the Detailed Report button. 
3. Click on the OK button to proceed. 

 

Figure 14-3 Generate Report 

4. The report will take several minutes to generate. 
5. Choose whether you would like to open or save the report. 
6. Click on the OK button. 

The report is saved on the default downloads folder of the computer.  

Detailed 
report button 

Status 
overview tab 



 Status Overview Tab 
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Figure 14-4 Detailed Report 

14.3 Status Overview Tab 

The Status Overview tab provides the following information concerning the server itself: 
fans, temperature, voltage, memory, network, projector, storage, security manager, time, 
administration, playback, security, and features.  

To access the Status Overview tab, click on the Storage tab. Clicking on a section on the 
left side of the GUI will take you from the top of the page to that section for more 
detailed information. 

The colored icons next to the sections reveal the status of that section: 

• Green: Healthy 
• Orange: Warning 
• Red: Failure 

  

Figure 14-5 Status Overview Tab 

Status 
icons 

Storage tab 
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Reset drives tab  

14.4 Storage Tab 

The Storage tab consists of two subviews: 

• Storage 
• Unit Information 

Click on the Storage tab button to access it. 

Storage details, at the top half of the screen, lists all the RAID builds configured on the 
server. On the right side of the GUI, there is a visual representation of the information for 
each RAID build in the first tab. The second tab displays the Reset All Drives button (See 
Section 15.2).   

Hovering over an individual drive reveals the Remove button. See Chapter 14 for more 
information. Unit information, which is the bottom half of the screen, lists information on 
the disks configured in the selected RAID. 

 

Figure 14-6 Storage Tab 

 

Figure 14-7 Reset Drives Button 
 

RAID selected 

Disk information 

RAID information 
Disk selected 

Reset drives button  

MediaBlock tab  

Remove button  



 MediaBlock Tab 
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14.4.1 RAID Information 

Storage details lists all the RAIDs configured on the server. Clicking on an individual 
RAID will reveal the disks that make up the selected RAID. Clicking on the individual 
disks will reveal the information in the unit information portion as well as display a 
general visual representation of the RAID: 
• An icon to show RAID status (green = healthy; amber = degraded/rebuild; red = 

missing) 
• Array device name 
• Mount point 
• Array size 
• Array used disk space and free space 
• RAID status (healthy, degraded, rebuilding percentage, failed) 
• Self-monitoring , analysis, and reporting technology information 
• Model and serial number 
• A pie chart depicting the percentage of used and free space 

14.5 MediaBlock Tab 

Click on the MediaBlock button to access it. 

The MediaBlock tab is divided into three sections: 

• Projector: 
• Connection status: Displays the status of the connection with the media block 
• Model: Displays the projector model 
• Dowser: Displays whether the dowser is open 
• Lamp: Displays whether the lamp is on 

• Media Decoder: 
• Video watermark: Displays the type of watermark present 
• Audio watermark: Displays the type of watermark present 

• Security Manager: 
• Blackout mode 
• Service door status 
• Service door armed status 
• Physical marriage: Displays whether the physical marriage is operational 
• Logical marriage: Displays whether the logical marriage is engaged 
• Active marriage: Displays whether the active marriage is engaged 
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The colored icons next to the sections reveal the status of that section: 

• Green: Healthy 
• Orange: Warning 
• Red: Failure 

 

Figure 14-8 MediaBlock Tab 

14.6  Log Viewer 

The Log Viewer tab allows you to manage and view various logs and records of the 
server.  

To access the Log Viewer tab, select Monitoring > Log Viewer.   

14.6.1 Log Records 

The Log Viewer tab defaults to the Log Records tab. Here, you can search for previously 
created logs. Logs are generated automatically as necessary. For example, they are 
generated when CPLs start and end, when the system is rebooted, when a schedule is 
added, and much more. 

Media decoder section  

Security 
manager 
section 

Projector section 

MediaBlock tab 



 Log Viewer 
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Figure 14-9 Log Records 

You can search by date or class, or use the advanced filter option, using their respective 
buttons. 

 

Figure 14-10 Date Filtering 

 

Figure 14-11 Class Filtering 

 

Figure 14-12 Advanced Filtering 

Properties icon 

Log download tab 

Advanced filtering 

Class filtering 

Date filtering 
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Properties 

To view the properties of an individual record: 

1. Highlight the record. 
2. Click anywhere on the line or on the properties icon that appears on the right. 

The Properties window appears, and the two tabs provide information on the specific 
record.  

3. Click the Close button to return to the tab. 

 

Figure 14-13 Main Properties Tab 

 

Figure 14-14 Properties Tab  

Close button 



 Log Viewer 
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14.6.2 Log Download 

The Log Download tab allows you to generate and download security manager (SMPTE) 
and system logs.  

To access the Log Download tab, click on the Log Records button to access it. 

 

Figure 14-15 Log Download 

To generate a log:  

1. Click on the New button.  
2. Input the correct password, if necessary.  

The New Log window appears. 

 

Figure 14-16 New Log Window 

3. Select either the System or Security Manager database to create the log. 
4. Select the starting and ending date. 
5. Specify a CPL or KDM ID, if needed. 
6. Click on the Create button, or click Cancel to cancel the operation.  
7. The log appears in the Log Download tab. 

New button 

Download button 

Delete button 

Applied filters 

Last packages 
log tab 
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8. Select the log, and click on the download icon that appears to download the log.  
A window appears asking if you would like to save or open the log.  

9. Make your selection, and click OK to access your log.  

 

Figure 14-17 Opening a Log 

To delete a log: 

1. Select the log. 
2. Click on the X that appears. 

Highlighting a log will also reveal the applied filters for the log in the bottom of the 
screen. 



 Log Viewer 
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14.6.3 Last Packages Logs 

The Last Packages Logs tab allows you to view the status of the last package installed 
since the last reboot. It provides information such as whether the install was successful 
and if and why it failed.  

To access the Log Download tab, click on the Log Records button to access it. 

 

Figure 14-18 Last Packages Log Tab 
 

Last packages 
logs tab 
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Chapter  15  Replacing a Drive  

The Storage tab identifies a failed drive that requires replacement in Storage Details, and 
also displays the RAID status.  

To replace a drive: 

1. Press on the handle to release it, and open the handle all the way. 
2. Slide the drive out gently from the enclosure. 

 

Figure 15-1 Hard-Disk Drive Removal 

3. Reboot the unit with just the two functioning drives in place.  
4. Insert the new drive all the way in the enclosure at the same position as the previous 

drive. 
 

 
Note: The drive must be inserted all the way inside the enclosure before trying to 

close the handle. Otherwise, the drive might not be plugged properly. 

 
5. Close the handle by pushing it toward the hard-disk drive until it clicks. 

When the new drive insertion process has been completed, the drive will 
automatically start rebuilding.  

Chapter 15 
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15.1 Rebuild Progress 

The Storage tab enables you to view the rebuild progress in Storage Details after you 
replace and insert a new disk. 

 

 
Note: When the server is rebuilding a RAID, an orange icon appears to indicate 

that the RAID is being rebuilt. 

 

 

Figure 15-2 Rebuild Status 

15.1.1 Managing a Drive 

Support for this feature is forthcoming. Presently, the only way to disable a drive is to 
physically remove it from the RAID.  

Rebuild progress 

Reset all 
drives button 



 Rebuilding a RAID 
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15.2 Rebuilding a RAID 

When two or more drives have been installed, you must build the RAID. Select 
Monitoring > Diagnostics > Storage to view the RAID status. 

To build the RAID: 

1. Select the Reset All Drives tab in the Storage tab. 
2. Click the Reset All Drives button.  
3. You will receive a warning and will be asked to confirm the procedure.  
4. Click on the Continue button, or click Cancel to cancel the operation.  
5. Confirm the operation. 

The process begins. 

 

Figure 15-3 Confirmation Window 

 

Figure 15-4 Confirmation Window 

 

Figure 15-5 In Progress 

When the procedure is complete, the Storage tab will display a healthy RAID. 
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15.3 Remove Button 

To remove a drive without shutting down the unit: 

1. Select the diagnostics application. 
2. Hover over the drive. 
3. Click on the Remove button.  

You will be asked to confirm the action. 

 

Figure 15-6 Remove Button  

4. Click on the Continue button.  

 

Figure 15-7 Disable Drive 

Remove button 



 Remove Button 
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15.3.1 Repairing a Drive in the Storage Tab 

To repair a IMS2000 hard-disk drive: 

1. Hover over the drive. 
2. Click on the Repair button. 
3. Click on the Continue button. 

 

Figure 15-8 Repair Drive 

4. Click on the Continue button. 

 

Figure 15-9 Repair Drive: Step 1 

5. Click on the Continue button.  

 

Figure 15-10 Repair Drive: Step 2 

6. Insert the new drive. 
7. Click on the Continue button. 
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The drive will begin to rebuild. 

 

Figure 15-11 Repair Drive: Step 3 

 

Figure 15-12 Repair Drive: Step 4 
Figure 15-13 
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Chapter  16 Troubleshooting Guide 

This chapter lists troubleshooting issues, their descriptions and identifications, and the 
solution to the issue.  

 

 
Note: The highlighted sections indicate the error line. 

To identify errors, the following files are useful: 

• kern.log: The kernel log provides a detailed log of messages from the Linux® kernel. 
These messages may prove useful for troubleshooting as it shows information 
regarding software and its interaction with hardware.  

• kreport.log.x: This is a text file that is a snapshot of commands executed for 
diagnostics. This particular log is generated just before every shutdown. The x is 
replaced with a numerical value to show the difference between shutdowns. For 
example, kreport.log.1 is from the previous shutdown and kreport.log.2 is from the 
shutdown previous to last shutdown. Information here is very similar to the 
information in drmreport.txt.  

• odetics.log: A log that shows playbacks noted as as-run log files. It can show frame-
specific issues in regard to underflows and decoder crashes, and can help with 
checking KDM validity. 

Chapter 16 
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16.1 eSATA Drives Not Seen 

The eSATA drives are not showing in the ingest manager.  
 

16.1.1 Identification 

When looking at \doremi\log\kern.log (or \doremi\log\kern.log.x if the issue occurred a while 
before the report was taken), you should see these kinds of messages when this issue 
occurs: 

 
Aug  6 12:39:27 ims1000 kernel: ata2: exception Emask 0x10 SAct 0x0 SErr 0x4050000 action 
0xe frozen 
Aug  6 12:39:27 ims1000 kernel: ata2: irq_stat 0x00400040, connection status changed 
Aug  6 12:39:27 ims1000 kernel: ata2: SError: { PHYRdyChg CommWake DevExch } 
Aug  6 12:39:27 ims1000 kernel: ata2: hard resetting link 
Aug  6 12:39:33 ims1000 kernel: ata2: link is slow to respond, please be patient (ready=0) 
Aug  6 12:39:37 ims1000 kernel: ata2: softreset failed (device not ready) 
Aug  6 12:39:37 ims1000 kernel: ata2: hard resetting link 
Aug  6 12:39:47 ims1000 kernel: ata2: softreset failed (device not ready) 
... 
Aug  6 12:40:22 ims1000 kernel: ata2: limiting SATA link speed to 1.5 Gbps 
Aug  6 12:40:22 ims1000 kernel: ata2: hard resetting link 
Aug  6 12:40:28 ims1000 kernel: ata2: softreset failed (device not ready) 
Aug  6 12:40:28 ims1000 kernel: ata2: reset failed, giving up 
Aug  6 12:40:28 ims1000 kernel: ata2: EH complete 

16.1.2 Solution 

To resolve the issue: 

Install ims_sw_hotfix_esata-1.0.0.pkg or software version 2.5.3 or later. 

16.2  File System Corruption  

The file system is corrupted. Symptoms include: 

• Arborescence is wrong and showing ??? instead of files or directories. 
• The KDM or digital license message folders in /data lose their symbolic link to 

/doremi/dlms and /doremi/kdms, and KDMs/digital license messages are lost as a result.  
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16.2.1 Identification 

When looking at \doremi\log\kern.log (or \doremi\log\kern.log.x if the issue occurred a while 
before the report was taken), you may see these kinds of messages when this issue 
occurs: 

 

IMS1000 kernel: EXT3-fs error (device md1): ext3_check_descriptors: Block bitmap for group 16 
not in group (block 589824)! 
IMS1000 kernel: EXT3-fs (md1): error: group descriptors corrupted 

 

Look at drmreport.txt file and search for ls -laRi /data, or simply run ls -la /data on the unit if 
you can access it.  When this issue occurs, dlms and kdms folders do not show their 
symbolic link to /doremi/dlms and /doremi/kdms, or some folders are missing and showing 
??? instead. 

 
root@IMS1000:~# ls -la /data/ 
total 8 
drwxr-xr-x  8 root   root   110 Nov 15 06:25 . 
drwxr-xr-x 23 root   root  4096 Jan 15  2013 .. 
drwxr-xr-x  4 root   root    92 Nov 14 14:19 assets 
drwxr-xr-x  2 root   root     6 Nov 12 20:02 dlms 
drwxrwxr-x  3 ingest users   32 Nov 14 14:09 incoming 
drwxr-xr-x  1 root   root    12 Nov 14 14:09 kdms 
drwxr-xr-x  2 root   root  4096 Nov 14 14:27 maps 
drwxr-xr-x  2 root   root     6 Nov 14 14:08 playlists 
drwxr-xr-x  4 root   root    36 Nov 14 14:08 repository 
drwxrwxrwt  2 root   root    44 Nov 14 14:27 tmp 
 
root@ims1000-1:~# ls -la /data/ 
ls: cannot access /data/tmp: No such file or directory 
ls: cannot access /data/tmp: No such file or directory 
total 56 
drwxr-xr-x 11 root   root   4096 Apr 23 07:13 assets 
lrwxrwxrwx  1 root   root     12 Oct 19  2012 dlms -> /doremi/dlms 
drwxrwxr-x  3 ingest users    32 Oct 19  2012 incoming 
lrwxrwxrwx  1 root   root     12 Oct 19  2012 kdms -> /doremi/kdms 
drwxr-xr-x  3 root   root  32768 Apr 23 07:14 maps 
drwxr-xr-x  2 root   root      6 Oct 19  2012 playlists 
drwxr-xr-x  4 root   root     36 Oct 19  2012 repository 
??????????  ? ?      ?         ?            ? tmp 
??????????  ? ?      ?         ?            ? tmp 
 
The following is a correct example of “ls -la /data” output for reference: 
 
root@IMS1000:~# ls -la /data/ 
total 8 
drwxr-xr-x  8 root   root   110 Nov 15 06:25 . 
drwxr-xr-x 23 root   root  4096 Jan 15  2013 .. 
drwxr-xr-x  4 root   root    92 Nov 14 14:19 assets 
lrwxrwxrwx  1 root   root    12 Nov 14 14:09 dlms -> /doremi/dlms 
drwxrwxr-x  3 ingest users   32 Nov 14 14:09 incoming 
lrwxrwxrwx  1 root   root    12 Nov 14 14:09 kdms -> /doremi/kdms 
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drwxr-xr-x  2 root   root  4096 Nov 14 14:27 maps 
drwxr-xr-x  2 root   root     6 Nov 14 14:08 playlists 
drwxr-xr-x  4 root   root    36 Nov 14 14:08 repository 
drwxrwxrwt  2 root   root    44 Nov 14 14:27 tmp 

 

16.2.2 Solution 

Check that standby is properly configured and running on the system. For a temporary 
workaround, the symbolic links can be re-created or the RAID can be reinitialized: 

Log onto the terminal (Administration > Terminal), and enter the administrator user login 
name and password. 

To solve the issue: 

• For a KDM link missing: 
• mount -o rw,remount / 
• rmdir /data/kdms 
• ln -s /doremi/kdms /data/kdms 
• mount -o ro,remount / 

• For a digital license message link missing: 
• mount -o rw,remount / 
• rmdir /data/dlms 
• ln -s /doremi/dlms /data/dlms 
• mount -o ro,remount / 

• For other cases (reinitialize the RAID): 
• SSH into IMS2000 
• Run mount -o rw,remount / 
• Run sh /doremi/sbin/reinit_raid.sh 
• Wait for RAID to complete building. 
• Reboot unit 
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16.3  Show Playlist Errors 

If there is a problem with playback, it can be attributed to one of two issues. This section 
lists and describes the solutions for playback issues.  

16.3.1 Empty Show Playlist 

Show playlist is empty, Security Manager and firmware versions are missing. 

Identification 

If the report was taken while the error was showing, look at 'lspci' in drmreport.txt. 

If the report was taken after a reboot, look at 'lspci' in \doremi\log\kreport.log.x (kreport.log 
being the previous boot, kreport.log.0 being the boot before, and so on). 

 
Exec. command: 'lspci' 
00:00.0 Host bridge: Intel Corporation Device 0709 (rev 08) 
... 
01:13.0 Multimedia controller: Intel Corporation Device 0706 (rev 01) 
01:14.0 Multimedia controller: Intel Corporation Device 0705 (rev 01) 
01:15.0 Unassigned class [ff00]: Intel Corporation CE Media Processor SPI Slave (rev 01) 
01:16.0 Display controller: Intel Corporation Device 070a 
01:1b.0 SD Host controller: Intel Corporation Device 070b 
02:00.0 SATA controller: Marvell Technology Group Ltd. Device 9230 (rev 10) 
03:00.0 Unassigned class [ff00]: Device 1fd5:0007 (rev 21) 
 
The highlighted line 03:00.0 referencing the device 1fd5:0007 (FPGA) will be missing when this 
issue occurs. 
 
When looking at \doremi\log\kern.log (or \doremi\log\kern.log.x if the issue occurred a while 
before the report was taken), you should NOT see this message when this issue occurs: 
 
Jun 24 15:55:43 IMS01-SC3 kernel: pci 0000:03:00.0: reg 10: [mem 0xbfd00000-0xbfdfffff] 
... 
Jun 24 15:56:31 IMS01-SC3 kernel: dolphin 0000:03:00.0: enabling device (0000 -> 0002) 
Jun 24 15:56:31 IMS01-SC3 kernel: dolphin 0000:03:00.0: PCI INT A -> GSI 17 (level, low) -> 
IRQ 17 
Jun 24 15:56:31 IMS01-SC3 kernel: dolphin 0000:03:00.0: setting latency timer to 64 
Jun 24 15:56:31 IMS01-SC3 kernel: dolphin 0000:03:00.0: irq 65 for MSI/MSI-X 
Jun 24 15:55:55 IMS01-SC3 kernel: Dolphin DEBUG: dolphin_malloc_ex: f0e00000 (4194304 
bytes) [23c00000–24000000] 

Solution 

The solution for a customer would be to return the unit. 
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16.3.2 Playback Stops 

Unit stops playing. 

Identification 

When looking at \doremi\log\odetics.log (or \doremi\log\odetics.log.x if the issue occurred a 
while before the report has been taken), you should see the following message when this 
issue occurs: 

 

[Sat Nov 23 04:24:37 2013][INFO ]: AsRun: "c110ad93-2041-4138-9300-3e34177ef0f9"," 
       ","00:00:00.00","00:00:59.24","0","0","C" 
[Sat Nov 23 04:24:37 2013][INFO ]: Loading CPL 'ad49f2d6-c435-4714-af47-bd9372c8130c' in 
slot '2'... 
[Sat Nov 23 04:24:37 2013][INFO ]: CPL 'ad49f2d6-c435-4714-af47-bd9372c8130c' successfully 
loaded 
[Sat Nov 23 04:24:37 2013][ERROR]: DMA transfer failed for frame x during playback. 
[Sat Nov 23 04:24:37 2013][ERROR]: Try to recover from error... 
 
When looking at \doremi\log\kern.log (or \doremi\log\kern.log.x if the issue occurred a while 
before the report has been taken), you should see the following message when this issue occurs: 
 
Nov 23 04:24:37 IMS332399 kernel: Dolphin DEBUG: Video: JP2K: 2048 x 1080 @ 30p 
Nov 23 04:24:37 IMS332399 kernel: Dolphin DEBUG: Audio: WAV: 16Ch 48000Hz 
Map:fedcba9876543210 Mute:0000 Data:0000 
Nov 23 04:24:37 IMS332399 kernel: Dolphin DEBUG: Software seamless play. 
Nov 23 04:24:37 IMS332399 kernel: Dolphin DEBUG: WARNING: Possible DMA transfer 
dropped (dma_xfer_state:= 1, xfer_pending:= 575272) 
Nov 23 04:24:37 IMS332399 kernel: Dolphin DEBUG: Set playback state: 
'DolphinContextStopped' 

Solution 

To solve the issue, ensure that the latest versions of the software, firmware, and security 
manager are installed:  

• Software: v2.4.5 
• Firmware: v4.2.7 
• Security manager: v6.0.1.5 
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16.4 Cannot Initiate Marriage 

16.4.1 Description 

Trying to initiate a marriage fails with software v2.4.4. 

16.4.2 Identification 

Certificates under /doremi/etc/certs/mine do not match with the unit serial number. 

16.4.3 Solution 

To solve this issue, install ims_sw_hotfix_certs_2.4.4-1.0.0.pkg. 

A workaround is to execute the command /doremi/sbin/sbcsetup.out -f --verify --
repair and reboot the unit. 
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16.5 Preloaded Test Content 

You have the ability to test the playback of the IMS2000 without having the hard-disk 
drives installed. To do this, select Control > CineLister > Editor. 

The content will already be available in Cinelister, under the section called Test.  

 

Figure 16-1 Pre-Loaded Test Content 

To test playback: 

1. Click on the content so that it appears in the right side of the GUI.  
2. Click on the Play button in the Cinelister application. 

16.6  Temporarily Setting the Network Configuration via USB 

This method should be used to “rescue” the device in case the IP address is lost or 
forgotten. The network configuration is set temporarily until the next reboot. The current 
IP will be back after the next reboot.  

To update the network configuration with a USB flash drive: 
 

1. Create a directory called doremi at the root of the USB key. 
2. Create a directory called tmp inside the /doremi/ directory. 
3. Create a directory called network inside the /doremi/tmp/ directory. 
4. Create a file inside the network directory, and name it ifconfig.0. This will be used to 

configure Ethernet port 0. 

For static IP, enter the following information in the ifconfig.0 file, replacing the items in 
bold with your settings: 

• Interface: eth0 

Test content 

Test content 



 Temporarily Setting the Network Configuration via USB 
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• IP: 42.0.0.1 
• Mask: 255.255.255.248 
• Gateway: 42.0.0.6 

For DHCP, use the following format: 

• Interface: eth0 
• IP: dhcp 

5. Create a file, and name it ntp (optional) with the following format. Replace items in 
bold with your settings. 

NTPSERVERS="server1.ntp.org server2.ntp.org" 
 

6. Create a file, and name it dns (required for NTP) with the following format. Replace 
items in bold with your settings. 
• Name server: 172.17.16.1 
• Name server: 8.8.8.8 
• Search: rnd.doremilabs.fr 
• Domain: rnd.doremilabs.fr 

 

 
Note: When creating these configuration files, make sure that the files do not 

have any extensions (for example, .txt, .doc), which are the default for some 
operating systems. 

 
7. Place all files that were created into /doremi/tmp/network/. 
8. Plug your USB flash drive on the IMS2000, and wait for two minutes.  
9. Unplug the flash drive, and reboot. 

 

 
Note: The files on USB flash drives are never moved or changed by the IMS2000. 
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16.6.1 Permanently Setting the Network Configuration 

It is possible to permanently set the IP only via the USB. The files to put on the USB are 
the same as presented but in the directory /doremi/update/network instead of 
/doremi/tmp/network. 

16.7 Generating a Detailed Report 

16.7.1 Generating a Report via USB 

To generate a report using a USB key: 

1. Create a directory doremi at the root of the USB key. This may have been previously 
created. 

2. Create a directory report inside the /doremi directory. 
3. Safely remove the USB drive, and plug it into the IMS2000. 
4. Wait two minutes without any USB activity. (Watch your USB key LED.) 
5. Reboot the IMS2000. 

The report will be in the USB key folder /doremi/report. 

16.7.2 Generating a Report via Command Line 

To generate a report via command line: 

1. Log in via SSH. 
2. Type: sh /doremi/sbin/report.sh. 

This will generate a report and place it in the /doremi/tmp directory. 

3. Log in using an FTP client with the following criteria: 
• Host: IP 
• User name: root 
• Password: veeone 
• Port: 22 



 Generating a Detailed Report 
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16.7.3 Generating a Report via the GUI 

To generate a report via the GUI:  

1. Select Monitoring > System. 
2. Click on the Detailed Report button. 
3. Click on the OK button.  
4. The report will take several minutes to generate. 
5. Choose whether you want to open or save the report.  
6. Click on the Ok button.  

The report is saved in the default downloads folder of the computer. 
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Chapter  17 Installing and Configuring a Dual-
Projector Setup 

This chapter provides step-by-step instructions for installing and configuring two 
IMS2000s for a dual-projector setup. It also explains how to create a basic playlist.  

In a dual IMS2000 setup, the two boards are identical in terms of firmware and software 
configuration and different in terms of serialization. The primary IMS2000, also referred 
to as the IM2000 security manager, is similar to a standard IMS2000 in terms of 
serialization. It uses a specific firmware for a dual-projector setup in the 4.xx version 
range. You can update a primary unit back and forth with standard IMS2000 firmware 
and use it as a standard IMS2000. 

The secondary IMS2000, the IMS2000 link decryptor, includes the same hardware as a 
standard IMS2000 but is serialized differently in the factory. This unique serialization 
enables the unit to operate as a secondary IMS2000. It uses specific firmware for a dual-
projector setup in the 4.xx version range. You cannot update a secondary unit to standard 
IMS2000 firmware and cannot use it as a standard/primary IMS2000. 

In this section, the primary IMS2000 is referred to as the security manager, and the 
secondary as the link decryptor.  

 

 
Note: Dolby® 3D is not yet supported in dual IMS2000 setups. 

 

Chapter 17 
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17.1 Required Materials 

The following materials are required to complete the installation: 

• IMS2000 security manager (quantity: 1) 
• IMS2000 link decryptor (quantity: 1) 
• Series 2 digital cinema projectors (quantity: 2) 

We recommend using the same projector type and model for both IMS2000s. 

• KDM for dual projection  (quantity: 1) 
 

 
Note: Dual 4K presentations also require 4K digital license managers (one for the 

IMS2000 security manager and one for the IMS2000 link decryptor). 

 

17.2 HFR and Non-HFR Setup 

The IMS2000 must be running software version 2.7.10 or later.  

The primary and secondary IMS2000 should have the following software versions 
installed: 

• Firmware: v4.5.4 or later 
• Security manager: v6.1.119 or later 



 Installation and Power-Up Sequence 
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17.3  Installation and Power-Up Sequence 

To complete the installation: 

1. Verify that both projectors and the IMS2000s are turned off.   
2. Install the IMS2000 security manager in the primary projector.   
3. Install the IMS2000 link decryptor in the secondary projector.   
4. Connect Ethernet cables to both projectors and the IMS2000, and verify that they are 

on the same network.   
5. Connect BNC cables A and B from the primary projector SDI output connectors to the 

secondary projector SDI input connectors.   

To complete the power-up sequence:   

1. Power up the primary projector. 
2. Power up the secondary projector. 
3. Wait until both projectors are completely powered up.   
4. Power up the IMS2000. 

17.4  Device Manager Configuration 

To configure the IMS2000 to operate in a dual-IMB setup: 

1. Select Administration > Device Manager. 
2. Click on the New button to add the primary projector (security manager) in the Device 

Manager application. 
3. Set the primary projector (security manager) configuration:  

a. Set the identifier: Primary projector plus the name of the projector. 
b. Select the projector model from the drop-down menu. 
c. Specify the head IP of the projector. 
d. Select Yes for the primary projector. 
e. Select the dual-projector check box. 
f. For 2D presentations, select Full from the Display drop-down menu.  

 
 

 

 
Note: For HFR 3D setups, select Left from the display mode drop-down menu. 

 
4. Click on the Save button. 

5. Enter the appropriate credentials. 
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Figure 17-1 Primary Projector 

6. Add the secondary projector.  
7. Set the secondary projector configuration:  

a. Set the identifier: Secondary projector plus the name of the projector. 
b. Select the projector model from the drop-down menu. 
c. Specify the head IP of the projector. 
d. Select No for the primary projector. 
e. Select the dual-projector check box. 
f. For 2D presentations, select Full from the Display drop-down menu.  

 

 
Note: For HFR setups, select Right from the Display mode drop-down menu. 

 
g. Click on the Upload button to upload any matrices.  
h. Click on the Save button, and enter the appropriate password. 

New button 

Save button 

Display drop 
down menu 



 Device Manager Configuration 
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Figure 17-2 Secondary Projector 

The Device Manager will automatically create a device for the IMS2000 hosted in the 
primary projector and will name it Certainty. Rename the device to reflect that it is for 
the security manager projector. 

8. Add another RAW device by clicking on the New button and selecting Raw device.  
9. Fill the identifier field (for example, Certainty_LD to reflect the secondary projector), 

vendor, and product name fields.  
10. Enter the IP address of the secondary projector, and fill the port number field. 

 

Figure 17-3 Secondary Projector 

11. Click on the Save button, and enter the proper password. 
 

New button 

Save button 

New button 

Upload button 

Certainty devices 
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17.5 Creating a Playlist  

This section shows you how to create a show playlist. 

 
Note: The following example may look different from your generated show 

playlist. 

To create a playlist: 

1. Select Control > CineLister > Editor. 
2. In CineLister, click on the Properties button. 

 

Figure 17-4 Editor Window 

3. Select 2D or 3D for the display mode in the ShowPlaylist Properties window: 
a. For HFR setups, select the HFR composition check box. 
b. For 4K setups, select 2D (4K). 

 
Figure 17- 4 Editor  

Figure 17-5 Show Playlist Properties 

 
4. Click the Close button. 



 Creating a Playlist 
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5. Double-click Black to select the element under all elements in the Edit window: 
• For 2D HFR and non-HFR, select Black. 
• For 3D, select Black 3D. 
• For 3D HFR, select Black 3D 48. 

6. Set the black duration in the Pattern Setup window, then click Ok. 

 

Figure 17-6 Pattern Setup Window 

7. Add any required macros for your show playlist. 
8. Click the Save button to save your show playlist. 
9. Enter a name for your newly created show playlist, then click Save.  

You have now completed the show playlist setup procedure. 

 

Figure 17-7 Show Playlist Example (2D) 
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17.6 KDM Information 

To enable playback for dual-projector setups, you must generate KDMs for the IMS2000 
serial number that include the certificates for both the IMS2000 secondary projector and 
the integrated cinema processor for the primary projector in the trusted device list. The 
following figure shows the Dolby MXF mastering software with the Trust Any Projector 
box unchecked, which is required for this KDM setup.  

Only the following KDMs are acceptable for an IMS2000 dual-projector configuration: 

• Multiple modified transitional 1: KDMs for Interop or SMPTE packages. 
• DCI specific for SMPTE packages only with the DCI constraint for multiple-projector 

auditoriums; one-to-one match of the trusted device list; assume trust certificate 
thumbprint is rejected by the system. 

Click the following URL for additional details that further define these KDMs. 

http://isdcf.com/papers/ISDCF-Doc5-Guideline-formulations-Interop-and-SMPTE-KDMs.pdf 

 

 
Note: The assume trust certificate thumbprint is not accepted in dual-projector 

configurations. 

    

Figure 17-8  Certificates 

 

  Uncheck Trust Any Projector  

IMS-LD certificate 

Christie_S1_projector - certificate 

http://isdcf.com/papers/ISDCF-Doc5-Guideline-formulations-Interop-and-SMPTE-KDMs.pdf
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Chapter  18 Setting Up the System for Dolby Atmos 

This section provides instructions on how to set up, install, and configure Dolby Atmos® 
on the IMS2000. 

18.1 Unit Setup 

 

Figure 18-1 Connection Diagram Between Dolby IMS2000 and Dolby CP850 
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18.2 Dolby Atmos Installation 
 

 
 

1. Request the digital license message from technical support: 
a. Receive email. 
b. Download attachment to local drive. 

2. Log in. 
3. Ingest the Dolby Atmos digital license message (if not already ingested): 

a. Move the cursor over the Control tab. 
b. Move the cursor over the Ingest Manager selection. 
c. Click on the Upload selection button. 

 

Figure 18-2 Overview Tab 

4. Click on the Choose File button. 

 

Figure 18-3 Upload Tab 
 

a. Navigate to the digital license message destination folder. 
b. Click on the digital license message to highlight it. 
c. Click on the open button to select the digital license message. 
d. Click on the Upload button to upload the digital license message to the IMS2000. 
e. Click on the Ingest Monitor tab. 



 Dolby Atmos Configuration 
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f. Verify that the digital license message ingest was successful. 

 

Figure 18-4 Ingest Successful 

18.3 Dolby Atmos Configuration 

To configure the Dolby Atmos feature using the Dolby® IMS2000: 

1. Click on the Administration tab. 

 

Figure 18-5 Overview Tab 
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2. Click on the Device Manager application. 

 

Figure 18-6 Control Panel Tab 

3. Hover the cursor over the New button. 
4. Select Audio Processor from the list. 

 

Figure 18-7 Device Manger: Device List 

 

 
Note: Devices displayed in red text specify that the device is not enabled. 



 Dolby Atmos Configuration 
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5. Select Dolby and Atmos in the Processor model fields. 

 

Figure 18-8 Selecting Audio Processor Model 

6. Input the IP address of the command port for the audio processor. 
7. Click the Save button to save the settings. 

The Dolby Atmos feature is ready to use. 
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18.3.1 Dolby CP850 Audio Processor Cable Configuration 

To configure the cables on the Dolby CP850:  

1. Connect an Ethernet cable to the COMMAND port on the CP850, and connect the other 
end of the cable to the network switch. 

 

Figure 18-9 Dolby CP850 Audio Processor 

 

Figure 18-10 Audio Adapter 

 

Figure 18-11 Doremi to Dolby Audio Adapter 

2. Connect the Doremi to Dolby audio adapter to the AES Input port on the Dolby 
CP850. 

3. Connect the audio adapter to the Doremi to Dolby audio adapter on the CP850. 
4. Connect an Ethernet cable to port A (channels 1–8) on the audio adapter, and connect 

the other end to the IMB AES port (channels 1–8). 
5. Connect an Ethernet cable to port B (channels 9–16) on the audio adapter, and connect 

it to the IMB AES port (channels 9–16). 
6. Connect the power cable to the CP850 power port. 

 

Port B 
Command port 
Input port 

Power port 

Port A 

Male end 

Female end 

Port B 

Port A 



 Dolby CP850 Web GUI 
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18.4  Dolby CP850 Web GUI 

18.4.1 Accessing the Dolby CP850 Web GUI 

To access the Dolby CP850 web GUI: 

1. Open a web browser on a Macintosh® or Windows® system that is on the same 
subnetwork as the CP850. 
The default IP address is required to access the Dolby web GUI. Confirm the IP 
address with your Dolby installer. 

 

Figure 18-12 Dolby Audio Processor Login Screen 

Do not change the Dolby Atmos input port IP address. Do not connect this port to an 
Ethernet switch. If you experience any difficulty, contact Dolby support. 

2. Enter the user name and password. 
Contact your local Dolby support to obtain proper credentials. 

 

 

 

 

 

 

 

 

Figure 18-13 Dolby Web GUI Home Screen 
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Note: If the selected content does not have the required Dolby Atmos data, the 

Dolby Atmos content section displays a red dot, stating No Dolby Atmos 
frames available. 

 

 
 

Figure 18-14 No Dolby Atmos Content 

 

 
Note: Dolby Atmos content appears in green, which indicates that the content 

playing has the appropriate Dolby Atmos data and that channel 14 is 
functioning. Channel 14 transfers the Dolby Atmos information from the 
player to the CP850 audio processor. 

 

 

Figure 18-15 With Dolby Atmos Content 

Content without 
Dolby Atmos 

Data 

Content with 
Dolby Atmos 

data 

Input status 
section  
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3. The row of green dots in the Input Status section signifies channels 1–8 and 9–16. 
4. If a channel is disconnected, the dot is grayed out. 

  

Figure 18-16 Input Status Section 

18.5 Troubleshooting Tips 

18.5.1  Channels Not Recognized 

If the system does not recognize the channels in the input status section, try the 
troubleshooting tips in the following sections. 

Check the Cables 

Check the Ethernet cable connections on the audio adapter. Refer to Section 18.3.1 for 
connection information. 

18.5.2 Dolby Atmos Content Not Recognized 

If the Dolby Atmos content is not recognized, a gray or red dot appears in the Dolby 
Atmos content section. 

Follow these steps to try and solve this issue: 

• Verify that the CP850 is on the same network as the IMS2000. 
• Verify that the selected content is Dolby Atmos content.  
• Verify that the CP850 is enabled. 

18.5.3 KDMs for Dolby Atmos Content (CPL) 

All KDMs created to unlock encrypted Dolby Atmos content must have the audio 
watermark disabled from only channels 12 and above. 

The following is an example of what a correct KDM would look like: 

• <ForensicMarkFlagList> 
<ForensicMarkFlag>  
</ForensicMarkFlagList  

Not recognized   
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18.5.4 Dolby Atmos Channel Dropout 

If the system experiences Dolby Atmos dropout when outputting only the base bed 
audio channels (that is, the first ten physical channels, for example, 5.1 or 7.1), this might 
be caused by network dropout or a network that is not running at an optimum speed.  

1. Check the Ethernet port to which your CP850 is connected (for example, 10.203.50.10). 
In drmreport.txt, search for IP Interfaces. 

Example 1: Dropped Packet 
eth0 Link encap:Ethernet HWaddr 00:25:90:74:08:F8 
inet addr:10.203.50.204 Bcast:10.203.50.255 Mask:255.255.255.0 
inet6 addr: fe80::225:90ff:fe74:8f8/64 Scope:Link 
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1 
RX packets:103696968 errors:0 dropped:12866overruns:0 frame:0 
TX packets:34997690 errors:0 dropped:0 overruns:0 carrier:0 
collisions:0 txqueuelen:1000 
RX bytes:1007555312 (960.8 MiB) TX bytes:3127287593(2.9 GiB) 
Base address:0x2000 Memory:d0300000-d0320000 

Example 2:  Network run is only at 100 base T (max 100mbps, and should be 1000 
(gigabit) as Atmos needs 150 mbps 
eth0 Link encap:Ethernet HWaddr 00:25:90:74:08:F8 
inet addr:10.203.50.204 Bcast:10.203.50.255 Mask:255.255.255.0 
inet6 addr: fe80::225:90ff:fe74:8f8/64 Scope:Link 
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1 
RX packets:103696968 errors:0 dropped:0 overruns:0 frame:0 
TX packets:34997690 errors:0 dropped:0 overruns:0 carrier:0 
collisions:0 txqueuelen:100 
RX bytes:1007555312 (960.8 MiB) TX bytes:3127287593(2.9 GiB) 
Base address:0x2000 Memory:d0300000-d0320000 
 

2. Verify that you are using a gigabit network switch. 
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Chapter  19 General Purpose Output Connection Diagram 

 

19.1 LTC 

To enable the linear timecode (LTC) output feature on the IMS2000: 

1. Attach a jumper at the J83 header. 
LTC is the jumper configurable on header J83. 

2. Connect the left and middle pin (pins 2 and 3). 
To obtain LTC output, use the optional IMS2000 GPIO out with LTC out cable (part 
number CBL-GPO-LTCO-IMS2-25).  

Chapter 18 
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Note: The factory default for the J83 header is set to GPO5, not LTC output. 

  

Figure 19-1 LTC Jumper 

 

Figure 19-2 LTC Diagram 

 

 

LTC jumper 
at J83 
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Chapter  20 General Purpose Input Connection Diagram 
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Chapter  21 25-Pin D-Connector to Dual RJ-45 Adapter 
Pinouts 

The following table shows the pinouts for the 25-pin D-connector to dual RJ-45 adapter. 

Table 21-1 25-Pin D-Connector to Dual RJ-45 Adapter Pinouts      

AES Pair To 

1+ (channel 1/2+) P14 

1– (channel 1/2–) P2 

2+ (channel 3/4+) P3 

3+ (channel 5/6+) P17 

3– (channel 5/6–) P5 

2– (channel 3/4–) P16 

4+ (channel 7/8+) P6 

4– (channel 7/8–) P19 

5+ (channel 9/10+) P8 

5– (channel 9/10–) P21 

6+ (channel 11/12+) P22 

7+ (channel 13/14+) P11 

7– (channel 13/14–) P24 

6– (channel 11/12–) P10 

8+ (channel 15/16+) P25 

8– (channel 15/16–) P13 
 

Chapter 19 

Chapter 20 
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Chapter  22 LED Behavior 

 

Figure 22-1 Front-Panel LED Specifications 

The following table shows the status indication information for the IMS2000 LEDS. 

Table 22-1 CPU LED Status      

CPU1 CPU2 Status of the IMS2000 CPU 

Orange Green Standby. 

Green Green CPU operational without warning/error, no eSATA/USB 
connected. 

Green  Orange CPU operational without warning/error, eSATA/USB connected. 

Green Off Booting. 

Orange  Off CPU operational but with warning (nonspecific). 

Orange Orange CPU operational but with warning on RAID (RAID degraded). 

Orange Red CPU operational but with warning on temperatures. 

Red Off CPU cannot play due to error (nonspecific). 

Red Orange CPU cannot play due to error on RAID. 

Red Red CPU cannot play due to error in communication with security 
manager. 

Chapter 21 

HDMI LED 

SM LEDs 

CPU 1 and 
2 LEDs 

SDI A –B 
LEDs 
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The following table shows the status indication information for the HDMI™ LED. 

Table 22-2 HDMI LED Status      

HDMI LED Behavior 

Off No HDMI signal detected 

Green HDMI detected with supported format 

Orange HDMI detected with unsupported format 

The following table shows the status indication information for the SM1, SM2, SM3, and 
SM4 LEDs. 

Table 22-3 Security Manager LED Status      

SM1 SM2 Security Manager Status 

Orange Green Booting. 

Green Green Security manager operational. 

Orange Orange Security manager in rescue mode. 

Red Any Security manager in Federal Information 
Processing Standards (FIPS) lock. (Different color 
of SM2 can indicate the reason for FIPS lock, to be 
defined.) 

SM3 SM4 Playback Status 

Green Green OK to play, no problem reported since last CPL 
validate. 

Orange Green Service door is closed, but needs to be rearmed. 

Orange Orange Service door is open, marriage is activated 
otherwise. 

Orange Red Service door is open, marriage is not activated. 

Red Orange Marriage is initialized/armed, but marriage is not 
verified. 

Red Green Marriage is not initialized/armed, service door and 
physical marriage are OK (ready to marry). 



 LTC 
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Red Red Marriage is not activated, physical marriage is 
currently broken. 

The following table shows the status indication information for the Serial Digital 
Interface (SDI-A) LEDs: 

Table 22-4 SDI A LED Status      

 

 

 

 

The following table shows the status indication information for the SDI B LEDs: 

Table 22-5 SDI B LED Status      
 

 
 

 

 

 

 

 
 

SDI A LED Configuration Connected to an 
Output Device 

Green Output N/A 

Green Input Connected 

OFF Input Not connected  

SDI B LED Configuration Connected to an 
Output Device 

Green Output N/A 

Green Input Connected 

OFF Input Not connected  
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Chapter  23 HDMI Input Supported Formats 

The following table shows the HDMI™ inputs and their supported formats. 

Table 23-1 HDMI Inputs: Supported Formats      

Interface 
Format 

Signal Format 

Resolution Aspect I/P Color Space 
Frame Rate (fps) 

23.98 24 25 29.97 30 47.95 48 50 59.94 60 

     2D 

VGA 

640 × 480 
1.333, 
1.778 

P 
RGB/ 
component 

4:2:2 
       

 
○ ○ 

4:4:4 

480p 

720 × 480 
1.333, 
1.778 

P 
RGB/ 
component 

4:2:2 
        ○ ○ 

4:4:4 

576p 720 × 
576 

1.333, 
1.778 

P 
RGB/ 
component 

4:2:2 
       ○   

4:4:4 

HDTV 1280 × 
720 

1.778 P 
RGB/ 
component 

4:2:2 
       ○ ○ ○ 

4:4:4 

HDTV 1920 × 
1080 

1.778 

i/PsF 
RGB/ 
component 

4:2:2 
○ ○ ○ ○ ○      

4:4:4 

P 
RGB/ 
component 

4:2:2 
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ 

4:4:4 

2048 × 1080 1.896 

i/PsF 
RGB/ 
component 

4.2.2 
○ ○ ○ ○ ○      

4:4:4 

P 
RGB/ 
component 

4:2:2 
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ 

4:4:4 

3840 × 2160 1.778 P 
RGB/ 
component 

4:2:2 
○ ○ ○ ○ ○      

4:4:4 

4096 × 2160 1.896 P 
RGB/ 
component 

4:2:2 
○ ○         

4:4:4 
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• Audio: 
• 32 kHz 
• 44.1 kHz 
• 48 kHz 
• 88.2 kHz 
• 96 kHz 

 

 
Note: The HDMI audio data rate is not converted when processed through the 

IMS2000. Be sure your audio processor supports the audio format encoded 
on your playback disk. 
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Chapter  24 SDI Supported Formats 

The following table shows the SDI inputs and their supported formats. 

Table 24-1 SDI Supported Formats      

Interface 
Format 

Signal Format 

Resolution Aspect I/P Color 
Space 

Frame Rate (fps) 

23.98 24 25 29.97 30 47.95 48 50 59.94 60 

2 

D 

Single-
link 1.5G 

1280 × 720 1.778 P YCbCr 4:2:2 
 

            ○ ○ ○ 

1920 × 1080 1.778 
i/Ps
F 

YCbCr 4:2:2 ○ ○ ○  ○  ○            

P YCbCr 4:2:2 ○ ○ ○ ○ ○           

2048 × 1080 1.896 
i/Ps
F 

YCbCr 4:2:2 ○ ○ ○  ○  ○            

P YCbCr 4:2:2 ○ ○ ○  ○  ○            

Single-
link 3G 

1920 × 1080 1.778 P YCbCr 4:2:2      ○ ○ ○  ○  ○  

2048 × 1080 1.896 P YCbCr 4:2:2      ○ ○ ○  ○  ○  

Dual link-
1.5G 

1280 × 720 1.778 P 
RGB / 
YCbCr 

4:4:4               ○ ○ ○ 

1920 × 1080 1.778 

i/Ps
F 

RGB / 
YCbCr 

4:4:4 ○ ○ ○  ○  ○            

P 
YCbCr 4:2:2      ○ ○ ○ ○ ○ 

RGB / 
YCbCr 

4:4:4 ○ ○ ○ ○ ○           

2048 × 1080 1.896 

i/Ps
F 

RGB / 
YCbCr 

4:4:4 ○ ○ ○  ○  ○            

P 
YCbCr 4:2:2         ○ ○ ○ ○ ○ 

RGB / 
YCbCr 

4:4:4 ○ ○ ○  ○  ○            

Dual 
Link- 3G 

1920 × 1080 1.778 P 
RGB / 
YCbCr 

4:4:4      ○ ○ ○ ○ ○ 

2048 × 1080 1.896 P RGB / 
YCbCr 

4:4:4      ○ ○ ○  ○  ○  

3 

D 

Dual 
stream-
1.5G 

1280 × 720 1.778 P YCbCr 4:2:2        ○ ○ ○ 

1920 × 1080 1.778 
i/Ps
F 

YCbCr 4:2:2 ○ ○ ○ ○ ○           

P YCbCr 4:2:2 ○ ○ ○ ○ ○           

2048 × 1080 1.896 i/Ps YCbCr 4:2:2 ○ ○ ○  ○  ○            
Chapter 23 
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F 

P YCbCr 4:2:2 ○ ○ ○  ○  ○            

Dual 
stream-3G 

1920 × 1080 1.778 P YCbCr 4:2:2      ○ ○ ○ ○ ○ 

2048 × 1080 1.896 P YCbCr 4:2:2      ○ ○ ○  ○  ○  

Audio: 

• SDI embedded audio @ 48 kHz 
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Chapter  25 Example Connection Diagram 

4.  
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Chapter  26 Updating Web-Based User-
Interface Version 

To update the web-based user-interface version: 

1. Obtain the latest update package from the FTP site. Contact Dolby product specialists 
to confirm the latest version.  

2. Log into the unit using an FTP client. 
3. Go to the data/incoming/GUI folder. 
4. Place the file in the GUI folder. 
5. Log onto the IMS2000.  
6. Select Control > Ingest > Ingest Scan. 

 

 

Figure 26-1 Ingest Scan Window 

7. Select Local Storage. 
8. Select the package. 
9. Click on the Ingest button. 
10. Click on the OK button in the pop-up window to acknowledge that the system must 

be rebooted.  

Chapter 25 
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Figure 26-2 Reboot Notification 

11. Select Administration > System > Restart. 
After approximately ten minutes, the system will complete the update. 

 

Figure 26-3 Restart Button 
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Chapter  27 Troubleshooting the NAS 

 

27.1 Network Error 

Verify the following items: 

• The NAS can communicate with the same network as the IMS2000. 
• The IP address is set properly in the NAS manager. 

27.2 SNMP Error 

The troubleshooting process varies depending on the model of the NAS device. 

27.2.1 Seagate: STDE100 

To verify the SNMP function is on: 

1. Log in to the NAS device GUI. 
2. Click on the Device Manager button. 

 
Figure 27-1 Home Screen: Seagate STDE100 

3. Click on the Notifications button in the Overview column. 
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Figure 27-2 Device Manager Window 

4. Click on the SNMP tab. 
5. Verify the SNMP agent is set to ON. 

 

Figure 27-3 Notifications Window 
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27.2.2 Netgear: ReadyNAS 2120 

To verify the SNMP function is on: 

1. Log in to the NAS device GUI. 
2. Click on the Systems button. 
3. Click on the Settings tab. 

 

Figure 27-4 Home Screen: ReadyNAS 2120 

4. Click on the SNMP button in the Services section. 

 

Figure 27-5 Services Section 

5. Verify that Enable SNMP is check marked. 

 

Figure 27-6 SNMP Settings Window 

6. Click on the Apply button to save the settings. 
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27.3 Linked Filed Error 

This feature is currently not supported. 

27.4 Mount Error 

The troubleshooting process varies, depending on the model of the NAS device. 

27.4.1 Seagate: STDE 100 

This feature is currently not supported. 

27.4.2 Netgear: ReadyNAS 2120 

To verify that the folder to be mounted is set to read/write: 

1. Log in to the NAS device GUI. 

 

 
Figure 27-7 Homescreen: ReadyNAS 2120 

 

2. Click on the Shares tab. 
3. Click on the folder to be mounted. 
4. Click on the Settings button from the drop-down menu. 

 

Figure 27-8 Shared Folder Settings Button 
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5. Click on the Network Access tab. 
6. Click on the NFS button. 

 

Figure 27-9 Shared Folder Network Access Tab 

7. Verify that the read/writer configuration is set. 
8. Click on the Apply button to save the configuration. 
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Chapter  28 Acronyms 

The following table defines the acronyms used in this manual. 

Table 28-1 Acronyms       

Term Definition 

CPL Composition Playlist 

DCI Digital Cinema Initiatives 

DLP Digital Light Processing 

FPS Frames per second 

GPI General purpose input 

GPO General purpose output 

HDCP High-bandwidth Digital Content Protection 

HFR High frame rate 

IMB Integrated Media Block 

KDM Key Delivery Message 

LCD Liquid crystal display 

LED Light emitting diode 

LTC Linear timecode 

LVDS Low-voltage differential signaling 

MXF Material eXchange Format 

RAID Redundant array of independent disks 

SDI Serial Digital Interface 

SMS Screen Management System 

SSH Secure Shell  
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VGA Video Graphics Array 

XML Extensible Markup Language 
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Chapter  29 Document Revision History 

Date Version Description 
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